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Typographic Conventions
The PC-BSD® 9.1 Handbook uses the following typographic conventions:
bold text: represents a command written at the command line. In usage examples, the font is changed to Courier 10 with any command output displayed in unbolded text.
italic text: used to represent device names or file name paths.
bold italic text: used to emphasize an important point.
1 Introduction
Welcome to PC-BSD®!
PC-BSD® began in 2005 when Kris Moore presented the first beta version of a FreeBSD operating system pre-configured for desktop use. Since then, PC-BSD® has matured into a polished, feature-rich, free-of-charge, open source operating system that meets the desktop needs of the beginner to the advanced user alike.
PC-BSD® is essentially a customized installation of FreeBSD, not a forked derivative. Since the underlying FreeBSD system has been kept intact, you have a fully functional FreeBSD system under the hood. PC-BSD® provides a graphical installer, a graphical package management system, and dozens of graphical utilities that make PC-BSD® suitable for desktop use. As a user of PC-BSD®, you don’t have to worry about configuring a FreeBSD system for desktop use; instead you can simply install and start using it.
The main difference between PC-BSD® and FreeBSD is that PC-BSD® is geared towards desktop use, while FreeBSD has been created with server use in mind. Other differences include:
PC-BSD® pre-configures at least one desktop manager during installation
PC-BSD® is installed by a graphical installer rather than a text based installer
the PC-BSD® installer supports additional features such as configuring ZFS and encryption during installation
PC-BSD® provides a graphical software management system
PC-BSD® provides a Control Panel of graphical utilities for configuring the system
PC-BSD®’s rc.conf and sysctl.conf have been tweaked for a desktop environment
PC-BSD® comes pre-configured with a number of automatic scripts to perform tasks such as connecting digital cameras or USB memory sticks
PC-BSD® started off as an independent project, but since October, 2006 PC-BSD® is (financially) backed and supported by the enterprise-class hardware solutions provider iXsystems.
The rest of this section discusses:
1.1 Goals and Features
Designed with the desktop computer user in mind, PC-BSD® provides the following features:
Easy installation: to install PC-BSD®, simply insert the installation media, reboot the system to start the installer, and answer a few questions in the graphical menus.
Automatically configured hardware: video, sound, network and other devices are automatically configured for you.
Intuitive desktop interface: PC-BSD® comes with a choice of desktop environments to support your day-to-day computing needs.
Easy software management: with AppCafe®, installing, upgrading, and uninstalling software is safe and easy.
Lots of software available: in addition to its own software, PC-BSD® can install software that has been ported to FreeBSD (currently nearly 24,000 applications).
Binary compatibility: for software that has not been specifically ported to FreeBSD. PC-BSD® can run almost any GNU/Linux application using Linux binary compatability. It is also able to run many Windows applications using Wine.
Easy to update: PC-BSD® provides a built-in Update Manager that will notify you of available updates and allow you to apply operating system security fixes, bug fixes, system enhancements as well as upgrade to newer versions of the operating system or installed software.
Virus-free: PC-BSD® is not affected by viruses, spyware and other malware.
No defragmentation: PC-BSD® hard drives do not need to be defragmented and do not slow down over time. PC-BSD® also supports ZFS which is a self-healing filesystem.
Architecture support: PC-BSD® is available for 32-bit and 64-bit systems.
Laptop support: provides power saving and swap space encryption and automatically switches between wired and wifi network connections.
Secure environment: PC-BSD® provides a pre-configured PF firewall, brute-force attack protection with OSSEC, and a Host-based Intrusion Detection System with Fail2ban.
Easy system administration: PC-BSD® provides a Control Panel containing many graphical tools for performing system administration tasks.
Localization: PC-BSD® supports a number of native languages and locales.
Vibrant community: PC-BSD® has a friendly and helpful support community.
Professional support: professional email and phone support is available from iXsystems.
1.2 What's New in 9.1
The following features have been added to or improved for PC-BSD® 9.1:
Based on FreeBSD 9.1, which includes improved Intel video support. The Release Notes for FreeBSD 9.1 list the new features and drivers introduced in FreeBSD 9.1.
The PC-BSD® installer has been revamped to separate pre-installation tasks from post-installation tasks. This makes it easier to automate the roll-out of multiple installations because the end-user can configure their account information and display settings before logging in for the first time.
The PC-BSD® installer now sets its default settings according to the hardware installed. 64-bit systems containing over 2GB of RAM will default to the ZFS filesystem whereas 32-bit systems and any system containing less than 2GB of RAM will default to UFS+SUJ. Systems containing more than 2GB of RAM will default to the KDE desktop and all other systems will default to the LXDE desktop. A hardware compatibility icon within the installer allows the user to see at a glance if their video card, Ethernet card, wireless card, and sound card are compatible with PC-BSD®.
The PC-BSD® installer now provides a wizard to install either a vanilla FreeBSD server or a TrueOS server. In addition to the base FreeBSD system provided by a vanilla FreeBSD server installation, the TrueOS server edition adds the command line versions of PBI Manager, Update Manager, and Warden®.
The ability to perform a network install has been removed from the graphical installer. The scriptable back-end still provides the variables needed for network installations.
The ZFS section of the PC-BSD® installer now allows you to set ZFS properties such as compression and quotas, create datasets, and import existing ZFS pools.
Multiple Boot Environments support allows systems formatted with ZFS to create alternate bootable snapshots. These can be used for testing purposes or to create a bootable backup of the boot environment before performing an upgrade.
Warden® is now built into the operating system and available through Control Panel. It can now be used to manage multiple jails.
Warden® now supports the creation of three types of jails: traditional FreeBSD jails for running network services, (a less secure) ports jail for safely installing and running FreeBSD ports/packages from your PC-BSD® system, and the installation of Linux within a jail.
Warden® now supports the management of ZFS snapshots on a per-jail basis.
has been integrated into Warden®. Combined with the meta-package support, it is now easier than ever to install software into a jail and to keep that software up-to-date.
AppCafe® now shows the number of available PBIs and supports automatic updating.
EasyPBI is now available through Control Panel, making it easier than ever to convert existing FreeBSD ports to PC-BSD® PBIs.
An About icon has been added to the Control Panel, making it easy to determine the PC-BSD® version, which desktops, and the version of X that have been installed.
A Hardware Compatibility icon has been added to the control panel, providing a quick overview of detected hardware devices.
The GDM Configuration GUI has been added to Control Panel and can be used to configure auto-login and remote login through XDMCP.
A Mount Tray icon has been added to the Control Panel and System Tray, allowing easy access to USB drives.
A Sound Configuration icon has been added to the Control Panel and can be used to test sound or change the default audio device.
Network Configuration manager now supports 802.1x authentication over Ethernet networks.
Life Preserver now provides a browse button when creating an include or exclude filter.
Thin Client now allows you to create a PXE Boot Desktop Server or a PXE Boot Installation Server.
Bluetooth Manager has been added to the System Tray.
PC-BSD® Live Mode is now a USB-only, read/write image.
When ZFS formatting during installation, gnop 4K alignment is now used when creating the zpool. This results in a dramatic increase in performance. For this reason, it is recommended that users with existing ZFS installations re-install rather than upgrade in order to receive these performance benefits.
1.3 PC-BSD® Releases
As of September 2008, PC-BSD® release version numbers are the same as those for FreeBSD. When the first number of a release is followed by a zero (e.g. version 9.0), this means that this version of PC-BSD® introduces many new features. When the second number of a release is not a zero (e.g. version 9.1), this means that the new version may have some new features, but it mostly fixes known software problems and security vulnerabilities. If a release includes the letters RC, this means that it is a “Release Candidate”, or that the developers are still adding and fixing features and need testers to help them find any existing problems in preparation for the upcoming release. If the release includes the word BETA, it means that that version is still buggy and needs the help of testers to find as many problems as possible so that they can be fixed.
NOTE: if you want to use PC-BSD® (not test it), you should install the most recent release (i.e. the one with the highest number), not a BETA or RC version.
PC-BSD® releases follow the same EoL (end of life) schedule as the underlying FreeBSD release. Any security patches for a supported release will appear in Update Manager, making it easy to keep your PC-BSD® system fully patched against known security vulnerabilities.
1.4 PC-BSD® for Linux Users
PC-BSD® is based on BSD Unix, meaning that it is not a Linux distribution. If you have used Linux before, you will find that some features that you are used to have different names on a BSD system and that some commands are different. This section covers some of these differences.
1.4.1 Filesystems
BSD and Linux use different filesystems during installation. Many Linux distros use EXT2, EXT3, EXT4, or ReiserFS, while PC-BSD® uses UFS or ZFS. This means that if you wish to dual-boot with Linux or access data on an external drive that has been formatted with another filesystem, you will want to do a bit of research first to see if the data will be accessible to both operating systems.
Table 1.4a summarizes the various filesystems commonly used by desktop systems. Most of the desktop managers available from PC-BSD® should automatically mount the following filesystems: FAT16, FAT32, EXT2, EXT3 (without journaling), EXT4 (read-only), NTFS5, NTFS6, and XFS. See the section on Files and File Sharing for more information about available file manager utilities.
Table 1.4a: Filesystem Support on PC-BSD®
Filesystem | Native to | Type of non-native support | Usage notes |
Btrfs | Linux | none | |
exFAT | Windows | r/w support loaded by default | |
EXT2 | Linux | r/w support loaded by default | |
EXT3 | Linux | r/w support loaded by default | since EXT3 journaling is not supported, you will not be able to mount a filesystem requiring a journal replay unless you fsck it using an external utility such as e2fsprogs |
EXT4 | Linux | r/o support loaded by default | EXT3 journaling, extended attributes, and inodes greater than 128-bytes are not supported; EXT3 filesystems converted to EXT4 may have better performance |
FAT16 | Windows | r/w support loaded by default | |
FAT32 | Windows | r/w support loaded by default | |
HFS+ | Mac OSX | none | older Mac versions might work with hfsexplorer |
JFS | Linux | none | |
NTFS5 | Windows | full r/w support loaded by default | |
NTFS6 | Windows | r/w support loaded by default | |
ReiserFS | Linux | r/o support is loaded by default | |
UFS | PC-BSD® | r/o support is included in Linux kernel 2.6.5 onwards; | changed to r/o support in Mac Lion |
UFS+S | PC-BSD® | check if your Linux distro provides ufsutils; | changed to r/o support in Mac Lion |
UFS+J | PC-BSD® | check if your Linux distro provides ufsutils; | changed to r/o support in Mac Lion |
XFS | Linux | r/o support is loaded by default | |
ZFS | PC-BSD®, OpenSolaris | Linux port |
1.4.2 Device Names
Linux and BSD use different naming conventions for devices. For example:
in Linux, Ethernet interfaces begin with eth; in BSD, interface names indicate the name of the driver. For example, an Ethernet interface may be listed as re0, indicating that it uses the Realtek re driver. The advantage of this convention is that you can read the man 4 page for the driver (e.g. type man 4 re) to see which models and features are provided by that driver.
BSD disk names differ from Linux. IDE drives begin with ad and SCSI and USB drives begin with da.
1.4.3 Feature Names
Some of the features used by BSD have similar counterparts to Linux, but the name of the feature is different. Table 1.4b provides some common examples:
Figure 1.4b: Names for BSD and Linux Features
PC-BSD® | Linux | Description |
PF | iptables | default firewall |
/etc/rc.d/ for operating system and /usr/local/etc/rc.d/ for applications | rc0.d/, rc1.d/, etc. | in PC-BSD® the directories containing the startup scripts do not link to runlevels as there are no runlevels; system startup scripts are separated from third-party application scripts |
/etc/ttys and /etc/rc.conf | telinit and init.d/ | terminals are configured in ttys and rc.conf indicates which services will start at boot time |
1.4.4 Commands
If you are comfortable with the command line, you may find that some of the commands that you are used to have different names on BSD. Table 1.4c lists some common commands and what they are used for.
Table 1.4c: Common BSD and Linux Commands
Command | Used to: |
dmesg | discover what hardware was detected by the kernel |
sysctl dev | display configured devices |
pciconf -l -cv | show PCI devices |
dmesg | grep usb | show USB devices |
kldstat | list all modules loaded in the kernel |
kldload <module> | load a kernel module for the current session |
pbi_add -r <pbiname> | install software from the command line |
sysctl hw.realmem | display hardware memory |
sysctl hw.model | display CPU model |
sysctl hw.machine_arch | display CPU Architecture |
sysctl hw.ncpu | display number of CPUs |
uname -vm | get release version information |
gpart show | show device partition information |
fuser | list IDs of all processes that have one or more files open |
1.4.5 Additional Resources
The following articles and videos provide additional information about some of the differences between BSD and Linux:
2 Pre-Installation Tasks
While the PC-BSD® installer is very easy to use, installing a brand new operating system can sometimes be a daunting task.
Before you begin, there are a few things you should check to ensure that your system is ready to install PC-BSD®.
Are you dual-booting or installing over the entire drive? If you are dual-booting you will need to ensure that you have a primary partition available. You should also review the section on Dual Booting to make sure you are comfortable with preparing the drive for the installation and to determine which boot loader best suits your needs.
Have you backed up your important data? Any irreplaceable data, such as emails, bookmarks, or important files and documents should always be backed up to an external media, such as a removable drive, or to another system before installing or upgrading any operating system.
If you would like to try out PC-BSD® without committing to an install, try PC-BSD® Live Mode first. This is an excellent way to determine if your hardware will work with PC-BSD®.
Should you run into an issue with your installation there are many different ways to get help.
This section discusses the following topics:
2.1 Hardware Requirements
PC-BSD® has moderate hardware requirements and commonly uses less resources than its commercial counterparts. Before installing PC-BSD®, make sure that your hardware or virtual machine at least meets the minimum requirements. To get the most out of your PC-BSD® experience, refer to the recommended system requirements.
2.1.1 Minimum System Requirements
At a bare minimum, you need to meet these requirements in order to install PC-BSD®:
Pentium II or higher
512 MB RAM
10GB of free hard drive space on a primary partition
Network card
2.1.2 Recommended System Requirements
The following are the minimum recommended requirements. The more RAM and available disk space, the better your computing experience:
Pentium 4 or higher
1024 MB of RAM
20GB of free hard drive space (if you will be installing KDE, GNOME, or lots of software)
Network card
Sound card
NVIDIA 3D accelerated video card
You can never have too much RAM, so install as much as you can afford. To play modern video games, you should use a fast CPU. If you want to create a collection of tunes and movies on your computer, you will want a large hard disk drive which can be internal or external.
2.1.3 Supported Processors
PC-BSD® should install on any system containing a 32-bit (also called i386) or 64-bit (also called amd64) processor. Despite the amd64 name, a 64-bit processor does not need to be manufactured by AMD in order to be supported. The FreeBSD Hardware Notes list the i386 and amd64 processors known to work.
2.1.4 Supported Video Cards
Like most open source operating systems, PC-BSD® uses X.org drivers for graphics support. PC-BSD® will automatically detect the optimal video settings for supported video drivers. You can verify that your graphics hardware is supported by clicking the Hardware Compatibility icon within the installer or by accessing this utility from Control Panel when using Live Mode. If this utility shows your video as VESA on a 32-bit system with an older NVIDIA card, you must install and use the legacy driver as described below.
Support for the major graphic vendors is as follows:
NVIDIA: if you want to use 3D acceleration, NVIDIA is currently the best supported as there is a native driver for PC-BSD®. If an NVIDIA video card is detected, an “nVidia settings” icon will be added to the Control Panel for managing NVIDIA settings. Some older NVIDIA cards on 32-bit systems require an older NVIDIA driver. If you suspect you have one of these cards, select the Hardware-Drivers ➜ NVIDIA-Legacy drivers during installation or afterwards using System Manager.
Intel: as of 9.1, 3D acceleration on most Intel graphics is supported. Due to the current KMS support, you will not be able to switch between the graphical console and a virtual console using Crtl+Alt+F#.
ATI/Radeon: 3D acceleration will not work on ATI or Radeon cards until FreeBSD completes its TTM work (possibly in time for 9.2). You can still use these cards, but you will have to choose the 2D driver, and if that does not work, you will need to resort to using the Vesa driver.
Optimus: at this time Bumblebee has not been ported to FreeBSD, meaning that there is no switching support between the two graphics adapters provided by Optimus. Optimus implementations vary, so PC-BSD® may or may not be able to successfully load a graphics driver on your hardware. If you get a blank screen after installation, check your BIOS to see if it has an option to disable one of the graphics adapters or to set “discrete” mode. If the BIOS does not provide a discrete mode, PC-BSD® will default to the 3D Intel driver and disable NVIDIA. This will change in the future when the NVIDIA driver supports Optimus.
2.1.5 Wireless Cards
PC-BSD® has built-in support for dozens of wireless networking cards. You can check if your card has a FreeBSD driver. If it does, it should “just work”.
PC-BSD® will automatically detect available wireless networks for supported wireless devices. You can verify that your device is supported by clicking the Hardware Compatibility icon within the installer or by accessing this utility from Control Panel when using Live Mode. If it an external wireless device, insert it before running the Hardware Compatibility utility. If your device is not detected, the Wireless Testing page has some information about drivers which have not been ported yet. It also contains instructions for converting a Microsoft driver to a FreeBSD kernel module, though results will vary by driver. Known missing wireless drivers are typically in the Broadcom and newer Realtek series.
Certain Broadcom devices, typically found in cheap laptops, are quite buggy and can have lockups when in DMA mode. If the device freezes, try switching to PIO mode in the BIOS. Alternately, add the line hw.bwn.usedma=0 to /boot/loader.conf and reboot to see if that makes a difference.
2.1.6 Checking Hardware Compatibility
If you wish to check your hardware before installing PC-BSD®, a good place to start is the FreeBSD 9.1 Hardware Notes.
Another good resource is to run PC-BSD® in Live Mode; that way you can test your various devices before committing to an install.
While most hardware “just works” with PC-BSD®, it is possible that you will run across a piece of hardware that does not. If you do, you can help improve hardware support for all PC-BSD® users by reporting the problem so that it can be addressed by the developers. It should be remembered that PC-BSD® is really FreeBSD, meaning that any hardware that works on FreeBSD will work on PC-BSD®.
2.2 Laptops
Many PC-BSD® users successfully run PC-BSD® on their laptops. To determine if the hardware on your laptop is supported, search the FreeBSD Laptop Compatibility List. Consider adding to this list if your model is not listed or the information for your model is out-of-date.
Depending upon the model of laptop, you may run across some issues. These typically deal with:
Sleep/suspend: unfortunately, ACPI is not an exact science, meaning that you may have to experiment with various sysctl variables in order to achieve successful sleep and suspend states on your particular laptop model. If your laptop is a ThinkPad, Thinkwiki is an excellent source. For other types of laptops, try reading the SYSCTL VARIABLES section of man 4 acpi and check to see if there is an ACPI man page specific to your vendor by typing apropos acpi. The Tuning with sysctl(8) section of the FreeBSD Handbook demonstrates how to determine your current sysctl values, modify a value, and make a modified value persist after a reboot. If the battery reading is incorrect, try the workaround in this PR.
Internal wireless: some chipsets do not have a FreeBSD driver yet. If you would like to try converting a Windows driver into a FreeBSD module, use the instructions in this blog post.
Internal ATI or Radeon graphics: at this time, these chipsets will only support 2D graphics. This may be fixed by PC-BSD® 9.2.
Synaptics: depending upon the hardware, you may or may not be able to disable the system's touchpad. This forum post describes how to enable Synaptics and some of the sysctl options that this feature provides.
If you wish to test your laptop's hardware, consider using PC-BSD® Live Mode before committing to an installation.
If you would like to install PC-BSD® onto an Asus Eee, read the FreeBSD Eee page first.
The FreeBSD Tuning Power Consumption page has some tips for reducing power consumption.
2.2.1 ThinkPads with Known Bugs
The ThinkPad T420 may panic during install. If it does, go into the BIOS and set the video mode to "discrete" which should allow you to complete an installation.
Some Thinkpads have a BIOS bug that prevents them from booting from GPT labelled disks. If you are unable to boot into a new installation, restart the installer and go into Advanced Mode in the Disk Selection Screen. Make sure that the “Partition disk with GPT” box is unchecked. If it was checked previously, redo the installation with the box unchecked.
If you wish to install PC-BSD® on an older IBM/Lenovo ThinkPad laptop, it is important to first check your ThinkPad model number to see if its BIOS has a known bug. This bug is rather nasty and will render the computer completely unbootable--even the BIOS will be inaccessible. This situation occurs as the BIOS thinks that the PC-BSD® (FreeBSD) partition number represents the IBM repair partition. The only way to get the affected laptop to boot again is to physically remove the hard drive, insert it into another laptop, wipe the drive, and insert the drive back into the system. While the hard drive is in the other system, you will note that PC-BSD® boots just fine as the problem is with the BIOS, not the hard drive. Once the BIOS is accessible again, you should upgrade (or possibly downgrade) the BIOS to a version number that fixes this bug. See Table 2.2a for the models which are affected, the BIOS version number that fixes the bug, and links to the BIOS software should you need to upgrade your BIOS. The BIOS needs to incorporate the fix “The system can not boot from a hard disk drive with partition ID of n5h where n is 1 or greater”.
Table 2.2a: ThinkPad BIOS Versions with Known Bug
Model Number | BIOS Version That Fixes The Bug |
A20m | |
A20p | |
A21e(2628) | |
A21m (except Sxx models) | |
A21p | |
A22m (except Sxx models) | |
A22p | |
T20 | |
T21 | |
X20 | |
X21 |
2.2.2 Acer Laptops with Known Bug
In models 2920z and 4920G, there is an issue with the BIOS settings for the HPET timer. The solution is to set a hardware hint.
Boot the installation media and select “7. Escape to the loader prompt” when you see the menu shown in Figure 2.2a.
At the resulting prompt, type:
set hint.hpet.0.allowed_irqs="0x400000"
boot
You should now be able to install PC-BSD®. Once the installer boots for the first time, you will need to repeat that command in order to boot into PC-BSD®. Once you are in PC-BSD®, you can make the hint permanent by carefully adding this line to /boot/loader.conf as the superuser:
hint.hpet.0.allowed_irqs="0x400000"
Figure 2.2a: PC-BSD® Boot Menu
2.2.3 MacBooks
Before starting, you should review the MacBook on FreeBSD Wiki.
Starting in PC-BSD® 9.0-RC1, support has been added for installing directly to Mac OS X BootCamp partitions.
First, you can install an OS X boot manager, such as rEFIt. This step is optional as it requires either a dedicated partition or it installs into your OS X partition and takes over the boot process.
Next you will need to make some free space to install into. You can use the MacBook's Boot Camp utility to make a primary partition of at least 25 GB in size.
After creating the BootCamp partition, boot from the PC-BSD® install media and proceed with a normal installation. When you get to the “Disk Selection” screen, be sure to select the ada0p3: linux-data partition for installation. After installation, reboot and select BSD from the rEFIt (or an alternate) boot menu to boot into the new PC-BSD® installation.
2.2.4 Touch Screens
Starting in PC-BSD® 9.0, automatic detection of USB-based touch screen devices has been added. During the display wizard phase, if your touch-screen is auto-detected, the necessary flags will be added to /etc/X11/xorg.conf automatically. If your display is USB and is NOT auto-detected, please send the output of usbconfig and your /etc/X11/xorg.conf file to the PC-BSD® testing mailing list.
2.3 Partitioning the Hard Drive
PC-BSD® does not come with a built-in partition manager. The installer assumes that the drive is already prepared for an installation. If you are not planning to install PC-BSD® onto the entire hard drive, you will need to use a third-party application in order to prepare a primary partition to use as the destination for your PC-BSD® install.
NOTE: PC-BSD® will not install into a secondary or logical partition, it must be a primary partition.
Before creating or editing your hard drive's partitions, make sure that you first back up your valuable data to an external media such as a removable USB drive!
This section demonstrates how to create free space within Windows 7 and how to use Parted Magic to create a primary partition from the free space.
2.3.1 Shrinking a Drive in Windows 7
If you are currently running Windows 7, it is using the entire hard drive. This means that you will need to first shrink the drive in order to make room to create a new partition. Shrinking is an operation that retains the current data on the partition, while reducing the size of the partition.
To shrink the drive, go to Start menu ➜ right-click Computer ➜ Manage ➜ Storage ➜ Disk Management. Figure 2.3a shows an example of a system running Windows 7. In this example, Windows has created three partitions: a 16GB recovery partition, a 100MB system partition, and a 450GB data partition.
Figure 2.3a: Viewing Disk Layout in Disk Management
NOTE: if you plan to dual-boot with Windows, it is important that you do not choose to install PC-BSD® into any of these three partitions when you get to the Disk Selection Screen of the installer. It is a good idea to write down the sizes of the partitions so that you will recognize them when the PC-BSD® installer displays your current partitions.
Since the three Windows partitions are using the entire disk, the data partition needs to be shrunk in order to create space to install PC-BSD® into. To shrink the data partition, right-click the partition, in this example it is called Acer (C:), and select “Shrink Volume”. Wait a moment as it queries the volume for available shrink space; the results will be displayed as seen in the example in Figure 2.3b.
Figure 2.3b: Available Shrink Space
In this example, 321089MB of space is available. To divide the partition between Windows and PC-BSD®, change that number to 230000 and click the “Shrink” button. When finished, the newly created free space will be displayed, as seen in Figure 2.3c.
Figure 2.3c: Disk Now Has Free Space
You can now format the newly created free space using a utility such as Parted Magic, as described in the next section.
NOTE: while the Disk Management utility in Windows 7 indicates that it will let you format a primary partition, in reality it will only create an extended partition which will not allow you to install PC-BSD®. This means that you still need another utility such as Parted Magic.
2.3.2 Using Parted Magic to Create a Primary Partition
Parted Magic is a graphical, easy-to-use partition editor that is packaged on a live CD. It can be used to shrink an existing partition and to create a primary partition from existing free space.
To use Parted Magic, download the latest .iso.zip file, unzip it, and burn it to CD. Boot the system with the CD and let it boot into “Default settings (Runs from RAM)”. Wait for it to boot into the graphical screen, then select the “Partition Editor” desktop icon.
Figure 2.3d shows the same Windows 7 system in Partition Editor. The 225.05GB partition is the Windows data partition (which was displayed as drive C within Windows 7) and the 224.61GB of unallocated space was created using the Windows Disk Management utility. The “Create new Partition” screen was opened by right-clicking on the unallocated space and selecting “New” from the menu.
Figure 2.3d: Formatting the Unallocated Space into a Primary Partition
When creating your partition from unallocated space, make sure that “Primary Partition” is selected. The filesystem type does not matter as the PC-BSD® installer will reformat it. It is a good idea to write down the size and filesystem type so that you will recognize the partition that you will be installing PC-BSD® into. Once you have made your selections, click the “Add” button. Note that the partition will not actually be created until you click the “Apply” button to apply your changes. A popup menu will prompt you to make sure that you have selected the correct partition as formatting a partition destroys all data on that portion of the disk. Once the operation is complete, you can reboot and start the PC-BSD® installation.
2.4 Obtaining PC-BSD®
The installation files for PC-BSD® can be downloaded for free and end with an .iso or .img.bz2 file extension. Depending upon the type of file you choose, the size will vary between ~650MB and ~3.5GB. This section will show you how to select which file to download and how to verify the downloaded file's checksum. The next section will demonstrate how to burn the file to bootable media.
If you have a slow download connection or wish to support the PC-BSD® project financially, you can purchase PC-BSD® DVDs from the FreeBSD Mall.
Members of the PC-BSD® project attend many IT conferences across the globe and give out PC-BSD® DVDs at conference booths. Visiting a PC-BSD® booth is an excellent way to meet other PC-BSD® users and to get your questions answered. Check the PC-BSD® Blog to see if any events are happening near you. If you are organizing a PC-BSD® booth, contact us to arrange for DVDs.
2.4.1 Selecting Which File to Download
When you go to the Download page of the PC-BSD® website, you will find a number of files available for download:
DVD: contains the full version of PC-BSD® (all system components, ports, and source); requires a DVD burner.
USB: contains the full version of PC-BSD® (all system components, ports, and source); requires a USB memory stick or flash card.
USB-lite: contains a stripped down version of PC-BSD® and the LXDE desktop (no system components, ports, source, or FreeBSD/TrueOS™); requires a USB memory stick or flash card.
USB-live: contains a writable, live version of PC-BSD® running the LXDE desktop; requires a USB memory stick or flash card.
VMware disk image: contains a pre-installed version of PC-BSD® with the GNOME, KDE, LXDE, Openbox, and XFCE desktops. See the section on Using the Downloadable VirtualBox or VMWare Disk for instructions on using the VMware disk image.
VirtualBox disk: contains a pre-installed version of PC-BSD® with the GNOME, KDE, LXDE, Openbox, and XFCE desktops. See the section on Using the Downloadable VirtualBox or VMWare Disk for instructions on using the VirtualBox disk.
NOTE: if your system is not able to boot from either a DVD or USB device and GRUB version 2 is installed, you can download the DVD .iso file and instruct GRUB to boot from it using these instructions.
The larger the installation file size, the more components that come with that installation.
Regardless of which media you use to install PC-BSD®, you have the option to install additional components and applications after the installation using System Manager and AppCafe®.
There are two versions available for each type of file: one for 32-bit (i386) systems and one for 64-bit (amd64) systems. It is important that you download a file that matches your computer's processor type (32- or 64-bit). For example, if the system is 64-bit or has more than 4GB or RAM, download the amd64 version, even if the brand is not AMD. Each media type includes the pcbsd-media-details file which identifies the release version, architecture, media type, and date of creation.
NOTE: If you plan to use VirtualBox to install PC-BSD®, you can install the 32-bit version, even if your computer is 64-bit. Depending upon your processor's capabilities, you may or may not be able to install the 64-bit version on a 64-bit system using VirtualBox.
2.4.2 Data Integrity Check
After downloading the file that is correct for your architecture and installation media, it is a good idea to check that the file is exactly the same as the one on the PC-BSD® server. While downloading, a portion of the file may get damaged or lost, making the installation file unusable. Each PC-BSD® download has an associated MD5 checksum which is listed next to the download link. If the checksum of the file you downloaded has the same number, your download was successful. If the MD5 numbers do not match, you should download the file again, preferably from a different mirror. In order to verify the checksum, you will need to use a checksum verification utility.
If you are currently using a Windows system, you can download and install the FastSum utility. Once installed, launch the program and click the “Files” button, shown in Figure 2.4a, to browse to the location of your downloaded file:
Figure 2.4a: Verifying a Checksum Using FastSum
Once the file is selected, click the green arrow to calculate the checksum. Once calculated, it will be listed in the “Checksum\State” column. In this example, the checksum is 87d28f726bd6b88c62433fddda16f089 (though FastSum will capitalize the letters).
On Linux and BSD systems you can use the built-in md5 (or md5sum) command line tool to check the data integrity of the downloaded file. In this example, the file is located in the Downloads subdirectory directory. You should substitute the name and location of the file that you downloaded:
md5 Downloads/PCBSD9.1-x64-DVD.iso
MD5 (Downloads/PCBSD9.1-x64-DVD.iso) = 87d28f726bd6b88c62433fddda16f089
2.5 Burning the Installation Media
Once you have downloaded PC-BSD® and verified its checksum, burn the file to the correct media type. This section demonstrates how to do so using several different applications and operating systems. Each application assumes that the correct media (CD, DVD, or USB flash drive) for the type of file is inserted.
2.5.1 Burning the CD/DVD ISO File on Windows
Several burning applications are available for Windows. This section will demonstrate how to use Windows 7's Disc Image Burner, ImgBurn, and InfraRecorder.
2.5.1.1 Windows 7 Disc Image Burner
Windows 7 has built-in support for writing ISO images to disc. Right-click on the .iso file in Windows Explorer and select Open with ➜ Windows Disc Image Burner to open the screen shown in Figure 2.5a. Click “Burn” to write the disc. See the Microsoft article Burn a CD or DVD from an ISO file for more detailed instructions.
Figure 2.5a: Windows Disc Image Burner
ImgBurn is an easy to use ISO burner for Windows that is available for free download. After installing and launching ImgBurn, select “Write image file to disk” from the main menu, seen in Figure 2.5b. You can then use File ➜ Browse for a source file... to select the .iso file to burn; once selected, your screen should look similar to Figure 2.5c. Click the Write icon in the lower left corner to begin the burn.
Figure 2.5b: Initial ImgBurn Screen
Figure 2.5c: Selecting the Source and Destination in ImgBurn
ImgBurn will provide a status bar to indicate the progress of the burn. When it is finished, ImgBurn will eject the burner tray then reclose it in order to verify the burn. If the tray does not return itself, which may occur on a laptop, push the tray back in if you wish to verify the burn.
2.5.1.2 InfraRecorder
InfraRecorder is an open source burning application for both CDs and DVDs. Once installed, open InfraRecorder and click on the “Write Image” button shown in Figure 2.5d:
Figure 2.5d: Initial InfraRecorder Screen
InfraRecorder will display a screen where you can browse to the location of the .iso file. Once selected, you will be presented with an options screen shown in Figure 2.5e. You can accept the defaults and click OK to start the burn. When finished, the burner tray will open and a dialog box will appear indicating that the burning process has finished.
Figure 2.5e: Burn Options in InfraRecorder
2.5.2 Burning the CD/DVD ISO File on a BSD or Linux System
This section demonstrates how to burn the installation ISO on a Linux or BSD system using the following tools: K3B, Brasero, and growisofs.
2.5.2.1 K3B
K3B is an easy-to-use graphical burning application for Linux and BSD systems. On a PC-BSD® system, it is installed with the KDE desktop. You can also install the K3B PBI using Using AppCafe®.
To burn your ISO, launch K3B, browse to the location of the .iso file in the screen shown in Figure 2.5f and click Tools ➜ Burn Image... to see the screen in Figure 2.5g.
Click the “Start” button to burn the file. K3B will automatically eject the media once the burn is complete.
Figure 2.5f: Selecting the Burn Image Tool Within K3B
Figure 2.5g: K3B's Burn Image Screen
2.5.2.2 Brasero
Brasero is an easy to use burning application included with the GNOME desktop. A PBI is also available within AppCafe®. To launch Brasero within GNOME, click Applications ➜ Multimedia ➜ Brasero Disk Burner and the dialog window shown in Figure 2.5h will be displayed. Alternately, type brasero from within any window manager.
Figure 2.5h: Brasero's Initial Screen
Click Burn image to open the screen seen in Figure 2.5i. Use the “Click here to select a disk image” button to select your .iso file.
The name and size of your .iso file should appear and Brasero will indicate the size of the media. The lower portion of Figure 2.5i shows the menu that appears if you click on the “Properties” button. You can change these options if you wish, but it is fine to keep the default settings. When you are ready, click the “Burn” button and Brasero will burn your ISO.
Figure 2.5i: Brasero Image Burning Setup
2.5.2.3 growisofs
If you are familiar with using the command line on a FreeBSD or PC-BSD® system, you can use the growisofs command line utility to burn the DVD. This utility is included with the dvd+rw-tools FreeBSD port which is installed by default on a PC-BSD® system. If that software is not yet installed on a FreeBSD system, issue this command as the superuser:
pkg_add -r dvd+rw-tools
Depending upon the type of DVD burner hardware, you may have to configure the system to use it. If the device is ATAPI (i.e. not USB or SCSI), the ATAPI driver must be loaded. The superuser can issue this command:
kldload atapicam
If you just get your prompt back, the driver successfully loaded. If you get the message “kldload: can't load atapicam: File exists”, this means that the driver was already loaded. If the device is USB or SCSI, no additional drivers need to be loaded if you are running the generic FreeBSD kernel. After inserting the DVD media into the device, you can start the burn using this command:
growisofs -Z /dev/cd0=PCBSD9.1-x64-DVD.iso
If your device is not the first CD device, change the number 0 accordingly. If your ISO has a different name, substitute the correct name in the command shown above.
2.5.3 Burning the CD/DVD ISO File on a Mac OSX System
To burn the ISO on a Mac OSX system, go to Finder ➜ Applications ➜ Utilities ➜ Disk Utility. With a blank media inserted into the burner, highlight the device representing the CD/DVD writer and click the “Burn” button. This will open up a browser where you can select the ISO to burn. In the example shown in Figure 2.5j, the DVD ISO has been selected and the device is a Sony DVD writer.
Figure 2.5j: Using Disk Utility
Once the ISO is highlighted, click the “Burn” button. A pop-up message will indicate that the device is ready to burn. Click burn once more and Disk Utility will write the ISO to the CD/DVD media.
2.5.4 Writing an IMG File to USB
To write an .img.bz2 file you will need the following:
a utility that can extract .bz2 zipped files
a utility that can write the image to a USB media; the utility that you use will depend upon your operating system
a USB thumb drive or hard drive large enough to hold the image
Once the image is written, boot from the removable device and proceed with the PC-BSD® installation.
2.5.4.1 Writing the IMG File on a Linux or BSD System
If you selected to download an .img.bz2 file instead of an ISO, you can write the image file to a flash card or removable USB drive using the bunzip2 and dd command line utilities on a BSD or Linux system. On a FreeBSD system, the superuser can use these commands to extract the specified image and write it to the first plugged in USB device:
bunzip2 PCBSD9.1-x64-USBFULL.img.bz2
dd if=PCBSD9.1-x64-USBFULL.img of=/dev/da0 bs=64k conv=sync
63200+0 records in
63200+0 records out
4141875200 bytes transferred in 1395.261087 secs (2968531 bytes/sec)
When using the dd command:
if= refers to the input file to be written; it should end with an .img extension
of= refers to the output file (the device name of the flash card or removable USB drive); increment the number in the name if it is not the first USB device
bs= refers to the block size
conv=sync pads the final block so it is the specified block size
NOTE for Linux users: if you type mount with the USB stick inserted, you will see two or more device nodes corresponding to the USB stick. For example, /dev/sdc and /dev/sdc1, where /dev/sdc1 corresponds to the primary partition of the USB stick. Before using the dd command, ensure that the usb stick is first unmounted. When using the dd command, remember to use /dev/sdc (device node without the number) as the option for the output file of=. Once the dd completes, you might not be able to mount the USB stick on Linux as Linux has very limited support for UFS, the BSD filesystem that gets created on the USB stick.
2.5.4.2 Writing the IMG File on a Windows System
To burn the image file on a Windows system, you can use win32-image-writer. You will also need a utility that can extract .bz2 files such as 7-Zip.
When downloading win32-image-writer, download the latest version that ends in -binary.zip and use a utility such as Windows Explorer or 7zip to unzip the executable.
To extract the PC-BSD® image file using 7-Zip, browse to the location containing your downloaded .img.bz2 file, as seen in the example in Figure 2.5k.
Click the “Extract” button and browse to the location where you would like to save the extracted image. Once extracted, your image will end in .img and is now ready to be written to a USB device using the win32-image-writer application.
If you launch win32-image-writer.exe, it will start the Win32 Disk Imager utility, shown in Figure 2.5l. Use the “browse” button to browse to the location of the .img file. Insert a USB thumb drive and select its drive letter (in this example, drive D). Click the “Write” button and the image will be written to the USB thumb drive.
Figure 2.5k: Using 7-Zip to Extract Image File
Figure 2.5l: Using Win32 Disk Imager to Write the Image
2.5.4.3 Writing the IMG File on a Mac OSX System
To extract the .img.bz2 file on a Mac system, use Finder to browse to the location of the file, as seen in Figure 2.5m.
Simply double-click the file to extract it to the .img format. Finder will create a second file with the .img extension.
Figure 2.5m: Extracting the Image on Mac
To burn that .img file, insert a USB stick and open Terminal. Run the diskutil list command to find out the device name of the USB disk, unmount the USB disk, then use dd to write the image to the raw disk (rdisk). In the following example, an 8GB USB stick has a device name of /dev/disk1 and a raw device name of /dev/rdisk1.
diskutil list
/dev/disk0
#: TYPE NAME SIZE IDENTIFIER
0: GUID_partition_scheme *500.1 GB disk0
1: EFI 209.7 MB disk0s1
2: Apple_HFS Macintosh HD 499.2 GB disk0s2
3: Apple_Boot Recovery HD 650.0 MB disk0s3
/dev/disk1
#: TYPE NAME SIZE IDENTIFIER
0: FDisk_partition_scheme *8.0 GB disk1
1: DOS_FAT_32 UNTITLED 8.0 GB disk1s1
diskutil unmountDisk /dev/disk1
Unmount of all volumes on disk1 was successful
sudo dd if=/Users/dru/Downloads/PCBSD9.1-x64-USBFULL.img of=/dev/rdisk1 bs=4m
Password:
375+0 records in
375+0 records out
1572864000 bytes transferred in 86.742798 secs (18132502 bytes/sec)
Beginning with PC-BSD® 9.1, Live Mode is a read-write live image that is only available for USB media. The uncompressed live image is about 4GB in size, but you will want to write it to a USB device that will provide sufficient room for the files that you wish to save and any applications that you wish to install.
NOTE: the speed of Live Mode is dependent upon the quality of the USB device. If you are purchasing a device, look for one that is advertised as "high speed".
To use PC-BSD® Live Mode, download the live USB version. Once you have written the image file to a USB media, boot the system with the USB device inserted. Assuming your BIOS has been set to boot from that device, you should see some startup messages followed by the PC-BSD® graphical boot menu, shown in Figure 2.6a.
Figure 2.6a: PC-BSD® Graphical Boot Menu
The options in this menu are described in Booting Into PC-BSD®. If you press enter or wait 10 seconds, the system will continue to boot. If this is the first time you have booted into the image, the boot will pause with this message:
Trying to mount root from ufs:mdo []...
tput: no terminal type specified and no TERM environmental variable.
Do you want to expand the file-system for this LIVE media?
This process may take up to 15 minutes.
Resize? (y/n):
This step grows the filesystem so that it can use the entire capacity of the USB device. Press y to expand the filesystem and reboot into live mode:
Resizing file-system da0a on da0, this may take a few minutes...
Adjusting partition tables on da0...
Running growfs on da0a, this may take a while...
Cleaning up...
Rebooting...
You will know that you have successfully entered live mode when you are asked to accept the graphics resolution mode that is considered to be optimal for your hardware.
If this is your first boot, you will then proceed through the post-installation configuration screens, ending in the Logging In screen.
When logging in, use the user account and password that you were prompted to create. Three desktops are available: Fluxbox, LXDE, and Openbox.
2.7 Using VirtualBox
A virtualized environment allows you to test drive an operating system without overwriting your current operating system. This is an excellent way to practice installation, determine whether all of your hardware is supported, or to try multiple versions of different operating systems. Virtualization software effectively creates windows (known as virtual machines) into which you can install and use an operating system. The only limitation to virtualization is your hardware as each virtual machine uses CPU and RAM. Depending upon the amount of CPU and RAM in your computer, you may find that the operating system you install using virtualization software runs slowly. If your computer slows down greatly, try closing other applications running on your computer to free up some RAM.
PC-BSD® provides a PBI for VirtualBox, an open source virtualization program. VirtualBox also runs on Windows, Linux, Macintosh, and OpenSolaris and supports a large number of operating systems that can be installed into a virtual machine. If your computer is already running a version of PC-BSD®, you can use AppCafe® to install VirtualBox. If your computer is running another operating system, download the binary for your operating system from the VirtualBox Downloads page.
In order to use PC-BSD® within VirtualBox, you will need to either:
download the PC-BSD® virtual disk, which contains a virtual machine with a pre-installed version of PC-BSD®, or
download the PC-BSD® ISO, create your own virtual machine, and use the ISO to install PC-BSD® into it.
NOTE: VirtualBox does not automatically support USB as a boot device. The Oracle VM VirtualBox Extension Pack can be used to convert an .img file to a VMDK. However, there is no BSD Extension Pack at this time. This means that you should not download a PC-BSD® USB image if you plan to use it within VirtualBox on a BSD system.
If you have downloaded the PC-BSD® virtual disk, skip ahead to Using the Downloadable VirtualBox Disk.
If you have downloaded the ISO file, you will need to first create a virtual machine that meets the following minimum requirements:
512 MB base memory size
a virtual disk at least 10 GB in size to hold the operating system and swap
a bridged adapter
2.7.1 Creating a Virtual Machine
Once installed, start VirtualBox to see the screen shown in Figure 2.7a:
Figure 2.7a: Initial VirtualBox Screen
To create the virtual machine, click the “New” button to start the new virtual machine wizard. Click the “Next” button to see the screen in Figure 2.7b:
Figure 2.7b: Type in a Name and Select the Operating System for the New Virtual Machine
Enter a name for your virtual machine, which can be anything that makes sense to you. Click the “Operating System” drop-down menu and select BSD which will automatically change the “Version” menu item to FreeBSD. Click Next to see the screen in Figure 2.7c.
The base memory size must be changed to at least 512 MB. If you wish to use ZFS, it will need to be at least 2048 MB. If your system has a lot of RAM, use more. Any number within the green area is considered a safe value by VirtualBox, meaning it should not slow down your computer too much. When finished, click Next to see the screen in Figure 2.7d.
This screen is used to create the virtual hard disk--in other words, the amount of disk space that will be available to the virtual machine. If this is your first virtual machine, keep the default of “Start-up disk” and click “Next”. If you have created a virtual machine in the past and wish to reuse its disk space, select “Use existing hard disk” from the drop-down menu. You can create as many virtual machines as you wish. However, if your computer is getting low on disk space, you should consider reusing existing virtual hard disks to prevent your hard drive from being used up by old virtual machines.
If you choose to create a new hard disk, the “Create New Virtual Disk Wizard”, seen in Figure 2.7e, will launch when you click “Next”.
Figure 2.7c: Select the Amount of Memory Reserved for the Virtual Machine
Figure 2.7d: Select Whether to Use an Existing or Create a New Virtual Disk
Figure 2.7e: Create New Virtual Disk Wizard
The wizard can be used to create the following types of virtual disk formats:
VDI: Virtual Disk Image is the format used by VirtualBox. Select this option if you downloaded a PC-BSD® ISO file.
VMDK: Virtual Machine Disk is the format used by VMWare.
VHD: Virtual Hard Disk is the format used by Windows Virtual PC.
HDD: is the format used by Parallels.
Once you make a selection, click the “Next” button to see the screen in Figure 2.7f.
You can now choose whether you want “Dynamically allocated” or “Fixed size” storage. The first option uses disk space as needed until it reaches the maximum size that you will set in the next screen. The second option creates a disk the same size as that specified amount of disk space, whether it is used or not. Choose the first option if you are worried about disk space; otherwise choose the second option as it allows VirtualBox to run slightly faster. Once you select Next, you will see the screen in Figure 2.7g.
This screen is used to set the size (or upper limit) of the virtual machine. If you plan to install PC-BSD® into the virtual machine, increase the size to at least 10 GB or you will receive an error during the PC-BSD® installation. If you plan to install KDE, GNOME, multiple desktop managers, or PBIs within the virtual machine, you will probably want to choose at least 20 - 30GB. Whatever size you set, make sure that your computer has enough free disk space to support it. Use the folder icon to browse to a directory on disk with sufficient space to hold your virtual machine.
Once you make your selection and press “Next”, you will see a summary of your choices. You can use the “Back” button to return to a previous screen if you wish to change any values. Otherwise, click “Create” to finish using the wizard. Your virtual machine should now show up in the left box, as seen in the example in Figure 2.7h.
Figure 2.7f: Select the Storage Type for the Virtual Disk
Figure 2.7g: Select the File Name and Size of the Virtual Disk
Figure 2.7h: The New Virtual Machine
2.7.1.1 Configuring the Network Adapter
If you wish to use your network card, you will need to configure bridging on your virtual machine. To do this, go to Settings ➜ Network. In the “Attached to” drop-down menu select “Bridged Adapter” then select the name of the physical interface from the “Name” drop-down menu. In the example shown in Figure 2.7i, the Intel Pro/1000 Ethernet card is attached to the network and has a device name of re0.
Figure 2.7i: Configuring a Bridged Adapter in VirtualBox
2.7.1.2 Configuring the Storage Device
Before starting your virtual machine, you will want to configure it to use your installation media. Click the Storage hyperlink in the right frame to access the storage screen seen in Figure 2.7j.
Double-click the word Empty, which represents your DVD reader. If you wish to access the PC-BSD® installer from your DVD reader, double-check that the Slot is pointing to the correct location (e.g. IDE Secondary Master) and use the drop-down menu to change it if the location is incorrect. Click the “CD/DVD Device” drop-down menu to change it from empty to the Host Drive value.
If you prefer to use an ISO that is stored on your hard disk, click the DVD icon ➜ “Choose a virtual CD/DVD disk file” to open a browser menu where you can navigate to the location of the ISO. Highlight the desired ISO and click Open. The name of the ISO will now appear in the Storage Tree section.
NOTE: the selected ISO/DVD can be 32-bit, even if you are using VirtualBox on a 64-bit system. Depending upon the extensions available in your CPU, you may or may not be able to run a 64-bit ISO on a 64-bit system. If you receive the error “your CPU does not support long mode” when you try to boot a 64-bit ISO, your CPU either does not have the required extension or AMD-V/VT-x is disabled in the system BIOS.
Figure 2.7j: The Storage Settings of the Virtual Machine
You are now ready to install PC-BSD® into your virtual machine. Simply highlight the virtual machine and click on the green Start icon. A window will open indicating that the virtual machine is starting. If you have a DVD inserted, you should hear it spin and it should start to boot into the installation program. If it does not or if you are using an ISO stored on the hard disk, press F12 to select the boot device when you see the message to do so, then press “c” to boot from CD-ROM. You can then proceed through the installation as described in the Installation section.
NOTE: the virtual machine will capture your mouse pointer. Use your right Ctrl button if you wish to leave the virtual machine and use your mouse to interact with other applications on your computer. To go back to the virtual machine, simply click anywhere inside the virtual machine and VirtualBox will re-capture your mouse pointer.
2.7.2 Installing VirtualBox Guest Additions
Beginning with PC-BSD® 9.0, you can install the VirtualBox Guest Additions either during installation or afterwards using Control Panel ➜ System Manager ➜ System Components ➜ Misc. The guest additions add mouse pointer integration, shared folders between the host and guest, better video support, and a shared clipboard. To use the improved video support, select vboxvideo in Control Panel ➜ Display.
2.7.3 Using the Downloadable VirtualBox or VMWare Disk
PC-BSD® provides pre-built VirtualBox and VMWare disks which create a a pre-made virtual machine with PC-BSD already installed. The VirtualBox file ends in a .vdi.bz2 extension and the VMWare disk file ends in a .vmdk.bz2 extension. The .bz2 means that either file needs to be unzipped first so that it just ends with a .vdi or .vmdk extension.
On a Linux or BSD system, use the bunzip2 command by giving it the name of the file which you downloaded:
bunzip2 PCBSD9.0-x86-VBOX.vdi.bz2
Since this is a large file, the command will take a few minutes to extract the image. You will receive the prompt back when it is finished.
On a Windows system, you can use a utility such as 7-Zip. On a Mac OS X system, simply double-click the file in Finder to extract it.
Once the file is unzipped, open VirtualBox as described in Creating a Virtual Machine. When you get to Figure 2.7d, select “Use existing hard disk”.
Use the browse icon to browse to the location of the .vdi or .vmdk file then press “Next”. A message will indicate that the virtual machine will be created; click the “Create” button to finish the wizard. You can then configure the network adapter and start the virtual machine.
The virtual machine will boot into PC-BSD®. Once the display wizard is finished and the login prompt appears, input the password pcbsd at the login screen. Should you be prompted for the administrative password, it is the same value. Since the password is a known value, you should create your own user account and change the root user's password using User Manager.
2.7.4 Troubleshooting VirtualBox
While using a virtual environment allows you to test an operating system without affecting what else is currently installed on the system, there are some things to be aware of when using VirtualBox.
If the installer program fails to load, try increasing the amount of RAM in the virtual machine. The bare minimum is 512 MB, but increasing this value to 1024 or higher will sometimes allow an unbootable ISO to boot into the installer.
If the installation fails and you would like to review the installation log, right-click the virtual machine window and select xterm from the menu. You can now type more /tmp/pc-sysinstall.log to review the log.
Ctrl-f (right ctrl key only) will toggle the virtual machine window in and out of full-screen mode.
The FreeBSD VirtualBox wiki contains additional information that may assist you in troubleshooting VirtualBox issues.
3 Installing PC-BSD®
PC-BSD® can be installed from the installation media directly onto a hard drive or into a virtual machine using virtualization software such as Virtualbox. You can also try PC-BSD® without installing it by using a Live version.
The installation of PC-BSD® is a fast, easy and straight-forward process. The graphical installer will take you step-by-step through the whole process by asking a few simple questions. Within a short period of time, your PC-BSD® system will be installed, configured, and ready to use. This section will walk you through the following installation steps:
3.1 Starting the PC-BSD® Installation
To begin the PC-BSD® installation, insert the boot media and boot the system. If the computer boots into an existing operating system instead of the installer, reboot and check your computer's BIOS program to ensure that the drive containing the installation media is listed first in the boot order. Save your BIOS changes and reboot.
After a couple of seconds, a series of lines of code will scroll down the screen, meaning that PC-BSD® is being loaded. Soon after, you should see a screen similar to Figure 3.1a:
Figure 3.1a: PC-BSD® Installer Boot Menu
There are 7 options to choose from:
1. Boot [default]: starts the installation program with all standard options enabled. This is the default if you do not select anything else within 10 seconds.
2. Boot with ACPI enabled: this enables power management, which may be useful for certain BIOS's and laptops.
3. Boot in Safe Mode: select this option if the installation still hangs when probing your hardware and option #2 did not help. It will boot with a forced PIO mode (disabling the use of DMA), disable write caching for all IDE hard drives and CD ROM drives, disable the probing of EISA slots (as very few systems have them), and (on i386 systems) disables the use of ACPI and APICs.
4. Boot with verbose logging: select this option if you would like to see more detailed messages during the boot process. This can be useful if you are troubleshooting which piece of hardware is causing the installation to hang.
5. Boot to emergency console: advanced users can use this option to fix critical system failures.
6. Boot with X in VESA mode: if the installation program is unable to load your video driver, restart the computer and select this option. The installer will default to VESA mode which should work on any system with a video card.
7. Escape to loader prompt: advanced users can select this option to perform advanced operations, such as changing kernels or loading kernel modules.
If you press enter or select any option other than 5 or 7, PC-BSD® will boot into the graphical installer.
3.2 Language Selection Screen
The first graphical installer screen, seen in Figure 3.2a, indicates that the installer successfully loaded and is ready to present you with its options:
Figure 3.2a: Welcome and Language Selection Screen
Starting on the left-hand side, the icons in the bottom navigation area allow you to:
access Hardware Compatibility information
read that screen's Help text
use the onscreen keyboard
switch between the US keyboard layout and a user selected layout
abort the installation
navigate to a previous or upcoming screen
This initial screen allows you to select your language. The menus in PC-BSD® have been translated to several different languages and you can see the status of your native language at the PC-BSD® Translation Site. If your language does not show 100% translation at this website, it means that not all of the menus have been translated yet and that the untranslated menus will instead display in English. You are welcome to join the PC-BSD® Translators Mailing List if you would like to assist in translating menus to your native language.
By default, PC-BSD® menus will display in English, unless you select another language in the drop-down menu in this screen.
NOTE: small screens may not display the entire installer window, which means that the buttons at the bottom of the window are hidden and inaccessible. There are two solutions for this situation: press Alt while dragging the window with the mouse, or press Alt+N to select the next button of the window.
When you are finished, click the “Next” button to go to the next installation screen.
3.3 System Selection Screen
The “System Selection” screen, shown in Figure 3.3a, allows you to select the system components and window managers to install with PC-BSD®.
The default selection will depend upon the amount of RAM on the system. Systems containing more than 2GB of RAM will default to the KDE desktop and all other systems will default to the LXDE desktop. The arrow buttons can be used to browse through the primary window managers or to install a FreeBSD or TrueOS server instead of a PC-BSD® desktop. Before leaving this screen, click the "Customize" button to review a larger selection of desktops and system components to install. If you right-click a component and select "View Packages", a pop-up menu will list the packages that are installed with that component.
After installation, you can return to this "Customize" screen in order to install or uninstall additional components by going to Control Panel ➜ System Manager ➜ System Packages.
Figure 3.3a: System Selection Screen
In the example shown in Figure 3.3b, the user clicked “Components” then right-clicked Development ➜ Development-Science to view the packages to be installed with this component.
Figure 3.3b: Browsing Additional System Components
The following components are available for installation.
Desktops: includes the following supported desktops: GNOME2, KDE4, LXDE, and XFCE4. If you expand the + next to a desktop, you can select which components to install with that desktop. You can select as many desktops and components as you wish to install.
Development: software utilities suited for developers. These include the valgrind debugging tool, QT development tools, CMake, GNU make, Subversion, and git.
Hardware-Drivers: if you expand the + you can select additional drivers to install: HPLIP (for HP printers), Handheld (for syncing with WinCE devices), and NVIDIA (for older NVIDIA cards). If you have an older NVIDIA video card or a HP printer, check the applicable box to install the required drivers.
Misc: if you expand the + you can select from the following: Compiz, the MythTV DVR, VMwareGuest, VirtualBox Guest additions, and the XBMC media center.
Unsupported-Desktops: additional light-weight desktops for expert users. If you expand the + you can select from Awesome, Enlightenment, evilWM, FVWM, i3, IceWM, Openbox, Ratpoison, spectrwm, WindowLab, or Window Maker.
NOTE: Fluxbox is always installed and available in the login menu of a PC-BSD® system.
If you check the box of a component that has a + next to it, it will automatically select all of its sub-components. You can click the + to expand and uncheck any sub-components that you do not wish to install. Once you have made your selection(s), click the “Save” button to save your selections. The “System Selection” box will list the components that you selected for installation. You can now click the “Next” button to proceed to the next screen.
3.4 Disk Selection Screen
The “Disk Selection” screen, seen in Figure 3.4a, summarizes the default disk configuration.
By default, PC-BSD® will assume that you wish to install on the entire first disk. On systems with less than 2GB of RAM, that drive will be formatted with the UFS+SUJ filesystem. On systems with 2GB or RAM or more, that drive will be formatted with the ZFS filesystem.
DANGER! If you are installing PC-BSD® as the only operating system on your computer, simply click “Next” to start the installation. However, if this is not your intent, review the rest of this section to determine how to layout your disk. If you plan on booting PC-BSD® with another operating system, you should also review the section on Dual Booting.
Figure 3.4a: Disk Selection Screen
If you wish to select which disk or partition to install PC-BSD® into, click the “Customize” button to start the Disk Setup Wizard, shown in Figure 3.4b.
Figure 3.4b: Disk Setup Wizard
The wizard provides three modes of operation. The rest of this section describes these modes in detail.
Basic: (default) select this mode if you wish to specify which partition or disk to install to or if you wish to encrypt user data.
Advanced: select this mode if you wish to specify the installation partition or disk, use GPT partitioning, encrypt user data, disable the FreeBSD boot menu, or specify the filesystem to use and the layout of that filesystem.
FreeBSD Expert: select this mode if you prefer to drop down to a shell to manually enter the commands to setup your disk.
Regardless of the mode that you select, once the disk wizard completes and you click “Next” at the disk “Summary” screen, a pop-up window will ask if you would like to start the installation. Be sure to review the disk summary before clicking “Yes” and starting the installation.
NOTE: the disk “Summary” screen is your very last chance to make sure that you are ready. Once you click “Yes”, the selected hard drive or partition will be formatted and any data it contains will be lost.
3.4.1 Basic Mode
If you select “Basic” mode, the wizard will display the screen shown in Figure 3.4c.
By default, the first hard disk will be selected. If you wish to install on a different disk, use the “Selected Disk” drop-down menu to select the disk to install into.
By default, the entire selected disk will be formatted. If the disk has been divided into partitions and you wish to install into a specific partition, use the “Selected Partition” drop-down menu to select the desired primary partition.
NOTE: PC-BSD® will only install into a primary partition. That is, you can not install PC-BSD® into a secondary or an extended partition. If you wish to create a new primary partition to install into, see Partitioning the Hard Drive for instructions on how to do this.
Figure 3.4c: Select a Disk or Partition
Once you have selected the disk and partition, click “Next” to see the screen shown in Figure 3.4d.
Figure 3.4d: Encrypt Data Screen
If you wish to encrypt the data in your home directory, check the box labelled “Encrypt user data”. This option will automatically encrypt all of the data stored in /usr, including the home directories of all of the users that you create. If you decide to encrypt, review the section if you encrypted a filesystem for instructions on how to enter your passphrase at system bootup.
If you check this box, enter and confirm a passphrase. You will be prompted to enter this passphrase whenever you boot into PC-BSD®. This means that if someone else boots your computer, they will not be able to boot into PC-BSD® if they do not know your passphrase. However, if you forget your passphrase, you will not be able to access PC-BSD® either. For these reasons, it is important to choose a good passphrase that other users will not guess and which you will not forget. Passphrases are case-sensitive and can contain spaces. The passphrase should be memorable to you, such as a line from a song or piece of literature, but hard to guess in that people who know you should not be able to guess your favorite line from a song or piece of literature.
NOTE: be careful if you have changed your keyboard variant and layout. At this time, the GELI encryption framework only supports QWERTY passphrases, so do not use any characters not found on a QWERTY keyboard in your passphrase. DO NOT set a passphrase with accents or special characters which are not found on a US keyboard. This is a limitation in FreeBSD as the keymap is not loaded until after the passphrase is entered, meaning that such a passphrase will render that partition as inaccessible.
It is important to remember to make a backup copy of your keys either to another system or to a removable media such as a USB thumb drive. You should do so after your first boot into PC-BSD®. The keys are located in /boot/keys/, so that is the directory that you should backup.
Once you click “Next”, the wizard will return to the disk “Summary” screen so that you can review your selections. If you wish to change anything, use the “Back” button to return to a previous screen. Otherwise, click “Finish” to leave the wizard. Click “Next” then “Yes” to start the installation.
3.4.2 Advanced Mode
If you select advanced mode, the wizard will again display the screen shown in Figure 3.4c. This time, that screen has the addition of a checkbox:
Partition disk with GPT: GPT is a partition table layout that supports larger partition sizes than the traditional MBR layout. If your installation disk/partition is larger than 2 TB, this box must be checked, otherwise checking this box is optional. Some older motherboards do not support this option. If the installation fails with this option checked, try again with the box unchecked. It has been reported that some Linux distros do not understand UFS partitions that use GPT. When in doubt, leave this box unchecked.
NOTE: if you plan to dual boot with LILO or legacy GRUB, do not check the GPT box. These bootloaders do not support the GPT format.
After making your selections click “Next” to access the filesystem selection screen shown in Figure 3.4e.
This screen allows you to choose from the following filesystem types:
UFS: the Unix File System is the original filesystem used by BSD systems. This is the default selection on systems with less than 2GB of RAM.
ZFS: this filesystem was originally developed by Sun and adds many features. You can learn more about ZFS at Wikipedia and the FreeBSD Handbook. This is the default selection on systems with more than 2GB of RAM and, due to ZFS RAM requirements, is not available for selection on systems with less than 2GB of RAM.
Figure 3.4e: Selecting the Filesystem
This screen also provides the following checkbox:
Install bootable MBR: this option displays the FreeBSD boot manager when the system boots. This is a simple and non-configurable boot manager which may or may not detect other operating systems installed on the computer. If you plan to only boot into PC-BSD® or to configure an alternate boot manager, you can uncheck this box.
The rest of this section demonstrates how to customize the UFS or ZFS layout.
3.4.2.1 UFS Layout
If you select UFS and click “Next”, the default UFS layout will be displayed, as seen in the example in Figure 3.4f. In this example, a 12GB disk has four partitions with mount points for /, SWAP, /var, and /usr. The actual sizes of the partitions created by the default layout will vary, depending upon the size of the disk, but always follow this logic:
the default size of / (root) will be 2 GB; this partition holds the root user's home directory as well as the files needed by the operating system. You should not use a size less than 1 GB. Do not store large files in the root user's home directory as the root partition is meant to be reserved for the operating system files.
the default size of the swap partition will be RAM (physical memory) size times 2 up to a maximum of 4GB. You can increase this if you want a larger swap partition (also known as a paging file or virtual memory in Windows), though this is not necessary as PC-BSD® has a built-in Swap Extender Daemon (swapexd) that monitors how much swap space is available on the system. When the operating system is running out of swap space, swapexd attempts to create a new, larger swap file. When the operating system no longer needs so much swap space, swapexd decreases the size of the swap file.
NOTE: if your hardware uses a solid state drive instead of a hard drive (e.g. an Asus Eee Netbook), do not create a swap partition as swap will shorten the life of the solid state drive. swapexd will not create a swap file if you do not create one during installation.
the default size of /var will be 2 GB. This partition holds data that varies such as logs, printer queues, and the FreeBSD packages database. You can safely increase the size of this partition, though this is usually not needed on a desktop system.
the rest of the disk space will go to /usr. This partition holds everything else, such as users' home directories and installed applications.
Figure 3.4f: Default UFS Layout
The UFS+SUJ means that this version of UFS adds a light version of journaling to soft updates as described in this technical paper. This is the default filesystem type as it virtually eliminates the need to run fsck. In practical terms, this means that even if the system is not cleanly shutdown (e.g. because of a power outage), it will still boot up quickly without losing any data.
If you right-click any partition other than /, you can select to "Enable Encryption". A pop-up box will prompt for the passphrase. When the system boots, you will be prompted for the passphrase for each partition that you encrypt, so be sure to remember the passphrases and to backup your encryption keys as described in the Basic Mode section.
Three buttons are provided should you wish to modify the default layout:
Add: this button will remain greyed out as long as there is no free space to work with. If free space is available, this button can be used to add a partition. It will prompt you for the name of the mount point and size of the new partition.
Resize: allows you to decrease or increase (if free space is available) the size of the highlighted partition.
Remove: will delete the highlighted partition. This can be used to create free space in order to recreate that partition at a smaller size or to increase the size of the remaining partitions.
If you decide to change the default partitions, keep the following points in mind:
You must have a / partition to hold the operating system; make sure it is at least 1 GB in size.
Unless your system has a solid state drive, you want a swap partition.
You can have one big root partition (plus a swap partition). If you decide to do this, the installation will create /var and /usr directories as they are needed by applications. This is often discouraged on server systems, but is an option on desktop systems.
You can remove /usr and divide the newly created free space into multiple partitions. For example, some users like to create separate partitions to hold their video files, artwork, work files, etc. When creating multiple partitions, use names that makes sense to you (e.g. /usr1, /usr2 or /video, /work) and set sizes that makes sense for the amount of content each partition will hold. If you decide to take this approach, you should still make a good sized /usr (otherwise it will be placed on root which will quickly fill up the / partition). The size of /usr should be sufficient to store any software you install.
Once you click Next, the wizard will show a summary of your selections. If you wish to change anything, use the “Back” button to return to a previous screen. Otherwise, click “Finish” to leave the wizard and return to the “Disk Selection” screen.
3.4.2.2 ZFS Overview
ZFS is a combined filesystem and logical volume manager originally designed by Sun Microsystems. It was ported to FreeBSD and has been part of the operating system since FreeBSD 7.0.
ZFS provides many features including: support for high storage capacities, snapshots and copy-on-write clones, continuous integrity checking and automatic repair, RAIDZ which was designed to overcome the limitations of hardware RAID, and native NFSv4 ACLs.
If you are new to ZFS, the Wikipedia entry on ZFS provides an excellent starting point to learn about its features. These resources are also useful to bookmark and refer to as needed:
The following is a glossary of terms used by ZFS:
Pool: a collection of devices that provides physical storage and data replication managed by ZFS. This pooled storage model eliminates the concept of volumes and the associated problems of partitions, provisioning, wasted bandwidth and stranded storage. Thousands of filesystems can draw from a common storage pool, each one consuming only as much space as it actually needs. The combined I/O bandwidth of all devices in the pool is available to all filesystems at all times. The Storage Pools Recommendations of the ZFS Best Practices Guide provides detailed recommendations for creating the storage pool.
Mirror: a form of RAID where all data is mirrored onto two disks, creating a redundant copy should one disk fail.
RAIDZ: ZFS software solution that is equivalent to RAID5 in that it allows one disk to fail without losing data. Requires a minimum of 3 disks though 5 disks is recommended.
RAIDZ2: double-parity ZFS software solution that is similar to RAID6 in that it allows two disks to fail without losing data. Requires a minimum of 4 disks.
RAIDZ3: triple-parity ZFS software solution. RAIDZ3 offers three parity drives and can operate in degraded mode if up to three drives fail with no restrictions on which drives can fail.
Dataset: once a pool is created, it can be divided into datasets. A dataset is similar to a folder in that it supports permissions. A dataset is also similar to a filesystem in that you can set properties such as quotas and compression.
Snapshot: a read-only point-in-time copy of a filesystem. Snapshots can be created quickly and, if little data changes, new snapshots take up very little space. For example, a snapshot where no files have changed takes 0MB of storage, but if you change a 10GB file it will keep a copy of both the old and the new 10GB version. Snapshots provide a clever way of keeping a history of files, should you need to recover an older copy or even a deleted file. For this reason, many administrators take snapshots often (e.g. every 15 minutes), store them for a period of time (e.g. for a month), and store them on another system. Such a strategy allows the administrator to roll the system back to a specific time or, if there is a catastrophic loss, an off-site snapshot can restore the system up to the last snapshot interval (e.g. within 15 minutes of the data loss). Snapshots can be cloned or rolled back, but the files on the snapshot can not be accessed independently.
Clone: a writable copy of a snapshot which can only be created on the same ZFS volume. Clones provide an extremely space-efficient way to store many copies of mostly-shared data such as workspaces, software installations, and diskless clients. Clones do not inherit the properties of the parent dataset, but rather inherit the properties based on where the clone is created in the ZFS pool. Because a clone initially shares all its disk space with the original snapshot, its used property is initially zero. As changes are made to the clone, it uses more space.
3.4.2.3 ZFS Layout
If you select ZFS and click “Next”, the disk setup wizard allows you to configure your ZFS layout. The default layout is seen in Figure 3.4g.
Figure 3.4g: ZFS Configuration
If you wish to format the hard drive or partition that you selected in Figure 3.4c with ZFS, leave the "Enable ZFS mirror/raidz mode" box unchecked and click "Next" to go to the "Encrypt user data" screen shown in Figure 3.4d. Unlike UFS, which only encrypts /usr/, selecting encryption for ZFS encrypts the entire pool. In other words, it encrypts the entire selected disk or partition, except for a small, UFS /boot partition.
If your system contains multiple drives and you would like to use them to create a ZFS mirror or RAIDZ, check the box “Enable ZFS mirror/raidz mode” which will enable the rest of the options in this screen. In the example shown in Figure 3.4g, the system has 7 disks, all of which are the same size. The first disk, ada0, was pre-selected in Figure 3.4c and the remaining 6 disks (ada1 to ada6) are available to be added to the ZFS pool.
NOTE: the PC-BSD® installer requires you to use entire disks (not partitions) when creating a ZFS mirror or RAIDZ. At this time, encryption is not supported for multiple disk configurations.
If you have never configured a RAIDZ before, take the time to read the RAIDZ Configuration Requirements and Recommendations first. It indicates the optimum number of disks for each type of configuration. While ZFS will let you use disks of different sizes, this is discouraged as it will decrease decrease storage capacity and performance of the ZFS system.
The PC-BSD® installer supports the following ZFS configurations:
mirror: requires a minimum of 2 disks.
RAIDZ1: requires a minimum of 3 disks. For best performance, 3, 5, or 9 disks are recommended.
RAIDZ2: requires a minimum of 4 disks. For best performance, 4, 6, or 10 disks are recommended.
RAIDZ3: requires a minimum of 5 disks. For best performance, 5, 7, or 11 disks are recommended.
The installer will not let you save a configuration if your system does not meet the minimum number of disks required by that configuration. As you select a configuration, a message will indicate how many more disks you need to select.
To use multiple disks, select the type of configuration from the “ZFS Virtual Device Mode” drop-down menu, then check the box for each disk that you would like to add to that configuration. When finished, click the “Next” button to see the default layout screen shown in Figure 3.4h.
Figure 3.4h: Default ZFS Layout
Regardless of how many disks you selected for your ZFS configuration, the default layout will be the same. Unlike UFS, ZFS does not require separate partitions for /usr, /tmp, or /var. Instead, you create one ZFS partition (pool) and specify multiple mount points. A /boot partition is not mandatory with ZFS as the PC-BSD® installer puts a 64k partition at the beginning of the drive.
You can use the “Add” button to add additional mount points. You will only be prompted for the name of the mount point as, unlike UFS, size is not limited at creation time. Instead, the data on any mount point can continue to grow as long as space remains within the ZFS pool.
NOTE: do not remove any of the default mount points as they are used by PC-BSD®.
If you right-click any mount point (other than /swap), you can toggle between enabling or disabling any of the following ZFS properties. For performance reasons, the PC-BSD® installer will not allow you to remove or modify /swap.
atime: when set to “on”, controls whether the access time for files is updated when they are read. When set to “off”, this property avoids producing write traffic when reading files and can result in significant performance gains, though it might confuse mailers and some other utilities.
canmount: if set to “off”, the filesystem can not be mounted.
checksum: automatically verifies the integrity of the data stored on disks. Setting this property to “off” is highly discouraged.
compression: if set to “on”, automatically compresses stored data to conserve disk space.
exec: if set to “off”, processes can not be executed from within this filesystem.
Once you click “Next”, the wizard will show a summary of your selections. If you wish to change anything, use the “Back” button to return to a previous screen. Otherwise, click “Finish” to leave the wizard and return to the “Disk Selection” screen.
3.4.3 FreeBSD Expert Mode
If you select FreeBSD expert mode, you will be prompted to launch a terminal where you can use command line utilities such as bsdinstall or sysinstall to manually configure the partitions. When you are finished, type exit to leave the terminal, then click “Next” to review the disk summary. If you wish to change anything, use the “Back” button to return to a previous screen. Otherwise, click “Finish” to leave the wizard and return to the “Disk Selection” screen.
3.5 Installation Progress Screen
Once you select “Yes” to start the installation, a progress screen, seen in Figure 3.5a, provides a progress bar and messages so that you can watch the installation's progress.
How long the installation takes depends upon the speed of your hardware, the installation type you selected, and the number of components to be installed. A typical installation takes between 20 and 40 minutes.
Figure 3.5a: Installation Progress Screen
3.6 Installation Finished Screen
The screen shown in Figure 3.6a appears once the installation is complete.
Click the “Finish” button to reboot into your PC-BSD® installation. Wait until the installer exits before removing the installation media.
Figure 3.6a: PC-BSD® Installation is Now Complete
4 Post Installation Configuration and Installation Troubleshooting
Once PC-BSD® is installed, it will reboot into the new operating system.
If you are dual-booting PC-BSD®, you may need to first add an entry to your boot loader menu. The section on Dual Booting describes how to add a PC-BSD® entry to the GAG, GRUB, and EasyBCD boot loader programs.
The first time PC-BSD® boots, a background script checks the PC-BSD® mirror servers and automatically configures the system to use the fastest mirror. If you find that you have connectivity issues using AppCafe® or Update Manager, it may mean that your default mirror is temporarily unavailable. You can change the mirror setting in System Manager ➜ Mirrors.
Once the PC-BSD® system has finished booting for the first time, the installer will present you with some additional screens so that you can configure your system. This section describes the following post-installation steps and provides some troubleshooting tips for failed installations.
4.1 Booting Into PC-BSD®
After installation, PC-BSD® will reboot and you will be prompted to configure your system and to login to a desktop.
Unless you unchecked the “Install bootable MBR” option in the advanced mode of the disk setup wizard, you will see a FreeBSD boot menu similar to this one when you first boot up:
F1 FreeBSD
F6 PXE
Boot: F1
Your FreeBSD boot menu may vary if other operating systems are installed on the computer or if your system does not support PXE booting. By default, the computer will automatically boot into PC-BSD® (FreeBSD) after a few seconds unless you press another function key listed in the boot menu.
NOTE: if another boot manager is installed on the system, see the section on Dual Booting for instructions on how to add a PC-BSD® entry to the GAG, GRUB, or EasyBCD boot menu programs.
After a few seconds, the boot should continue and you will be presented with the graphical PC-BSD® boot menu, shown in Figure 4.1a.
If you press any key, this screen will pause, allowing you to read and select the desired options. Otherwise, it will pause for a few seconds then continue to load PC-BSD® with the default options.
There are 6 boot options and 4 actions to choose from:
1 Disable ACPI: ACPI controls power management but may be problematic on some hardware. Select this option if you are unable to boot into PC-BSD®.
2 Enable Safe Mode: select this option if the installation hangs when probing your hardware. It will boot with a forced PIO mode (disabling the use of DMA), disable write caching for all IDE hard drives and CD ROM drives, disable the probing of EISA slots (as very few systems have them), and (on i386 systems) disable the use of ACPI and APICs.
3 Enter single user mode: advanced users can use this option to fix critical system failures.
4 Enable verbose logging: select this option if you would like to see more detailed messages during the boot process. This can be useful if you are troubleshooting a piece of hardware.
5 Run X in VESA mode: select this option if PC-BSD® is unable to load your video driver. PC-BSD® will default to VESA mode which should work on any system with a video card.
6 Run the Display Wizard: if you are unable to access the GUI due to a display setting, enable this option to boot into the display settings wizard.
Press the number of an option to select that option. As you make a selection, the FreeBSD bobble-head icon will be filled in, indicating that that option has been selected. To de-select an option, press its number again.
Figure 4.1a: PC-BSD® Graphical Boot Menu
Once you have made your selection(s), you can choose from the following actions:
B Boot PC-BSD® with above options: starts PC-BSD® with the selected options enabled.
D Restore default options: clears your selections.
L Escape to loader prompt: advanced users can select this option to perform advanced operations, such as changing kernels or loading kernel modules. This prompt provides a limited set of commands which are described here.
R Reboot: reboots the computer.
As the system continues to boot, the PC-BSD® splash screen will appear. If you prefer to watch the boot messages, press any key.
4.1.1 If You Encrypted a Filesystem
If you checked the box “Encrypt user data” during PC-BSD® installation, the boot process will pause, waiting for you to input your passphrase. Press enter at the splash screen so that you can see the message, similar to the one shown in Figure 4.1b, in order to type your passphrase.
Figure 4.1b: Prompt to Enter Passphrase
A * should appear for each character that you type, so type slowly and make sure that each keystroke is accepted. If you do not enter the passphrase correctly, this message indicates that you should try again:
GEOM_ELI: Wrong key for ada01se. Tries left: 2.
Once the correct passphrase is entered, you will see a message similar to the following and the boot sequence will proceed.
GEOM_ELI: Device ada01se.eli created.
GEOM_ELI: Encryption: AES-XTS 128
GEOM_ELI: Crypto: software
4.1.2 If Your Display is Not Automatically Detected
Once the first boot is complete, the installer will attempt to set the optimal display settings. A pop-up menu will ask if you would like to accept these settings. Simply click “Yes” to continue. PC-BSD® will now play a short video. You can press Esc to skip the video and move on to the Language screen of the post-installation process.
If you instead select “No”, or if for some reason the installer is unable to find the optimal display settings, you will instead see the “Display Settings” screen shown in Figure 4.1c.
The settings in this screen are described in more detail in Display. If you wish to return to this display wizard at a later time, go to Control Panel ➜ Display.
If you change any display settings, click the “Apply” button for the settings to be tested. If anything goes wrong during testing, you will be taken back to the “Display Settings” screen so that you can try another setting. Once you are happy with the tested setting, click the “Yes” button to save the setting and to proceed.
Figure 4.1c: Display Settings Wizard
4.1.3 Fast Boot
PC-BSD® uses a "fast boot" script to decrease the amount of time that it takes the system to boot to the login screen. When this script is enabled, which is the default, services are started in the background and the boot process does not wait for confirmation from each service as it starts. This is referred to as delayed mode.
The fast boot script is controlled by these lines in /etc/rc.conf:
fastboot_enable="YES"
fastboot_earlyrc="/etc/rc.d/netif /etc/rc.d/moused /etc/rc.d/dhclient /etc/rc.d/pf /etc/rc.d/routing /etc/rc.d/devd /usr/local/etc/rc.d/pefs /usr/local/etc/rc.d/dbus /usr/local/etc/rc.d/hald /usr/local/etc/rc.d/gdm"
The logfile /var/log/rc_delay.log shows the startup messages for the services which were started in delayed mode. If this log indicates that a delayed mode service is not starting correctly, become the superuser, remove the path to that service in the fastboot_earlyrc line of /etc/rc.conf, and reboot to see if that fixes the problem.
If a faster boot time is not important to you and you prefer to watch each service as it starts at boot time, you can disable fast boot by changing the "YES" to a "NO" in the fastboot_enable line of /etc/rc.conf.
4.1.4 Creating a Custom Boot Theme
If you would like to change the image in the graphical boot loader, create a PCX image file. It is important that the file is saved in .pcx format as that is the only image format that the boot loader understands. Additionally, the image must be 640 x 480 pixels and 16 colors. The RGB colors that will be available in the menu text will be taken from the image's palette.
The default PC-BSD® graphical boot theme is found in /boot/themes/default/. To create your own theme, create a new directory in /boot/themes/ (e.g. mkdir /boot/themes/mytheme) and copy your PCX file to that new subdirectory.
Next, copy /boot/themes/default/theme.conf to your new subdirectory. Open the copied file and edit this line to point to the location of your PCX file:
theme_background="/boot/themes/default/bglogo.pcx"
You can change the theme's colors by editing the RGB values in this file. You can also change the font by modifying the theme_font path to point to the font to use. Finally, you can change the locations of the list of options and the actions menu. These are defined with the *_xy settings in the configuration file. The value must be two numbers which specify the X and Y coordinates in pixels, relative to the upper left corner.
To enable your theme, modify this line in /boot/loader.conf to point to the location of your theme.conf file:
beastie_theme="/boot/themes/default/theme.conf"
Once the system has completed its boot, an introductory video will play. You can press the Escape key if you wish to skip the video. If you wish to watch the video at a later time, it is located in /usr/local/share/pcbsd/movies/.
Once the video finishes, the language selection screen will again be displayed, as seen in Figure 4.2a.
Figure 4.2a: Language Selection Screen
This allows you to select the language you will use to access the installed system.
Once you have made your selection, click “Next” to go to the next configuration screen.
4.3 Time Zone Selection Screen
The next configuration screen, shown in Figure 4.3a, allows you to select your timezone. Use the drop-down menu to select the city closest to your location.
Figure 4.3a: Select Time Zone
When finished, click “Next” to proceed to the next screen.
4.4 Set Root Password Screen
This configuration screen, seen in Figure 4.4a, requires you to set the root or administrative password.
The system password, also known as the root, superuser, or administrative password, is required for system administration tasks such as installing server software, setting up your printer, or changing settings that affect all users. You will need to remember this password for the times that you are prompted for it. The password must be a minimum of 4 characters and you are required to type it in twice to confirm the password.
Click the “Next” button when you are finished.
Figure 4.4a: Set Root Password
4.5 Create a User Screen
This screen is used to create the user account that you will use to login to your system.
NOTE: do not login to the system using the root user account. The system has been designed to prompt your user account for the administrative password when it is required.
Figure 4.5a shows the configuration screen used to create the initial user account.
This screen requires you to complete the following fields:
Name: this value will be displayed in the login screen. It can be your full name and can contain capital letters and spaces.
Username: this is the name you will use when logging in. It can not contain spaces and is case sensitive (e.g. Kris is a different username than kris).
Password: this is the password you will use when logging in. You must type it twice in order to confirm it.
If you share your computer with other users, you will be able to create additional user accounts once you are logged in using Control Panel ➜ User Manager.
Figure 4.5a: User Creation Screen
4.6 Connect to a Wireless Network
If the system has an active wireless interface, a screen similar to Figure 4.6a will indicate the wireless networks which were automatically detected.
If you would like to set the default wireless connection, highlight the network that you would like to connect to. If the network does not appear, you can click the “Rescan” button. If you are unable to connect or you wish to configure the connection at a later time, see the section on Network Configuration.
When finished, click the “Next” button to continue the post-configuration tasks.
Figure 4.6a: Connect to a Wireless Network
4.7 Post Install Finished Screen
The screen in Figure 4.7a indicates that the post-installation setup is complete. Click the “Finish” button to access the login menu.
Figure 4.7a: Setup is Complete
4.8 Logging In
Once you have finished setting up your system, you will be presented with the login screen seen in Figure 4.8a:
Figure 4.8a: PC-BSD® Login Screen
The Username that you created in the Create a User Screen will be listed (in this example, it is dru).
NOTE: while the GDM login manager will let you do it, logging in as the root user is STRONGLY DISCOURAGED. If you do login as root, you run the risk of overflowing the / filesystem and will be required to type in the full path of binaries. Instead, login as the user account that you created and input the administrative password whenever a task requires it. If you are working from the command line, you can use the pc-su or sudo commands which will prompt for the administrative password before performing a task that requires root permissions. PC-BSD® will have its own login manager in version 9.2 which will prevent users from logging in as the root user.
If you click the “Universal Access” button in the task bar (round icon with a stick figure), you can set the accessibility options shown in Figure 4.8b.
Figure 4.8b: Universal Access Preferences
If you installed PC-BSD® on a laptop, the taskbar will also show the current battery charge level when you hover your mouse over the power icon. The taskbar includes a clock followed by a “Shutdown Options” icon. If you click that icon, you can choose to restart or shutdown the system.
If you highlight the username, some more options will be added to the left side of the taskbar as shown in Figure 4.8c:
Figure 4.8c: Login Menu with User Selected
These options allow you to select your language, keyboard layout, and desktop to use for the login session. Once you have made your selections, input the password associated with the selected user and press enter.
NOTE: if you just get the login prompt after typing the password, the password was incorrect. Double-check that caps lock is not on and try typing the password again.
If you wish to add or delete any desktops, use the “System Packages” tab of System Manager.
If you wish to enable auto-login, see the section on GDM Configuration.
4.8.1 Welcome & Getting Started
The first time you log in, the PC-BSD® “Getting Started” screen will load as seen in Figure 4.8d.
Figure 4.8d: PC-BSD® Getting Started Screen
If you click the “Next” button, you can read an overview of the utilities that are used to configure your network connection, install applications, configure your system, make a backup, and keep the system updated, as well as how to get involved with the PC-BSD® community. Check the box “Don't show this greeting on next startup” if you do not want to see this screen the next time you log in. To re-open the screen after checking that box, type pc-welcome.
4.9 Installation Troubleshooting
Installing PC-BSD® is usually an easy process that “just works”. However, sometimes you will run into a problem. This section will look at solutions to the most common installation problems.
4.9.1 Installation Starts But Fails
The PC-BSD® installer creates a log which keeps a record of all the steps that are completed as well as any errors. When an installation error occurs, the PC-BSD® installer will ask if you would like to generate an error report. If you click “Yes”, a pop-up message will ask if you would like to save the error log to a USB stick. Type y and insert a FAT formatted USB thumb drive to copy the log.
While in the installer, you can read this log to see what went wrong. Right-click an area on the desktop outside of the installation window and select “xterm” from the menu. You can read the log with this command:
more /tmp/pc-sysinstall.log
If you can not figure out how to fix the error or believe that you have discovered an installation bug, send the log that was saved on the USB stick to the Support mailing list.
4.9.2 System Does Not Boot Into the Installer
If the installer does not make it to the initial GUI installer screen, try unplugging as many devices as possible, such as webcams, scanners, printers, USB mice and keyboards. If this solves the problem, plug in one piece of hardware at a time, then reboot. This will help you pinpoint which device is causing the problem.
If your computer freezes while probing hardware and unplugging extra devices does not fix the problem, it is possible that the installation media is corrupt. If the checksum on the file you downloaded is correct, try burning the file again at a lower speed.
If the system freezes and you suspect the video card to be the cause, review your system's BIOS settings. If there is a setting for video memory, set it to its highest value. Also check to see if the BIOS is set to prefer built-in graphics or a non-existent graphics card. On some systems this is determined by the order of the devices listed; in this case, make sure that the preferred device is listed first. If you can not see your BIOS settings you may need to move a jumper or remove a battery to make it revert to the default of built-in graphics; check your manual or contact your manufacturer for details.
If that change did not help, try rebooting and selecting option “7. Escape to loader prompt” from the boot menu shown in Figure 4.9a.
Figure 4.9a: PC-BSD® Installer Boot Menu
Selecting this option will open the boot loader prompt where you can type the following commands:
unload
disable-module vesa
set module_path=/boot/kernel;/boot/modules;CONSOLE
boot
Those commands will disable the vesa splash screen before attempting to boot the installer.
A not uncommon cause for problems is the LBA (Logical Block Addressing) setting in the BIOS. If your PC is not booting up before or after installation, check your BIOS and turn LBA off (do not leave it on automatic).
If the SATA settings in your BIOS are set to “compatibility” mode, try changing this setting to “AHCI”. If the system hangs with a BTX error, try turning off AHCI in the BIOS.
4.9.3 USB Keyboard Does Not Work in Installer
If the USB keyboard is non-functional, check if there is an option in your BIOS for legacy support in relation to the keyboard or to USB, or both. Enabling this feature in your BIOS may solve this issue.
4.9.4 Getting Help
If none of the above has fixed your problem, search the PC-BSD® forums to see if a solution exists, try a web search, or check the section on Finding Help.
5 Advanced Installation Topics
The previous section discussed a default installation of PC-BSD®. This section covers the following advanced installation topics:
5.1 Install a Server
The System Selection screen of the PC-BSD® installer can be used to install a FreeBSD-based server operating system, rather than a PC-BSD® desktop operating system. This screen provides two server options:
FreeBSD Server: installs a basic, vanilla installation of FreeBSD. While the installation routine is different, the end result is the same as if one had installed FreeBSD from a FreeBSD media as it results in a minimal, command-line only FreeBSD server installation.
TrueOS™: adds the following to a vanilla installation of FreeBSD:PBI Manager,the command line version of warden,and the command line versions of most of the Control Panel utilities. You will find those utilities in /usr/local/bin/pc-*. It also installs this list of additional shells and utilities.
For a server installation, using the PC-BSD® installer rather than the FreeBSD installer offers several benefits:
the ability to easily configure ZFS during installation
the ability to configure encryption during installation
the ability to configure ZFS multiple boot environments
a wizard (described in this section) is provided during installation to configure the server for first use.
To perform a server installation, start the PC-BSD® installation as usual. When you get to the System Selection screen of the installer, click the left arrow until either FreeBSD or TrueOS is selected. In the example shown as in Figure 5.1a, the user has selected TrueOS™ and the FreeBSD option is to the left of the selection.
Figure 5.1a: Selecting to Install TrueOS™
Once selected, press “Next” to start the “Server Setup Wizard”. The wizard is the same for either a FreeBSD or a TrueOS™ installation. Click “Next” to see the screen shown in Figure 5.1b.
Input and confirm the root password which will be used for administrative or superuser access to the server, then click “Next” to proceed to the screen shown in Figure 5.1c.
Figure 5.1b: Set the Root Password
Figure 5.1c: Create the Primary User Account
For security reasons, you should not login as the root user. For this reason, the wizard requires you to create a primary user account that will be used to login to the FreeBSD system. This account will automatically be added to the wheel group, allowing that user to su to the root account when administrative access is required.
This screen contains the following fields:
Name: can contain capital letters and spaces.
Username: the name used when logging in. Can not contain spaces and is case sensitive (e.g. Kris is a different username than kris).
Password: the password used when logging in. You must type it twice in order to confirm it.
Default shell: use the drop-down menu to select the csh, tcsh, or sh login shell.
When finished, click “Next” to proceed to the screen shown in Figure 5.1d.
Figure 5.1d: Set the Hostname
Input the system's hostname. If you will be using ssh to administer the system, check the box “Enable remote SSH login”. Click Next to proceed to the network configuration screen shown in Figure 5.1e.
Figure 5.1e: Configure the Network
Use the “Network Interface” drop-down menu to select from the following:
AUTO-DHCP-SLAAC: (default) will configure every active interface for DHCP and for both IPv4 and IPv6
AUTO-DHCP: will configure every active interface for DHCP and for IPv4
IPv6-SLAAC: will configure every active interface for DHCP and for IPv6
Alternately, select the device name for the interface that you wish to manually configure and input the IPv4 and/or IPv6 addressing information. When finished, click “Next” to proceed to the screen shown in Figure 5.1f.
Figure 5.1f: Install Source or Ports
If you wish to install FreeBSD source or ports, check the associated box(es) then click “Finish” to exit the wizard.
If you are installing TrueOS™, you can use the “Customize” button to install server meta-packages. This screen, shown in Figure 5.1g, can be used to install packages such as MySQL, PostgreSQL, Samba, PHP, VirtualBox, Apache, and Lighttp.
When you have saved your selections, click “Next” to proceed to the Disk Selection screen in order to configure the system's disk(s).
Once the system is installed, it will boot to a command-line login prompt. Login using the primary user account that was configured during installation. You can now configure and use the server as you would any other FreeBSD server installation. The FreeBSD Handbook is an excellent reference for performing common FreeBSD server tasks.
Figure 5.1g: Installing Server Applications into TrueOS™
5.2 Dual Booting
A PC-BSD® installation assumes that you have an existing primary partition to install into. If your computer has only one disk and PC-BSD® will be the only operating system, it is fine to accept the default partitioning scheme. However, if you will be sharing PC-BSD® with other operating systems, care has to be taken that PC-BSD® is installed into the correct partition; otherwise, you may inadvertently overwrite an existing operating system.
If you wish to install multiple operating systems on your computer, you will need the following:
a partition for each operating system. Many operating systems, including PC-BSD®, can only be installed into a primary partition. This means that you will need to use partitioning software as described in Partitioning the Hard Drive.
a boot loader that allows you to select which operating system you wish to boot into. Depending upon the choice of boot loader and the operating systems that you install, you may or may not have to configure the boot loader to list all of the installed operating systems. Also, depending upon the order that you install the operating systems, the existing MBR data may be overwritten. This section will describe the configuration of several different boot loaders and how to restore an overwritten MBR.
a backup of any existing data. This backup should not be stored on your computer's hard drive but on another computer or on a removable media such as a USB drive or burnt onto a DVD media. If you are careful in your installation, everything should go fine. However, you will be glad that you made a backup should something go wrong.
5.2.1 Choosing the Installation Partition
When installing PC-BSD® onto a computer that is to contain multiple operating systems, care must be taken to select the correct partition in the Disk Selection screen of the installation. On a system containing multiple partitions, each partition will be listed. Highlight the partition that you wish to install into and make sure that you do not select a partition that already contains an operating system or data that you wish to keep.
DANGER! make sure that you click the “Customize” button while in the “Disk Selection” screen. If you just click Next without customizing the disk layout, the installer will overwrite the contents of the primary disk.
If you install PC-BSD® on a computer that already contains an operating system, the first time you reboot, your computer will automatically boot into the previous operating system. You will need to configure a boot loader utility to recognize all of the operating systems that are installed and to provide you with a boot menu where you can select which operating system to boot into.
5.2.2 Choosing a Boot Manager
When selecting a boot manager, choose the one that best suits your needs or which is already installed on the computer.
If GRUB is already installed on the system, review the GRUB section before installing PC-BSD® in order to determine which version of GRUB is installed. Legacy GRUB does not support GPT or ZFS. Depending upon your hardware, the installer may automatically select GPT or ZFS for you. You will need to change your layout to UFS and make sure that the "Partition disk with GPT" checkbox is unchecked while in the Disk Selection Screen of the installer. If GRUB version 2 is installed, you can select the installer's default partitioning layout as GRUB version 2 supports all of the disk options available during a PC-BSD® installation.
If you will be dual booting with Windows, EasyBCD is easy to install graphical application for configuring a customized boot menu. This boot manager supports all of the disk options available during a PC-BSD® installation, including ZFS and GPT. EasyBCD has also been localized into 13 languages, making it a good choice for localized boot menus.
GAG provides an easy to configure boot manager for loading any operating system. However, it does not support GPT or ZFS. This means that you will need to change your layout to UFS and make sure that the "Partition disk with GPT" checkbox is unchecked while in the Disk Selection Screen of the installer.
The rest of this section will demonstrate how to configure the GAG, GRUB, and EasyBCD boot loaders.
5.2.3 GAG, The Graphical Boot Manager
GAG is a versatile boot manager, capable of booting many different operating systems. Once you have finished installing all of your operating systems, you can configure GAG to present you with a boot menu containing an entry for each operating system.
After downloading and unzipping GAG, burn the cdrom.iso file to a CD. Insert the CD and reboot the system to configure GAG. You will be presented with the initial GAG screen, shown in Figure 5.2a.
NOTE: your mouse will not work in GAG. Instead, use the key representing the number or letter of the option that you wish to select.
Press 4 in order to “Install GAG”. The next screen will prompt you to choose your keyboard type by pressing the associated number key. The next screen will prompt you to choose your language by pressing the associated number or letter key. Once your selections have been made, you will see a screen similar to Figure 5.2b.
Figure 5.2a: Initial GAG Screen
Figure 5.2b: Press the S Key to Configure GAG
Press S to “Setup GAG” and see the screen shown in Figure 5.2c.
Figure 5.2c: GAG's Main Configuration Menu
Press A to “Add a new Operating System”. GAG will display an entry for each operating system installed on the computer.
NOTE: if you are dual-booting with Linux, GAG will not find the Linux installation unless GRUB or lilo is installed in the / or /boot partition of the Linux system.
Press the letter associated with the operating system name. Your PC-BSD® entry will probably be displayed as “A5h FreeBSD”. When you press the associated letter, a pop-up menu will prompt you to type a description which will be shown in the boot menu. Type in something that is useful to you, such as “PC-BSD® 9.1”. When you press enter, you will be prompted to type in a password or to press return for no password. If you decide to type in a password, you will need to input this password whenever you wish to boot into that operating system.
Once you press enter, you will see the screen shown in Figure 5.2d.
Press the letter representing the icon that you wish to associate with the operating system--it will be displayed next to the description in the boot menu. For example, you could press F to associate the FreeBSD Beastie icon next to the “PC-BSD® 9.1” description. Once you press enter, you will be returned to the main menu. Press A again to add another operating system and repeat this process for each operating system that you wish to boot.
When you are finished, press H to “Save in Hard disk”. You should receive a pop-up message indicating that “GAG installed successfully”. You can now press R to “Return to main menu”. Note that the screen shown in Figure 5.2b now contains the entries for the operating systems that you added. Remove the CD and press the key associated with the operating system that you wish to boot.
Now, whenever you reboot your system, this same menu will appear. It will always contain the S option so that you can add or delete operating system entries, set the boot passwords, or set the boot timer.
Figure 5.2d: Selecting an Icon for the Boot Menu Entry
5.2.4 GRUB
Many Linux distros use GRUB as the boot loader. This section shows you how to add PC-BSD® to an existing GRUB menu.
There are two versions of GRUB that are in use. To see which version your Linux distro is using, boot into the Linux system and use the --version option to the grub command line tool:
sudo grub
grub> grub --version
If the version number is less than 1, you are using legacy GRUB; otherwise you are using GRUB version 2.
If you are using GRUB version 2, run the ls command within grub to determine the names of the disks and partitions that can be seen by GRUB. This will help you determine which drive options to use when setting the root option in the examples shown in Adding PC-BSD® to GRUB Version 2. The output of this command will vary depending upon your disk layout and the naming scheme used by the Linux distro. When you are finished using grub, type quit to leave the utility.
grub> ls
grub> quit
5.2.4.1 Adding PC-BSD® to Legacy GRUB
NOTE: legacy GRUB does not support the GPT format. When you are in the Disk Selection screen of the PC-BSD® installer, select Advanced Mode and make sure that the “Partition disk with GPT” checkbox is unchecked.
Here is an example of adding a PC-BSD® entry to a Linux distro that is using legacy GRUB:
title PCBSD 9.1
root (hd0,1)
kernel /boot/loader
title: this will be the text that is shown in the boot menu and can be anything that makes sense to you.
root: the root of the partition containing PC-BSD®, as determined by the ls command described in the previous section. In this example, PC-BSD® is installed on the first hard disk hd0 and on the second partition ,1. Depending upon your distro and where you installed PC-BSD®, the ouput of ls on your system may differ.
kernel: used to load the primary boot image. For FreeBSD and PC-BSD®, always use /boot/loader.
For more information about legacy GRUB, refer to the GRUB Legacy Manual.
5.2.4.2 Adding PC-BSD® to GRUB Version 2
GRUB version 2 supports both the MBR and GPT formats.
In this example, PC-BSD® is installed on the third primary partition of the first hard drive using the MBR format:
menuentry "PCBSD 9.1" {
insmod ufs2
set root=(hd0,2,a)
kfreebsd /boot/loader
}
Where:
menuentry: the text between the quotes will be displayed in the boot menu and can be anything that makes sense to you.
insmod: some distros require this instruction to load the UFS2 kernel module.
set root: the root of the partition containing PC-BSD®, as determined by the ls command described in the previous section. Always add the a at the end to refer to the BSD boot partition on the specified disk and partition.
kfreebsd: used to load the primary boot image. For FreeBSD and PC-BSD®, always use /boot/loader.
The entry for the same installation (third partition on first drive), but with the GPT box checked, will differ slightly in the set root line.
menuentry "PCBSD 9.1" {
insmod ufs2
set root=(hd0,msdos2,bsd1)
kfreebsd /boot/loader
}
If you installed PC-BSD® onto the second hard drive, you need to invoke the map and chainloader commands in order to boot from the second disk. In this example, PC-BSD® is installed in the first partition of the second drive and the box to partition disk with GPT was not checked.
menuentry "PC-BSD® 9.1" {
map (hd0) (hd1)
map (hd1) (hd0)
map --hook
chainloader (hd0,0)/boot0
boot
}
The entry if the GPT box was checked looks like this:
menuentry "PC-BSD® GPT" {
map (hd0) (hd1)
map (hd1) (hd0)
map --hook
chainloader (hd0,0)/pmbr
boot
}
If you installed ZFS, several modules need to be loaded. Here is a sample entry with the GPT box checked:
menuentry "PC-BSD® 9.1" {
insmod zfs
search -s -l tank0
kfreebsd /freebsd@/boot/kernel/kernel
kfreebsd_module_elf /freebsd@/boot/kernel/opensolaris.ko
kfreebsd_module_elf /freebsd@/boot/kernel/zfs.ko
kfreebsd_module /freebsd@/boot/zfs/zpool.cache type=/boot/zfs/zpool.cache
set kFreeBSD.vfs.root.mountfrom=zfs:tank0/freebsd
}
After a GRUB2 configuration change you need to run a command to update the configuration. This command varies by distro:
sudo update-grub on a Debian-based system
grub2-mkconfig -o /boot/grub2/grub.cfg as the superuser under Fedora 16 or Gentoo
grub-mkconfig -o /boot/grub/grub.cfg when using Sabayon
For more information please refer to the GNU GRUB Manual.
5.2.5 Dual Boot with Windows Using EasyBCD
EasyBCD was developed by the non-profit NeoSmart Technologies to make it easy to add other operating system entries to the the Windows boot loader. EasyBCD allows you to add entries for multiple Windows installations as well as Linux, BSD, and Mac OS X. EasyBCD provides both a paid version and a free version for limited, non-commercial use.
After booting into Windows, download and install the latest version of EasyBCD. Once installed, launch EasyBCD. The initial screen will show the current Windows bootloader. As seen in the example in Figure 5.2e, it will be set to boot Windows only.
Click the “Add New Entry” button to add an entry for your PC-BSD® installation. In the “Linux/BSD” tab, click the “Type” drop-down menu and select FreeBSD/PC-BSD® from the list. Type in something useful in the “Name” field; whatever you type here will show up in the boot menu. Click the “Device” drop-down menu and select the partition holding your PC-BSD® installation. It will have a filesystem type of 0xA5 rather than a drive letter or NTFS. The entry will also show its size so you can find it if you have other non-Windows partitions. An example is seen in Figure 5.2f.
Figure 5.2e: Viewing the Windows Boot Loader Entries Using EasyBCD
Figure 5.2f: Adding an Entry for PC-BSD® to the Windows Boot Loader
Once you have made your selections, click the “Add Entry” button. If you then click on the “View Settings” button, you should see a new entry for your PC-BSD® installation.
Now that you have an entry, you can click the “Edit Boot Menu” button to set the order of the entries in the boot menu, the default operating system to boot, and the boot menu selection timeout before booting into the default operating system. This screen is shown in Figure 5.2g.
Figure 5.2g: Viewing the New Entry in EasyBCD
Once you reboot, a simple boot menu will appear containing entries for Windows and PC-BSD®. A sample menu is shown in Figure 5.2h. Use your arrow key to select the operating system you wish to boot into.
Figure 5.2h: Sample Boot Menu Created by EasyBCD
5.2.6 Recovering Windows Boot loader After Installing PC-BSD®
If you accidentally overwrite your Windows boot loader, you will be unable to boot into Windows after installing PC-BSD®. Depending upon the version of Windows, the PC-BSD® boot loader may or may not automatically provide an entry to boot into Windows. However, assuming you have not accidentally installed PC-BSD® into the Windows partition, your Windows installation is still there and it is possible to restore the Windows boot loader. How to do so varies by the version of Windows:
Once the Windows boot loader is recovered, you can use EasyBCD to add an entry for PC-BSD® to the Windows boot loader.
5.3 Multiple Boot Environments
Beginning with version 9.1, PC-BSD® supports multiple boot environments (BEs) on systems that were formatted with ZFS during installation. In 9.1, this feature is managed from the command line. Version 9.2 will provide a graphical interface for managing boot environments.
With multiple boot environments, the process of updating software becomes a low-risk operation as you can backup your current boot environment before upgrading or making software updates to your system. If needed, you also have the option of booting into a backup boot environment. For example:
if you are making software changes to a boot environment, you can take a snapshot of that environment at any stage during modifications by using the beadm create command. A snapshot is a read-only image of a boot environment at a given point in time. A snapshot is not bootable but you can create a boot environment, based on that snapshot, by using the beadm create -e command followed by the beadm activate command to specify that this boot environment will become the default boot environment on the next reboot.
you can create custom names for each snapshot to identify when or why that snapshot was created. You can use the beadm list -s command to view the available snapshots for a boot environment.
you can save multiple boot environments on your system and perform various updates on each of them as needed. For example, you can clone a boot environment by using the beadm create command. A clone is a bootable copy of a boot environment. You can install, test, and update different software packages on the original boot environment and on its clone.
although only one boot environment can be active at a time, you can mount an inactive boot environment using the beadm mount command. You could then chroot into the mount point in order to update specific packages on the mounted environment.
you can move a boot environment to another machine, physical or virtual, in order to check hardware support.
NOTE: for boot environments to work properly, do not change the default ZFS layout during installation. The default ZFS layout ensures that when you create multiple boot environments, the /usr/pbi/, /usr/local/, /usr/home/, /usr/ports/, /usr/src/ and /var/ directories remain untouched. This way, if you rollback to a previous boot environment, you will not lose data in your home directories, any installed applications, or downloaded src or ports.
5.3.1 Managing Boot Environments
Boot environments are managed with the beadm command which must be run as the superuser. The following example creates a BE named beforeupgrade. The new BE is a clone of the current BE, the ZFS environment that you booted into.
beadm create beforeupgrade
Created successfully
To view all BEs, use the list command
beadm list
BE Active Mountpoint Space Policy Created
default NR / 6.05G static 2012-07-09 05:06
beforeupgrade - - 1K static 2012-07-10 12:25
The possible flags in the “Active” field are as follows:
R: active on reboot
N: active now
-: inactive
In this example, the current BE is called default, it is active now and at next reboot, and is mounted. The newly created beforeupgrade BE exists, but is inactive and unmounted. To activate the new BE:
beadm activate beforeupgrade
Activated successfully
beadm list
BE Active Mountpoint Space Policy Created
default N / 64.5K static 2012-07-09 05:06
beforeupgrade R - 6.05G static 2012-07-10 12:25
The flags now indicate that the system is currently booted into default, but at next boot the system will boot into beforeupgrade. Only one boot environment can be active at a time.
5.4 Upgrading PC-BSD®
PC-BSD® makes it easy to upgrade from an earlier version of 9.x (including beta and RC versions) to the latest version of PC-BSD®. When the upgrade is finished, simply reboot to access the new version of your PC-BSD® operating system. The upgrade can be performed using the graphical Update Manager or from the command line.
Before attempting an upgrade, be aware of the following caveats:
it is not recommended to update between major branches: for example, from a 7.x or 8.x version to a 9.x version of PC-BSD®. Instead, backup your data and do a fresh install of the new version.
it is not possible to upgrade from FreeBSD to PC-BSD®.
the temporary files used by the upgrade process require 2GB of free space in /usr/. If you receive an error message indicating that you do not have enough free space to perform the upgrade, you will need to delete some files or move them elsewhere in order to create enough free space.
before performing any upgrade, always back up your important data to an external backup device, such as a removable USB drive, or to another system using a utility such as Life Preserver. While it is unlikely that something will go wrong, you will be glad that you made that backup just in case.
when you do an upgrade, programs installed via FreeBSD ports or packages will be removed. If you want to preserve these across system updates, you should install these within a ports jail using Warden®. Better yet, request that your favorite port/package is made into a PBI as PBIs are preserved during an upgrade.
an upgrade will preserve the data in the home directories, any installed PBIs, and user accounts. It also preserves common configuration files--you can view the list of files which are excluded from the upgrade in upgrade-excludes. The upgrade process will also merge any customizations you have made into the new versions of the following files: boot/loader.conf, /etc/rc.conf, and /etc/sysctl.conf.
5.4.1 Using Update Manager
To start Update Manager, make sure that your Internet connection is active and go to Control Panel ➜ Update Manager or type pc-su pc-updategui from a terminal. After inputting the administrative password, Update Manager will look for updates and inform you if a newer version of the operating system is available. In the example shown in Figure 5.4a, the current operating system is 9.0 and Update Manager is indicating that the upgrade to 9.1 is available.
Figure 5.4a: Using Update Manager to Upgrade the Operating System
NOTE: if you know that a new release is available and it is not showing in Update Manager, make sure that any updates that do show are applied first. That way, the system will be fully patched and ready for the system upgrade.
To perform the upgrade, check the box for the "System Upgrade" entry and click the "Install selected updates" button. A progress bar will indicate:
the download status of the PCBSD.tbz upgrade file
the download status of the software packages that are installed with the operating system and which have newer available versions
How long these downloads take depends upon the speed of your network connection: for example, it can take an hour or so over a DSL connection. You can continue to use your PC-BSD® system while Update Manager downloads the files it needs to /usr/local/tmp/.
Once the downloads are finished, a pop-up message will indicate that the system is now ready to reboot in order to finish the upgrade. PC-BSD® will not automatically reboot the system, giving you the opportunity to close any applications that you have open before you reboot the system yourself.
NOTE: it is very important that once you reboot, you do not interrupt the upgrade process. This process may take up to 30 minutes, so plan your reboot for a time when you do not need immediate access to your system.
After rebooting, a console message will appear similar to this one:
##############################################################
A system update to PC-BSD is ready to be installed.
This may take 30 minutes or more.
If you wish to postpone the update, type 'skip' and press enter.
You will be prompted again during the next system boot.
The update will begin automatically in 20 seconds.
>
Since this portion of the updating process can make your system unavailable for as long as half an hour, this message allows you to skip completing the update for now if you need to reboot into the system. If you are ready to leave the system alone while it completes the update, do not do anything and the update will begin in 20 seconds. It is important to not reboot the system until this portion of the upgrade completes.
# PC-BSD System Upgrade
# Updating to 9.1
# Please do NOT reboot the system until the update is finished
##############################################################
Cleaning old system pkgs.....
Extracting updated world environment...DONE!
Extracting kernel and boot environment...DONE
Cleaning up old files...DONE
Rebooting for stage 2 of upgrade...Shutdown NOW!
The system will automatically reboot into the new operating system and continue with the application updates.
# PC-BSD System Upgrade
# Updating to 9.1
# Please do NOT reboot the system until the update is finished
##############################################################
Installing system packages...
Cleaning up...DONE
Update finished! Rebooting...
Your system will now reboot into the newly-installed operating system.
5.4.2 Using the Command Line
To start a system upgrade from the command line, become the superuser and use the following command to check to see if an update is available:
pc-updatemanager check
The following updates are available:
------------------------------------
NAME: System Update to 9.1
TYPE: SYSUPDATE
VERSION: 9.1
DATE: 2012-12-03
TAG: release-9.1
DETAILS: http://www.pcbsd.org
To install this update run "/usr/local/bin/pc-updatemanager install release-9.1"
Follow the instructions to install the update:
pc-updatemanager install release-9.1
STARTINGUPDATE: 9.1
Downloading Master Files...
The upgrade will then proceed as usual and you will be prompted when the system is ready to reboot.
5.5 Creating an Automated Installation with pc-sysinstall
PC-BSD® provides a set of Bourne shell scripts that allow advanced users to create automatic or customized PC-BSD® installations. pc-sysinstall is the name of the master script; it reads a customizable configuration file and uses dozens of backend scripts to perform the installation. You can read more about this utility by typing man pc-sysinstall.
Here is a quick overview of the components used by pc-sysinstall:
/usr/share/pc-sysinstall/backend/ contains the scripts used by the PC-BSD® installer. Scripts have been divided by function, such as functions-bsdlabel.sh and functions-installcomponents.sh. If you have ever wondered how the PC-BSD® installer works, read through these scripts. This directory also contains the parseconfig.sh and startautoinstall.sh scripts which pc-sysinstall uses to parse the configuration file and begin the installation.
/usr/share/pc-sysinstall/backend-partmanager/ contains the scripts which are used by the installer to create and delete partitions.
/usr/share/pc-sysinstall/backend-query/ contains the scripts which are used by the installer to detect (e.g. detect-nics.sh) and configure (e.g. enable-net.sh) hardware.
/usr/share/pc-sysinstall/components/ contains FreeBSD ports and src and the PBIs for chromium, firefox, opera, and thunderbird.
/usr/share/pc-sysinstall/conf/ contains the configuration file pc-sysinstall.conf. It also contains a file indicating which localizations are available (avail-langs), a list of files which are not touched during an upgrade (exclude-from-upgrade), and a license/ subdirectory containing text files of applicable licenses (e.g. bsd-en.txt and nvidia-en.txt).
/usr/share/pc-sysinstall/doc/ contains the help text that is seen if you run pc-sysinstall without any arguments.
/usr/share/examples/pc-sysinstall/ contains several example configuration files for different scenarios (e.g. upgrade, fbsd-netinstall). The README file in this directory should be considered as mandatory reading before using pc-sysinstall.
/usr/sbin/pc-sysinstall this is the script that is used to perform a customized installation.
To create a custom installation, perform the following steps:
Determine which variables you wish to customize.
Create a customized configuration.
Create a custom installation media or installation server.
These steps are discussed in more detail below.
5.5.1 Determine Which Variables you Wish to Customize
A list of possible variables can be found in /usr/share/examples/pc-sysinstall/README and in Table 5.5a. Note that the Table is meant as a quick reference to determine which variables are available. The README file contains more complete descriptions for each variable.
5.5.2 Create a Customized Configuration
One way to create this file is to read through the configuration examples in /usr/share/examples/pc-sysinstall/ to find the one that most closely matches your needs. Copy that file (to any location) and customize it so that it includes the variables and values you would like to use in your installation.
An alternate way to create this file is to perform an installation of the version that you wish to customize. The installer will automatically create a file containing the settings you selected during the installation to /root/pc-sysinstall.cfg. You can use that configuration file as-is or customize it to meet an installation's needs. This method may prove easier to use if you are performing complex disk layouts.
Here is a sample configuration:
# Sample configuration file for an installation using pc-sysinstall
installMode=fresh
installInteractive=no
hostname=myhost.mydomain.com
# Set the disk parameters - 1st disk
disk0=da0
partition=all
bootManager=none
commitDiskPart
# Set the disk parameters - 2nd disk
disk1=da1
partition=all
bootManager=none
commitDiskPart
# Setup the disk label - 1st disk
# All sizes are expressed in MB
# Avail FS Types, UFS, UFS+S, UFS+J, ZFS, SWAP
disk0-part=UFS+S 1024 /
disk0-part=SWAP.eli 2048 none
disk0-part=UFS+S 1024 /tmp
disk0-part=UFS+S 1024 /var
disk0-part=UFS+S 0 /usr
# Size 0 means use the rest of the slice size
# Do it now!
commitDiskLabel
# Setup the disk label - 2nd disk
# All sizes are expressed in MB
# Avail FS Types, UFS, UFS+S, UFS+J, ZFS, SWAP
disk1-part=UFS+S 1024 /usr/src
disk1-part=UFS+S 4096 /usr/local
disk1-part=UFS+S 0 /usr/ports
# Size 0 means use the rest of the slice size
# Do it now!
commitDiskLabel
netDev=em1
netIP=172.16.80.250
netMask=255.255.240.0
netNameServer=172.16.80.1
netDefaultRouter=172.16.80.1
netSaveDev=em0 em1
netSaveIP_em0=192.168.101.42
netSaveIP_em1=172.16.80.156
netSaveMask_em0=255.255.252.0
netSaveMask_em1=255.255.240.0
netSaveNameServer=172.16.80.1
netSaveDefaultRouter=192.168.100.1
# Set if we are installing via optical, USB, or FTP
installType=FreeBSD
installMedium=ftp
ftpPath=http://pkgbuilder.mydomain.com/images/freebsd/8.2/
packageType=tar
# List our components to install
#installComponents=ports,src
# Set the root pass
rootPass=root
# Setup our users
userName=demo
userComment=Demo User
userPass=demo
userShell=/bin/sh
userHome=/home/demo
commitUser
# Set up date/time
runCommand=cp /usr/share/zoneinfo/EST5EDT /etc/localtime
runCommand=touch /etc/wall_cmos_clock
runCommand=adjkerntz -a
# Install packages required for VMware Tools installation/configuration
runCommand=pkg_add -r compat6x-amd64
runCommand=pkg_add -r perl
runCommand=pkg_add -r pcre
runCommand=pkg_add -r puppet
runCommand=pkg_add -r sysrc
# Fetch/install VMware Tools
runCommand=fetch -o /tmp/vmtools.tar.gz http://pkgbuilder.mydomain.com/images/freebsd/vmware-freebsd-tools.tar.gz
runCommand=zcat /tmp/vmtools.tar.gz | tar -C /tmp -xvf -
runCommand=/tmp/vmware-tools-distrib/vmware-install.pl -d
runCommand=rm -rf /tmp/vmware-tools-distrib
runCommand=/usr/local/sbin/sysrc puppet_enable=YES
# Generate the certificate to be signed by the master
runCommand=/usr/local/bin/puppet agent -t
If you wish to perform a fully-automated installation that does not prompt for any user input, you will also need to review /usr/share/examples/pc-sysinstall/pc-autoinstall.conf and place a customized copy of that file into /boot/pc-autoinstall.conf on your installation media.
Table 5.5b summarizes the additional variables that are available for fully automatic installations. More detailed descriptions can be found in the /usr/share/examples/pc-sysinstall/pc-autoinstall.conf file. Note that the variables in this file use a different syntax than those in Table 5.5a in that the values follow a colon and a space rather than the equals sign.
Table 5.5b.: Additional Variables for Automated Installations
Variable | Options | Description |
pc_config | URL or /path/to/file | location of customized pc-sysinstall.conf |
confirm_install | yes or no | should be set to yes, otherwise booting the wrong disk will result in a system wipe |
shutdown_cmd | e.g. shutdown -p now | good idea to run a shutdown, but can be any command/script you wish to execute post-install |
nic_config | dhcp-all or <interface name> <IP address> <subnet mask> | will attempt dhcp on all found NICs until the installation file can be fetched or will setup specified interface |
nic_dns | IP address | DNS server to use |
nic_gateway | IP address | default gateway to use |
Here is a sample pc-autoinstall.conf file:
# pc-autoinstall.conf example
#
# Usage: Modify these variables, and copy the file to
# /boot/pc-autoinstall.conf on your PC-BSD installation medium
#
# The conf will then be read at bootup, and your automated
# install will take place
##################################################################
# Where the pc-sysinstall main config is located
# Can be either a file on the booted CD / DVD / USB media,
# or a remote file on http / ftp
#
# The value %%NIC_MAC%% is special, and will be substituted with
# the macaddress of the enabled NIC from DHCP or manually set
# with 'nic_config:'
##################################################################
# Examples:
# pc_config: ftp://192.168.0.2/cust-install.cfg
# pc_config: http://192.168.0.2/cust-install.cfg
# pc_config: http://192.168.0.2/%%NIC_MAC%%.cfg
# pc_config: /boot/cust-install.cfg
pc_config:
http://pkgbuilder.mydomain.com/images/freebsd/pc-sysinstall.cfg
# Set this to yes if we should confirm before doing an install
# This should normally be set to yes, otherwise booting the wrong
# disk will result in a system wipe
confirm_install: no
# Set the command to run post-install, usually best to run shutdown
# but this can be replaced with any other command / script you wish
# to execute post-install
shutdown_cmd: shutdown -r now
# Options for the network setup, should the cfg need to be fetched
# from a remote location, only necessary when using ftp or http
##################################################################
# Special option, will attempt dhcp on all found NICs
# until the file can be fetched, or we run out of interfaces
# nic_config: dhcp-all
# Line to be passed to the "ifconfig" command to bring up an interface
nic_config: em1 172.16.80.250 255.255.240.0
# DNS server to use
nic_dns: 172.16.80.1
# Default router / gateway
nic_gateway: 172.16.80.1
5.5.3 Create a Custom Installation Media or Installation Server
pc-sysinstall supports the following installation methods:
from a CD, DVD, or USB media
from an installation directory on an HTTP, FTP, SSH+rsync, or a PXE Boot Install server
The easiest way to create a custom installation media is to modify an existing installation image. For example, if you have downloaded an ISO for the PC-BSD® version that you wish to customize, the superuser can access the contents of the ISO as follows:
mdconfig -a -t vnode -f PCBSD9.0-x86-DVD.iso -u 1
mount -t cd9660 /dev/md1 /mnt
Make sure you have cd 'd into a directory where you would like to copy the contents of the ISO. In the following examples, /tmp/custominstall/ was created for this purpose:
cd /tmp/custominstall
tar -C /mnt -cf - . | tar -xvf -
umount /mnt
Alternately, if you have inserted an installation CD or DVD, you can mount the media and copy its contents to your desired directory:
mount -t cd9660 /dev/cd0 /mnt
cp -R /mnt/* /tmp/custominstall/
umount /mnt
If you are creating an automated installation, copy your customized pc-autoinstall.conf to /tmp/custominstall/boot/.
Copy your customized configuration file to /tmp/custominstall/. Double-check that the “installMedium=” variable in your customized configuration file is set to the type of media that you will be installing from.
You may also need to add some extra files if you set the following variables in your custom configuration file:
installComponents= make sure that any extra components you wish to install exist in extras/PBI/ (if they end in the .pbi extension) or extras/components/ (if they end in .tbz)
runCommand= make sure the command exists in the specified path
runScript= make sure the script exists in the specified path
runExtCommand= make sure the command exists in the specified path
If the installation media is a CD or DVD, you will need to create a bootable media that contains the files in your directory. To create a bootable ISO:
cd /tmp/custominstall
mkisofs -V mycustominstall -J -R -b boot/cdboot -no-emul-boot -o myinstall.iso
You can then use your favorite burning utility to burn the ISO to the media.
To begin an installation that requires user interaction:
pc-sysinstall -c /path_to_your_config_file
To begin a fully automated installation, insert the installation media and reboot.
If you are using an HTTP, FTP, or SSH server as the installation media, untar or copy the required files to a directory on the server that is accessible to users. Be sure to configure the server so that the installation files are accessible to the systems that you wish to install. If you are using a PXE Boot Install server, follow the instructions at Connecting to and Customizing the PXE Boot Install Server.
6 Desktops
Once you have installed PC-BSD®, you will want to become familiar with your desktop environment. This section discusses the desktops which can be selected during the installation of PC-BSD® or installed afterwards using System Manager.
NOTE: Fluxbox is always installed and available in the login menu of a PC-BSD® system.
These desktops are fully supported, meaning that all of the PC-BSD® utilities are integrated into the desktop environment:
By default, three PC-BSD® icons will appear on these desktops:
AppCafe®: graphical utility used to install, uninstall, and upgrade software. See the section on Using AppCafe® for more details.
PC-BSD® Control Panel: contains applications for administering the computer. See the section on Control Panel for more details.
PC-BSD® Handbook: a PDF version of the PC-BSD® 9.1 Users Handbook (this document).
The following desktops are called “unsupported” in the PC-BSD® installer as they are meant for more advanced users who are comfortable working at the command line. The PC-BSD® utilities will work in these environments, but the user may need to start some utilities manually from the command line if they do not appear as an icon on the desktop or in the desktop's application menu:
Advanced users can also install other desktops using the FreeBSD ports and packages collection. You can browse the 180+ available desktops in the x11-wm category at Freshports.
The rest of this section provides an overview of each of the desktops that can be installed with PC-BSD®.
6.1 GNOME2
GNOME2 is a popular desktop environment that provides many built-in utilities.
NOTE: GNOME3 has not yet been ported to FreeBSD. Once it has, it may be added as a desktop component in the PC-BSD® installer.
Figure 6.1a shows a screenshot of GNOME2 on a PC-BSD® 9.1 system with the “Applications” menu open:
Figure 6.1a: GNOME2 on PC-BSD®
Each category in the “Applications” menu contains many applications and the “Settings” and “System” categories contain many utilities for configuring your system. If you are new to GNOME2, take some time to discover which applications best suit your needs. Some of the applications which are provided by GNOME include:
Eye of GNOME: image viewer found in Graphics ➜ Image Viewer.
Epiphany: web browser found in Internet ➜ Epiphany Web Browser.
Brasero: CD/DVD burning software found in Multimedia ➜ Brasero Disk Burner.
Totem: movie player found in Multimedia ➜ Movie Player.
Evolution: email client with address book and calendar. Found in Office ➜ Evolution Mail and Calendar.
Nautilus: file manager found in Utilities ➜ File Browser.
NOTE: some games, such as Gnibbels, Lights Off, Quadrapassel, and Swell Foop, require 3D acceleration. If your video driver does not support this, you will not be able to launch those games.
You may or may not have installed all of GNOME's components during installation. You can view the installed components and check (to add) or uncheck (to delete) various components using Control Panel ➜ System Manager ➜ System Packages ➜ Desktops ➜ GNOME.
You can find additional themes and wallpapers at gnome-look.org.
6.2 KDE4
The KDE desktop environment provides many features and applications. However, it is hardware intensive and may run slowly on a computer with an older processor or a small amount of RAM. Figure 6.2a shows a screenshot of KDE4 running on PC-BSD® 9.1 with the “Applications” menu open.
Each category in the “Applications” menu contains many applications and the “Settings” and “System” categories contain many utilities for configuring your system. If you are new to KDE4, take some time to discover which applications best suit your needs. Some of the applications which are provided by KDE4 include:
Gwenview: image viewer found in Graphics ➜ Image Viewer.
Digikam: photo management program found in Graphics ➜ Photo Management Program.
Konqueror: file manager, web browser, and SSH client found in Internet ➜ Web Browser.
KMPlayer: media player found in Multimedia ➜ Media Player. Plays most MPEG/VOB, AVI, Ogg/OGM, VIVO, ASF/WMA/WMV, QT/MOV/MP4, RealMedia, Matroska, NUT, NuppelVideo, FLI, YUV4MPEG, FILM, RoQ, PVA files, supported by many native, XAnim, and Win32 DLL codecs. You can watch VideoCD, SVCD, DVD, 3ivx, DivX 3/4/5, WMV and even H.264 movies.
Okular: document viewer and annotator found in Office - Document Viewer. Supports PDF, OpenOffice, and Postscript files.
KOrganizer: organizer utility and reminder daemon found in Office ➜ Personal Organizer.
Dolphin: file manager found in System ➜ File Manager. Dolphin provides many features for manipulating files such as comments, tags, search, encryption, and archival (zip/unzip) functions.
Figure 6.2a: Applications Menu of KDE4
By default, desktop effects are disabled as not all video cards support them. If your video card supports 3D effects and you would like to enable them in KDE, go to System Settings ➜ Desktop Effects ➜ General and check the box “Enable desktop effects at startup”.
Some of KDE's games require 3D support. If your video card does not support 3D, these games will fail to start.
You may or may not have installed all of KDE's components during installation. You can view the installed components and check (to add) or uncheck (to delete) various components using Control Panel ➜ System Manager ➜ System Packages ➜ Desktops ➜ KDE.
If you have KDE installed and are currently logged into a different window manager, you can still run any KDE application by specifying its name. For example, type konqueror to run the Konqueror web browser or dolphin to access the Dolphin File Manager.
KDE Applications includes descriptions and screenshots of all of KDE's applications as well as links to their handbooks.
kde-look.org contains additional themes and wallpapers.
6.3 LXDE
LXDE is the Lightweight X11 Desktop Environment. It is an excellent choice for older hardware or for users who want a complete desktop environment without all of the overhead required by KDE or GNOME. Since it is XDG-compliant, the PC-BSD® Control Panel, AppCafe®, and Life Preserver are available on the desktop and integrated into LXDE's menus.
Figure 6.3a shows a screenshot of the default LXDE installation with the LXPanel open.
Figure 6.3a: LXDE Desktop on a PC-BSD® System
In addition to the PC-BSD® utilities, LXDE provides the following utilities:
LXPanel: desktop panel which is launched by clicking on the PC-BSD® icon in the lower right corner of the desktop. To configure the panel, right-click the PC-BSD® icon and select “Panel Settings” or “Add/Remove Panel Items” from the right-click menu.
PCManFM: found in Accessories ➜ File Manager. A file manager with features like drag and drop, tabbed browsing, built-in file search, file association with default application, thumbnails for images, bookmarks, and support for non-UTF-8 encoded filenames.
GPicView: fast image viewer found in Accessories ➜ Image Viewer.
Leafpad: a light-weight graphical text editor found in Accessories ➜ Leafpad.
LXTerminal: terminal emulator found in Accessories ➜ LXTerminal
Xarchiver: archiver utility that supports the 7z, ARJ, bzip2, gzip, lzma, RAR, RPM, DEB, tar, and ZIP file formats. Found in Accessories ➜ Xarchiver.
Midori: a lightweight web browser found in Internet ➜ Midori.
epdfview: a PDF viewer found in Office ➜ ePDFViewer.
LXTask: task manager and system monitor found in System Tools ➜ Task Manager.
LXAppearance: a theme switcher for customizing the widgets, colors, icons, mouse cursors, and sound effects used by applications. Found in Preferences ➜ Customize Look and Feel.
LXInput: a tool to configure your keyboard and mouse found in Preferences ➜ Keyboard and Mouse.
Openbox: the window manager used by LXDE. You can configure settings such as themes, appearance, mouse, and margins by going to Preferences ➜ Openbox Configuration Manager.
6.4 XFCE4
Xfce is a lightweight desktop environment that aims to be low on system resources and fast, while still being visually appealing and user friendly.
The first time you start XFCE4, you will see the message shown in Figure 6.4a:
Figure 6.4a: Panel Welcome Message
In XFCE, a panel is a bar which can hold many items such as application launchers, window lists, a clock, a notification area, and application menus. Your initial panel setup options are:
Migrate old config: select this option if you wish to have a single panel with an application launcher and other icons as shown in Figure 6.4b. The application launcher menu may be reached from the upper left, or by right-clicking the desktop.
Use default config: this option will install a large panel across the top and a small, minimal panel centered on the bottom. The application launcher menu may be accessed by the fireball icon in the lower left, or by a right-click on the desktop.
One empty panel: this option will install a panel with no icons. The application menu is available by right-clicking the desktop as shown in Figures 6.4b and 6.4c.
Figure 6.4b shows a screenshot of XFCE4 running on a PC-BSD® 9.1 with the application menu open.
Figure 6.4b: XFCE with Complete Panel Migrated From Old Config
Figure 6.4c: XFCE with Minimal Panel Using Default Config
If you wish to change your configuration choice at a later time, reset the panel using Applications ➜ Settings ➜ Settings Editor, as shown in Figure 6.4d, then exit to the login prompt without saving session info. The next login to XFCE will present the panel configuration choice again.
Figure 6.4d: Using Settings Editor to Reset Panel
In addition to the PC-BSD® utilities, XFCE provides the following utilities:
Xdesktop: desktop manager found in Settings ➜ Desktop. Sets the background image, provides a right-click menu to launch applications, and can show files (including application launchers) or iconified windows.
Xfwm4: window manager found in Settings ➜ Window Manager. It provides window decorations, virtual desktops, multiscreen mode, transparency and a keyboard shorcuts editor.
Ristretto: fast and light-weight picture viewer found in Graphics ➜ Ristretto Photo Viewer.
Midori: light-weight graphical browser found in Internet ➜ Midori.
Xfburn: CD/DVD burning tool found in Multimedia ➜ Xfburn.
Orage: calendar and reminder daemon found in Office ➜ Orage Calendar.
Thunar: file manager found in System ➜ Thunar File Manager.
Task Manager: graphical task manager found in System ➜ Task Manager.
A list of recommended applications for XFCE can be found on the XFCE Wiki.
6.4.1 Editing the Menu
XFCE no longer includes a graphical menu editor. The XFCE team recommends using alacarte which is included when you install XFCE4 on PC-BSD® and which can be started by typing alacarte within an xterm.
Figure 6.4e shows a screenshot of alacarte running on PC-BSD®.
Figure 6.4e: Using alacarte to Customize Applications Menu
Any entry with a checkbox will appear in your menu. To remove an item from the menu, simply uncheck its box. To create a new menu category, either highlight a top-level menu (e.g. KDE Menu or System) or an existing category and click the “New Menu” button. To add a new entry, highlight the category where you wish the entry to appear and click the “New Item” button. Input a name for the entry, browse to the path of the application and press “OK”.
6.4.2 XFCE Plugins
XFCE supports many plugins which provide additional applications that are separate from the official XFCE distribution. You can browse for plugins and read descriptions for each at the XFCE goodies website. If you find a plugin that is not available within AppCafe®, this README explains how to determine if a FreeBSD port is available, how to request a PBI if a port is available, and how to request a port if one does not already exist.
After installing a plugin, go to Settings ➜ Panel ➜ Items and click the + button to see the “Add New Items” screen shown in Figure 6.4f.
Figure 6.4f: Adding a Plugin to the Panel
Simply select your new plugin from the list, and click the “+Add” button. It will immediately be added as an icon in the panel.
6.5 Awesome
Awesome is a highly configurable and fast window manager that is primarily targeted at power users who prefer to use the command line within their graphical environment.
Figure 6.5a shows a screenshot of Awesome running on PC-BSD® 9.1. The user has right-clicked the desktop in order to launch the awesome application manager.
Figure 6.5a: Awesome Window Manager on PC-BSD®
If you click awesome ➜ manual, the man page for awesome will open in a terminal. If you click awesome ➜ edit config, the awesome configuration file will open in the ee text editor. The numbers in the upper left corner represent virtual desktops. For example, you can have different terminals open in each virtual desktop.
Bluetooth Manager (if the system has a Bluetooth interface), Update Manager, Wireless Configuration Manager (if your wireless card is detected), and Life Preserver are located in the system tray near the clock in the upper right corner. If you wish to access Control Panel type pc-controlpanel in a terminal. To launch AppCafe®, type appcafe in a terminal or use the pbi_* commands to manage software from the command line.
6.6 Enlightenment
Enlightenment is a lean, fast, modular, and extensible window manager. It provides a desktop for launching applications, managing windows, and doing other system tasks like suspending, reboots, and managing files.
The first time you run Enlightenment, you will be prompted to select your Language, then either a touchscreen or a standard computer profile. You will then be prompted to select the size of title bars, the type of window focus, and whether or not to use compositing. If in doubt, you can select the defaults by pressing "Next" at each initial configuration screen.
Figure 6.6a shows a screenshot of Enlightenment running a standard computer profile on PC-BSD® 9.1. The icon on the far left of the iBar has been clicked in order to access the applications menu.
Enlightenment is very customizable. The e17 User Guide describes how to configure windows, shelves, menus, wallpaper, and much more.
Figure 6.6a: Enlightenment Running on PC-BSD®
6.7 evilwm
evilwm is an extremely light window manager. It does not support window decorations or icons and uses keyboard shortcuts to access xterms in order to run applications from the command line.
Figure 6.7a shows a screenshot of evilwm running on PC-BSD® 9.1.
Notice that there are no icons, nor is there a system tray, an application panel, or window buttons. An xterm has been opened using Ctrl+Alt+Enter and shows the output of the ps command.
The keyboard shortcuts for manipulating windows are listed here.
To exit evilwm and return to the login screen, type killall evilwm within an xterm.
6.8 Fluxbox
Fluxbox is a light-weight and fast window manager. Regardless of the window managers that you have selected to install, Fluxbox is always available as an option in the login menu.
Figure 6.8a shows a screenshot of Fluxbox running on PC-BSD®. In this example, the user has launched the Application menu by right-clicking on the desktop.
Fluxbox provides many configuration files which can be edited in order to customize the desktop. The Features page of the Fluxbox website lists the available configuration files and links to instructions for getting the most out of Fluxbox.
Figure 6.8a: Fluxbox on PC-BSD®
To ease some aspects of configuration, the Fluxconf PBI, available in AppCafe®, adds the following graphical tools:
fluxbare: seen in Figure 6.8b, provides a tiny toolbar allowing you to launch the next three utilities. Type fluxbare within an xterm to open the toolbar.
fluxconf: seen in Figure 6.8c, is used for managing window placement.
fluxkeys: seen in Figure 6.8d, is used to define and manage keyboard shortcuts.
fluxmenu: seen in Figure 6.8e, is used to add or remove entries from the Fluxbox menu.
Figure 6.8b: Fluxbare Toolbar
Figure 6.8c: Configuring Window Placement with fluxconf
Figure 6.8d: Managing Keyboard Shortcuts with fluxkeys
Figure 6.8e: Editing the Menu Using fluxmenu
The following resources are useful when customizing Fluxbox:
6.9 FVWM
FVWM is a powerful and highly configurable desktop window manager for the X Window system. It supports any number of virtual desktops, each divided into multiple pages. It also supports side title bars, including vertical text.
When you install FVWM on PC-BSD®, it also installs FVWM-Crystal. Both window managers will be added to the login menu.
Figure 6.9a shows the default PC-BSD® desktop if you select FVWM from the login menu. The application menu was opened by clicking the mouse anywhere on the desktop.
Figure 6.9a: FVWM Running on PC-BSD®
Figure 6.9b shows the default PC-BSD® desktop if you select FVWM-Crystal from the login menu. To open an xterm in FVWM-Crystal, right-click any area of the desktop.
This article provides a good overview of the features and configurable options for FVWM-Crystal.
The FVWM Documentation provides further information about configuring FVWM.
Figure 6.9b: FVWM-Crystal Running on PC-BSD®
6.10 i3
i3 is a lightweight, tiling window manager. Keyboard shortcuts are provided to open xterms in order to start applications from the command line.
i3 provides a panel and on PC-BSD® that panel will contain icons for Bluetooth Manager (if the system has a Bluetooth interface), Update Manager, Wireless Configuration Manager (if your wireless card is detected), and Life Preserver.
Figure 6.10a shows a screenshot of i3 running on PC-BSD® 9.1.
To open an xterm, use Alt+Enter. Windows do not provide minimize/mazimize or close buttons, so type exit when you are finished using an xterm. To leave the window manager and return to the login screen, type killall i3 from within an xterm.
The i3 Users Guide contains the default key bindings and instructions for customizing i3.
Figure 6.10a: i3 Window Manager on PC-BSD®
6.11 IceWM
IceWM is a light-weight window manager.
Figure 6.11a shows a screenshot of IceWM running on PC-BSD®. In this example, the user has launched the Application menu by clicking on the IceWM button in the lower left corner. This menu can also be launched by right-clicking anywhere on the desktop.
If you are new to IceWM, see the IceWM FAQ and Howto for more information about configuration, customization, and keyboard shortcuts.
Figure 6.11a: IceWM on PC-BSD®
6.12 Openbox
Openbox is a highly configurable, minimalist window manager. It is the window manager used by LXDE but can also be run separately from LXDE.
Figure 6.12a provides a screenshot of Openbox running on a PC-BSD® system. The application menu was launched by right-clicking on an area of the desktop.
The application menu contains an entry for the Openbox Configuration Manager which can be used to customize settings such as themes, appearance, mouse, and margins. A screenshot of this configuration utility is shown in Figure 6.12b.
A list of websites containing additional themes is available from the Openbox wiki.
Figure 6.12a: Openbox on a PC-BSD® System
Figure 6.12b: Openbox Configuration Manager
6.13 Ratpoison
Ratpoison is a simple window manager with no fat library dependencies, no fancy graphics, or window decorations.
Figure 6.13a provides a screenshot of Ratpoison running on a PC-BSD® system:
Figure 6.13a: Ratpoison on a PC-BSD® System
Ratpoision uses keyboard shortcuts. To view the shortcuts, press Ctrl-t then ?. To leave this help screen, press enter.
To open an xterm, press Ctrl-t then c. Type exit to close the xterm. Type killall ratpoison with an xterm to leave Ratpoison and return to the login screen.
The Ratpoison wiki contains an FAQ and tips for setting keyboard shortcuts.
6.14 spectrwm
spectrwm, formerly known as Scrotwm, is a minimalist window manager written by OpenBSD hackers. It provides keyboard shortcuts, a configuration file, and assumes that the user prefers to use the command line. If you have not used spectrwm before, spend some time reading through its man page first.
Figure 6.14a provides a screenshot of spectrwm running on a PC-BSD® system.To launch applications within spectrwm, start an xterm by pressing Alt+Shift+Return. Once you have an xterm, you can start any program you wish. For example, to start Control Panel type pc-controlpanel. spectrwm does not provide minimize, maximize, or close buttons within its windows. To close a GUI application, use CTRL-c within the xterm you used to launch the application. To leave this desktop, type killall spectrwm from an xterm.
Figure 6.14a: spectrwm on a PC-BSD® System
6.15 WindowLab
WindowLab is a small and simple window manager. It uses a window resizing mechanism that allows one or many edges of a window to be changed in one action, and an innovative menubar that shares the same part of the screen as the taskbar. It follows a click-to-focus but not raise-on-focus policy. This means that when a window is clicked it gets focus, but it is not redrawn to obscure other windows. This allows one, for example, to switch to a terminal to enter commands while keeping documentation visible in a web browser.
Figure 6.15a shows a screenshot of WindowLab running on PC-BSD® 9.1. The right mouse button is pressed in order to display the top menu panel. Use the left mouse button or hover over a taskbar entry to open that application.
To add the applications you use most often to the menubar, select “Edit menu” while holding the right mouse button.
To leave the WindowLab session, select “Quit” from the menubar.
Figure 6.15a: WindowLab Running on PC-BSD®
6.16 Window Maker
Window Maker is a light-weight window manager that was designed to reproduce the elegant look and feel of the NEXTSTEP user interface.
Figure 6.16a shows a screenshot of Window Maker running on PC-BSD®. In this example, the user launched the Application menu by right-clicking an area of the desktop.
In addition to the PC-BSD® utilities, Window Maker provides the following applications:
WPrefs: located in Appearance ➜ Preferences Utility. Allows you to configure window focus, window placement, menu alignment, icons, keyboard actions, mouse, fonts, and various other window manager settings.
wmakerconf: found in Utils ➜ wmakerconf. Allows you to fine-tune your menu entries as well as your desktop's appearance, themes, background, mouse, and special effects. Figure 6.15b shows wmakerconf with the “Menu” button selected.
Figure 6.16a: Window Maker on PC-BSD®
Figure 6.16b: Editing the Application Menu Using wmakerconf
6.16.1 Working with the Dock
Window Maker uses a dock to store application shortcuts. The dock appears as a series of icons in the upper right corner of the desktop. Docked applications always show on the desktop, even after you close an application or close and restart your Window Maker session.
Whenever you start an application, an icon will appear in the lower left corner of the screen. You can move that icon elsewhere on the desktop with your mouse. If you right-click the icon, you have the option to hide/unhide the icon, set icon (change its picture), or kill the application. If you drag the icon onto the dock, it will remain on the desktop.
Once an icon is docked, a settings menu is added to the icon's right-click menu. Figure 6.16c demonstrates how to configure an icon for AppCafe®.
You will find the icons for AppCafe® and Control Panel in /usr/local/share/pcbsd/pc-controlpanel/icons. Choose the 64x64 versions as this is the size that Window Maker users. The application name for AppCafe® is appcafe and for Control Panel it is pc-controlpanel..
Figure 6.16c: Configuring an Icon
6.16.2 DockApps
Window Maker supports dockapps which are applications that were designed to work with Window Maker but which are separate from the Window Maker project. Dockapps tend to be small and designed to perform a particular function. For example, there are clocks, weather applications, and CPU monitors. Most dockapps have been ported to FreeBSD and the port always begins with “wm”. You can search for these at FreshPorts by entering a “Short Description” containing “dockapp”.
If your favourite dockapp has not been ported to FreeBSD, you can request that a port be created on the Ports Requests forum using these instructions. If a port already exists and you would like to see it made into a PBI, you can request that a PBI be created on the PBI Requests forum using these instructions.
7 Installing Applications and Keeping PC-BSD® Updated
In PC-BSD®, software is divided into PBIs, meta-packages, and package sets:
PBIs are single applications, such as web browsers or multimedia utilities. PBIs are installed and managed using AppCafe®. Update Manager will automatically notify you when newer versions of installed PBIs become available.
Meta-packages are installable software collections that can be considered the same as system components. Meta-packages are selected during installation and include supported and unsupported desktops, development utilities, hardware drivers, and miscellaneous applications such as MythTV or XBMC. After installation, your initial meta-package choices can be modified using System Manager. Warden® also supports meta-packages, allowing you to install system components into a jail.
Package sets include the default packages that get installed with any PC-BSD® system, plus the meta-packages which are selected for installation by the user. The list of packages which are installed with the 9.1 PC-BSD® operating system are listed in the base-system ports-list. You can also view the package list for each meta-package here. Update Manager will automatically notify you when a new package set is ready--typically this occurs every week or two, making it easy to keep the software that came with the operating system up-to-date.
NOTE: users are highly discouraged from using FreeBSD packages or ports or upgrade tools such as portupgrade or portversion from the PC-BSD® command line as Update Manager will remove your manually installed applications and upgrades. If you wish to practice using these tools, instead use Warden® to create a ports jail. If you think an application belongs in the base system (e.g. an add-on to a desktop meta-package), suggest that it be added using one of the resources in the Finding Help section.
This section demonstrates the following PC-BSD® tools for managing software on your PC-BSD® system:
AppCafe® to install PBI software using a graphical application.
PBI Manager to manage PBI software using command line utilities.
Update Manager to install newer versions of PBIs or package sets and to apply security patches using a graphical application.
Meta Package Manager to manage meta-packages from the command line.
It also describes how to create your own package repository of custom PBIs.
7.1 Using AppCafe®
PC-BSD® provides a unique file format known as a PBI (push button installer). PBI files end with the .pbi extension and are self-contained installation programs. When a PBI is installed using AppCafe®, even novice users are protected from the risk of inadvertently overwriting or deleting files needed by the operating system or other applications.
A PBI file includes all the runtime and library dependencies required by the application. This means that the initial download of a PBI is a large file, but this does not necessarily mean that the installed PBI will be that large. During installation, the PBI system compares the currently installed libraries and files with the ones contained within the PBI file and only installs the ones that are not already installed on the system. A hash database is used to eliminate dependency problems while allowing the computer to share libraries between different programs. Subsequent downloads to upgrade a PBI are significantly smaller as only what has changed in the new version will be downloaded.
AppCafe® provides an intuitive, graphical method for installing and managing PBI software. AppCafe® does not require the root password to install most of the applications that users require, such as web browsers, games, mail clients, and productivity software. This means that you do not have to give out the root password on multi-user systems. However, server applications, such as web servers or databases, will prompt for the root password. This is to prevent a regular user from installing server software.
When a regular user installs an application, they have the option to “Install Menu Icons (All Users)”, meaning that an application only needs to be installed once on a multi-user system.
If you prefer to use the command line to install PBIs, see the section on using pbi_add.
NOTE: at this time, AppCafe® does not keep a copy of the downloaded .pbi file. If you would like to retain a copy of this file on disk, use pbi_add -R to download a copy of the PBI to the current directory.
PBIs are the recommended software installation method on PC-BSD®. Update Manager will automatically notify you when newer versions of software installed through the PBI system are available. PBIs will also be preserved over system upgrades and system meta-package changes.
7.1.1 Installing and Uninstalling PBI Software
To install a PBI, start AppCafe® by double-clicking its icon on the Desktop, going to Control Panel ➜ AppCafe®, or by typing appcafe from a command prompt. The “Browse” tab in AppCafe® can be used to browse for available software, as seen in Figure 7.1a:
Figure 7.1a: Browsing for Software Using AppCafe®
In the example shown in Figure 7.1a, 1021 PBIs are available and 3 are currently installed on this system.
If you know the name of the application you would like to install, type its name into the “Search” bar. Alternately, you can click on a software category (for example, “Archivers”) to browse for available software. Use the back arrow or home icon to navigate within the browser. In the example shown in Figure 7.1b, the user searched for the “gimp” application then clicked on the “Gimp” search result.
Figure 7.1b: Browsing the Information Available for a PBI
Figure 7.1b shows an example of the information that is available for each PBI:
Name and icon of the application; in this example, it is Gimp.
A hyperlink to the application's website; in this example, clicking on “The GIMP Team” will open gimp.org in the user's default web browser.
Either a Download icon (if the application is not currently installed) or an Installed icon if it is already installed.
The version of the application.
The platform (i386 for 32-bit applications and amd64 for 64-bit applications). If you are on a 64-bit system and there is only a 32-bit application, AppCafe® will install the 32-bit application and PC-BSD® will still be able to run the program.
The type will indicate whether the application is graphical or text (command line).
Whether or not the installation requires the root (administrative) password.
The license used by the software.
The size of the initial download of the PBI.
A description of the application.
Once you find a PBI that you would like to install, click on its Download icon. AppCafe® will automatically detect your PC-BSD® version and architecture and install the correct PBI for you. When the installation is complete, the new PBI will be displayed in the “Installed” tab. Figure 7.1c shows a screenshot of this tab from a system with several PBIs installed.
Figure 7.1c: Viewing the List of Installed PBIs in AppCafe®
If you right-click an installed PBI you can:
View details: Figure 7.1d shows an example of a PBI's details. In addition to the information usually available for a PBI in the “Browse” tab, the details will indicate that the PBI is installed and a checkbox is added for “Automatic Updating”. Check this box if you would like Update Manager to automatically update this PBI, rather than just notify you that a newer version is available.
Install PATH links: select this option if you will be starting the application from the command line as it will add the command's location to your $PATH.
Install PATH links (All Users): adds the command's location to the $PATH of all users so that they can start the application from the command line. Requires the administrative password.
Uninstall: will uninstall the PBI. Once the PBI removal is complete, it will be removed from the Installed list.
If you highlight a PBI and click the “More” button, the following actions will be added to that list of options:
Install Desktop Icons: will create a shortcut to the application on the user's desktop.
Install Menu Icons: will add an entry for the application to the supported desktop's application menu.
Install Menu Icons (All Users): will add an entry for the application to the application menu of every user. Requires the adminstrative password.
Figure 7.1d: Viewing an Installed PBI's Details
7.1.2 Updating Installed PBIs
The “Installed” tab will also indicate if there are any newer versions available for the PBIs that you have installed. PBIs are created from the original FreeBSD package and automatically become available as an upgrade whenever the underlying package version changes. Figure 7.1e provides an example of a PBI that has a newer version available.
In this example, the currently installed version of Firefox is 16.0.1_1 and version 16.0.2 is available. To upgrade this PBI, highlight its entry and click the “Update” button. Alternately, if updates are available for multiple PBIs and you wish to upgrade them all, click the “Update All” button. If the PBI “Requires Root”, it will prompt you for the administrative password before starting the upgrade.
A status bar will indicate the progress of the download and upgrade process. When the upgrade is complete, the entry will be updated to show the new version. The upgrade process will save all of the current version's settings. For example, when you upgrade Firefox, it will keep all of your bookmarks, history, and cache.
Figure 7.1e: Using the Installed Tab to Upgrade Installed PBIs
7.1.3 Preferences
If you click File ➜ Preferences, you will see the screen shown in Figure 7.1f.
By default, an icon is added to the desktop (for window managers that support icons) whenever you install a PBI. Uncheck the box “Create desktop icons at install” to disable desktop icon creation. You can still elect to install a desktop icon on a per-PBI basis by right-clicking the PBI and selecting “Install Desktop Icons” as shown in Figure 7.1c.
Figure 7.1f: AppCafe® Preferences
7.1.4 Repositories
If you click Repositories ➜ Configure Repository from within AppCafe®, you will see the screen shown in Figure 7.1g:
Figure 7.1g: Managing Available Repositories
This screen will list the official PC-BSD® repositories. AppCafe® reads this list, in order, when connecting to the software repository. You can use the up and down arrows to reorder the list. If you have created your own software repository of PBIs, use the “Add” button to add the URL of the repository.
If you have created your own .rpo file using the pbi_makerepo command, you can use Repositories ➜ Add Repository to browse to the location of the .rpo file. This is the equivalent of manually running the pbi_addrepo command.
7.2 PBI Manager
PBI Manager is a suite of command line utilities which can be used to install, remove, create and manage PBIs. These utilities also allow administrators and PBI builders to create and manage their own repositories of PBIs.
NOTE: PBI files created for PC-BSD® 7.x or 8.x will not work with PBI Manager as it was designed for 9.x PBIs.
The following commands are installed by PBI Manager. For more details, refer to that command's man page. Note that single character commands can not be stacked. As an example, you must type pbi_add -i -v as pbi_add -iv will fail.
7.2.1 pbi_add(1)
Similar to FreeBSD's pkg_add, the pbi_add command is used for adding/installing PBIs on a system, either from a local file or remotely from a repository. This utility supports the options listed in Table 7.2a. All of the options, except for -r, assume that the .pbi file has already been downloaded and is in the current or specified directory.
Table 7.2a: pbi_add Options
Switch | Description |
-e | extract only, do not install; will extract the archive to ~/<pbidirname> unless the -o option is used |
-f | force installation, overwriting an already installed copy of the application |
-g | show path to icons and images for GUI installations |
-i | display information about specified PBI; if combined with -v, will display all of the files that will be installed with the PBI |
-l | display license for specified PBI |
-o outdir | specify the directory to use when extracting the PBI with -e |
-r | remote fetch installation file from update server; the system architecture and version will be automatically determined in order to fetch the correct file and resume support is built-in |
-R | remote fetch the install file from the update server but do not install |
-v | enable verbose output |
--checkscript | display any custom scripts used in the installation/removal of the PBI |
--licagree | agree to license terms and conditions; to view the license, use -l |
--no-checksig | skip the openssl signature verification of the PBI data |
--no-checksum | skip the checksum verification of the archive data |
--no-hash | disable using the shared hash dir |
--repo repoid | specify which repository to use |
--rArch arch | manually specify the PBI architecture type of i386 or amd64 |
--rVer version | specify which version of the PBI to install |
For security reasons, it is recommend that users first use the -i -v and --checkscript options to view archive contents and installation scripts prior to installing a PBI file.
To install a PBI from a remote repository, use: pbi_add -r name_of.pbi. The following example will install the alpine PBI on a 32-bit system:
pbi_add -r alpine
Downloading ftp://ftp.pcbsd.org/pub/mirror/PBI/mail/alpine/9/x32/alpine-2.00_3-i386.pbi
/usr/pbi/.alpine-2.00_3-i386.pbi 100% of 11 MB 295 kBps 00m00s
Verifying Checksum...OK
Extracting to: /usr/pbi/alpine-i386
Installed: Alpine-2.00_3
PBI Manager will automatically detect the architecture and install the appropriate PBI. If only a 32-bit version is available and you are on a 64-bit system, the 32-bit PBI will be installed and will work correctly on the PC-BSD® system.
If you previously downloaded the PBI, do not include the -r switch and give the fullname of the PBI:
pbi_add alpine-2.00_3-i386.pbi
The pbi_addrepo command is used to register a new PBI repository on a system. If the pbid daemon is running, the repository's index and meta files will be automatically fetched and made ready for browsing. The command has one argument: the name of the repository file. Repository files have a .rpo extension and are created with the pbi_makerepo command.
7.2.3 pbi_autobuild(8)
The pbi_autobuild command is used on the PBI build system to build any out-of-date or new packages. It can traverse the FreeBSD ports and metadata trees, building missing PBI files or PBIs in which the target port version has been updated. Instructions for using this command to keep a custom repository up-to-date can be found in the section Configure the Automatic Build of Updated Ports.
Table 7.2b summarizes this command's options:
Table 7.2b: pbi_autobuild Options
Switch | Description |
-c confdir | mandatory; specify the directory containing the PBI configuration modules; any found pbi.conf files will be parsed, and if PBI_MAKEPORT is set, the target port will be used for the build; if PBI_MAKEPORT is unset, the auto-build will attempt to match the module to a FreeBSD port based upon the dirname of pbi.conf |
-d portsdir | specify an alternative ports directory; defaults to /usr/ports/ |
-h script | specify a helper script to call after building a PBI |
-o outdir | mandatory; the directory to place the finished PBI files |
-p num | if your build hardware has the CPU and disk I/O to support concurrent build processes, specify the number of concurrent builds |
-32 | include when building a 32-bit PBI on a 64-bit system |
--genpatch | when building a new PBI, check for archived copies and generate smaller patch updates to the new version (*.pbp files) |
--keep num | when building new PBIs, keep <num> copies of past versions of working PBI in <outdir>/archived/ folder; these archived copies can be used with the --genpatch command to generate update patch files |
--pkgcache | enable caching of .txz pkg files which greatly speeds up subsequent builds of a PBI |
--prune | remove any PBIs which no longer have an associated module |
--tmpfs | automatically create and mount a tmp filesystem which can speed up port compiles on systems with available RAM |
--sign keyfile | digitally sign the PBI file with the specified openssl private key file |
7.2.4 pbi_browser(1)
The pbi_browser command provides a CLI front-end to browsing a repository's available PBIs. Options for viewing categories and searching by keyword are available, and once the desired PBI is located, it will show the pbi_add command which can be used to install the application. Table 7.2c summarizes the available options.
Table 7.2c: pbi_browser Options
Switch | Description |
-c category | displays a list of PBIs in the specified category |
-s search | search for PBIs containing the specified string in the name, description, or keywords |
--listcats | list the available categories |
--viewall | list all available PBIs |
7.2.5 pbi.conf(5)
pbi.conf is an ASCII text configuration file containing values that are used by the various pbi_* commands. The proxy variables are only needed if the system uses a proxy server to access the Internet. Table 7.2d lists the supported variables.
Table 7.2d: pbi_conf Variables
Switch | Description |
PBI_INDEXREFRESH | number of hours representing how often pbid refreshes the index and meta files from repos; default is every 24 hours |
PBI_PROXYPASS | password used to authenticate with proxy server |
PBI_PROXYPORT | proxy server port number |
PBI_PROXYTYPE | can be HTTP or SOCKS5 |
PBI_PROXYURL | proxy server IP address |
PBI_PROXYUSER | username used to authenticate with proxy server |
PBID_REFRESH | wakeup time in seconds for pbid to run its checks |
7.2.6 pbi_create(1)
pbi.conf is an ASCII text configuration file containing values that are used by the various pbi_* commands. The proxy variables are only needed if the system uses a proxy server to access the Internet. Table 7.2d lists the supported variables.
Table 7.2d: pbi_conf Variables
Switch | Description |
PBID_REFRESH | wakeup time in seconds for pbid to run its checks |
PBI_INDEXREFRESH | number of hours representing how often pbid refreshes the index and meta files from repos; default is every 24 hours |
PBI_PROXYURL | proxy server IP address |
PBI_PROXYPORT | proxy server port number |
PBI_PROXYTYPE | can be HTTP or SOCKS5 |
PBI_PROXYUSER | username used to authenticate with proxy server |
PBI_PROXYPASS | password used to authenticate with proxy server |
7.2.7 pbi_create(1)
The pbi_create command provides a way for packagers to manually specify a target directory to be compressed into a PBI file. The option -b can also be used to re-package an already installed PBI back to an archive. PBI creators are encouraged to send a tarball of the resulting PBI module to the PBI-dev mailing list so they can be added to the PC-BSD® PBI repository and made available to other PC-BSD® users.
Table 7.2e summarizes the available options:
Table 7.2e: pbi_create Options
Switch | Description |
-a author | specify the author for this PBI |
-b | make a backup of an installed PBI; specify the target PBI name instead of the PBI directory |
-c confdir | specify the metadata configuration directory; while not required it is highly recommended as metadata is required to create icons and binary entry-points |
-d portsdir | specify an alternative ports directory; defaults to /usr/ports/ |
-i icon | specify a default icon, relative to pbidir/ |
-n name | specify a name for this PBI |
-o outdir | place the finished .pbi file into the specified directory; defaults to $HOME |
-p port | use the given port to get PBI name and version |
-r version | specify a version for this PBI |
-u weburl | specify a website URL for the PBI |
--no-hash | disable using the shared hash directory which uses hard links to share files between applications |
--sign keyfile | digitally sign the PBI file with the specified openssl private key file |
As the superuser, you can create a PBI with the pbi_create command using the following syntax:
pbi_create -a <author> -n <name> -r <version> -w <weburl> <target directory>
Inside the target directory place the application's binaries or scripts along with any required dependencies. To indicate which file(s) represent the runtime command(s), include a file named external-links in the target directory. That file contains an entry for each command, as seen in the following example:
# Files to be symlinked into the default LOCALBASE
# One per-line, relative to %%PBI_APPDIR%% and LOCALBASE
# Defaults to keeping any existing files in LOCALBASE
# Use bin-files/ for binaries that need wrapper functionality
# TARGET LINK IN LOCALBASE ACTION
bin/myapp bin/myapp binary,nocrash
This entry instructs pbi_create to make the wrapper scripts for the myapp binary, along with placing it in the user's PATH at install time.
It is also possible to include desktop icons and mime entries using the xdg-mime/, xdg-desktop/ and xdg-menu/ directories. The section on how to Create PBIs contains more details about creating these files. These directories should be created as subdirectories of the target directory of your application.
7.2.8 pbi_delete(1)
Similar to FreeBSD's pkg_delete, the pbi_delete command removes an installed PBI from the system. It also schedules cleaning for the shared library directory, which is performed by pbid. Table 7.2f summarizes its options:
Table 7.2f: pbi_delete Options
Switch | Description |
-v | enable verbose output |
--clean-hdir | perform a full cleaning of the shared hash directory, removing any unused files; should only be required after a system crash or failure in removing a PBI |
When removing a PBI, you must give its full name. The full name can be found in the output of pbi_info. The following example searches for the ntop PBI and removes it:
pbi_info | grep ntop
ntop-4.0.1_1-i386
pbi_delete -v ntop-4.0.1_1-i386
Running pre-removal script: /var/db/pbi/installed/ntop-4.0.1_1-i386/pre-remove.sh
Removing: /usr/pbi/ntop-i386
Removing: /var/db/pbi/installed/ntop-4.0.1_1-i386
The pbi_deleterepo command can be used to remove a registered repository from the system. It takes the repository's ID as the only command argument.
7.2.10 pbi_icon(1)
The pbi_icon command provides a number of options for adding desktop icons, menu entries, and mime data for an installed PBI. Not all PBIs will contain desktop/menu/mime data. Additionally, the window manager must be XDG-compliant to understand a PBI's icon and mime settings. Table 7.2g summarizes this command's options:
Table 7.2g: pbi_icon Options
Switch | Description |
add-desktop | installs desktop icon; should be run as regular user |
add-mime | installs mime information; should be run as root |
add-menu | installs menu icons; should be run as root |
add-pathlnk | installs any $PATH links to ~/bin when run as user or to $LOCALBASE when run as root |
del-desktop | removes desktop icon; should be run as regular user |
del-menu | removes menu icons; should be run as root |
del-mime | removes mime information; should be run as root |
del-pathlnk | removes any $PATH links to ~/bin when run as user or to $LOCALBASE when run as root |
7.2.11 pbi_indextool(1)
The pbi_indextool command is useful for repository maintainers. It allows PBI files to be added and removed from the repository's INDEX file. An example of using this command can be found in Create Your Own PBI Repository. Table 7.2h summarizes the available options:
Table 7.2h: pbi_indextool Options
Command | Switch | Description |
add | -b vers | mark previous versions as having a binary diff patch (.pbp file used for upgrading) available |
add | -f pbifile | mandatory, name of PBI being added to the target INDEX file |
add | -k num | number of previous versions of this PBI to keep in the INDEX file |
add | -u fileurl | mandatory URL to PBI location on server in the format category/pbi_name |
rem | -m arch | mandatory architecture type for PBI being removed (e.g. i386, amd64) |
rem | -n pbiname | mandatory name of PBI being removed from the INDEX file |
rem | -v version | mandatory, version of the PBI being removed from the INDEX file |
7.2.12 pbi_info(1)
Similar to FreeBSD's pkg_info command, the pbi_info command is used to determine which PBIs are currently installed. Table 7.2i summarizes the available options:
Table 7.2i: pbi_info Options
Switch | Description |
-a | list all PBIs installed on the system; same as running pbi_info without an argument |
-i | list all available PBIs from any repo |
-v | enable verbose output |
7.2.13 pbi_listrepo(1)
The pbi_listrepo command manages installed repositories on a system. Table 7.2j summarizes this command's options:
Table 7.2j: pbi_listrepo Options
Switch | Description |
--down | move the targeted repoID down a single number in priority |
-mirror URL | change the specified repoID's mirror URL |
--up | move the targeted repoID up a single number in priority |
Run the command without any options to list the IDs of the available repositories.
7.2.14 pbi_makepatch(1)
The pbi_makepatch command is automatically used by pbi_autobuild to create small *.pbp (Push Button Patch) files. These files can be downloaded to a user's system in order to update a PBI's version without re-downloading the entire archive. This allows users to download only the incremental changes when a PBI is upgraded. The command can also be run manually by providing two PBI archives to compare and generate a patch file for.
Table 7.2k summarizes the available options:
Table 7.2k: pbi_makepatch Options
Switch | Description |
-o outdir | save the resulting *pbp file to the specified directory |
--sign keyfile | use the specified openssl key to digitally sign the patch file |
--tmpfs | can reduce building time for large PBIs |
7.2.15 pbi_makeport(1)
The pbi_makeport command can be used by packagers to build a target FreeBSD port and convert it into a PBI file. Many options are provided to fine-tune the build process, and meta-data modules can also be specified to further improve the resulting PBI file. The first time this command is run, it will build a fresh chroot sandbox environment which can be used for clean-room building of the target port without affecting the host system. How to create a PBI using this command is discussed in more detail here.
NOTE: the pbi_makeport command has support for using ccache to speed up the compile process. If ccache is installed on the host system and the CCACHE_DIR variable is set, the pbi_makeport command will automatically utilize it for the port compile phase. This can be disabled by setting NO_CCACHE=yes in /etc/pbi-make.conf on the host system, or as an optional make flag in a module's pbi.conf file.
pbi_makeport, will attempt to create any users or groups that the underlying ports require during the PBI installation. If the PBI is being installed as non-root, it will instead provide a warning message regarding any users or groups that need to be manually created. For this functionality to work, the port must set USERS= or GROUPS= in its Makefile and provide the corresponding UID and/or GID entries.
Table 7.2l summarizes the available options:
Table 7.2l: pbi_makeport Options
Switch | Description |
-B | build-only; generally used with -k to build a port before running pbi_create manually |
-c confdir | specify the metadata configuration directory; while not required it is highly recommended as metadata is required to create icons and binary entry-points |
-d portsdir | specify an alternative ports directory; defaults to /usr/ports |
-k | keep the build files after building the PBI |
-o outdir | the directory to place the finished PBI file; defaults to user's $HOME directory |
-p prefix | manually provide a PREFIX which determines the location where the PBI will be installed on the end-user's system |
--32 | include when building a 32-bit PBI on a 64-bit system |
--delbuild | remove any existing build directories before starting the build |
--mkdebug | will drop to a debugging shell should the port make fail |
--no-prune | disable auto-pruning of non-REQUIREDBY ports after the compile phase; by default any ports which are used solely for building and which are not required for program execution will be pruned |
--pkgdir dir | uses the specified directory to cache the .txz package so subsequent builds will not rebuild the port from source |
--tmpfs | automatically create and mount a tmp filesystem and use it for WRKDIRPREFIX; can speed up port compiles on systems with available RAM |
--sign keyfile | digitally sign the PBI file with the specified openssl private key file |
7.2.16 pbi_makerepo(1)
The pbi_makerepo command allows repository maintainers to create a single *.rpo file containing various information about the new repository. This .rpo file can then be installed on the target system with pbi_addrepo. Table 7.2m summarizes the available options.
Table 7.2m: pbi_makerepo Options
Switch | Description |
--desc description | required; description of the repo to be shown in the repo list |
--key keyfile | required; OpenSSL public key used to verify the digital signature of PBIs installed from this repo |
--mirror URL | required; URL in http://, https://, or ftp:// format to download PBIs and updates from |
--url URL | required; URL in http://, https://, or ftp:// format to use when downloading the master INDEX file of available PBIs |
7.2.17 pbi_metatool(1)
The pbi_metatool command provides a way for repository maintainers to modify the PBI metadata in their repository in order to add or remove application categories or specified PBIs. An example of using this command can be found in Create Your Own PBI Repository. Table 7.2n summarizes the available options:
Table 7.2n: pbi_metatool Options
Command | Switch | Description |
add or rem | --cat | indicates that a new category is being added to or removed from the target metafile |
add or rem | --app | adds or removes a new PBI to/from the target metafile |
add | -a author | adds the name of the application's author to the target metafile |
add | -c category | name of new category to add to the target metafile |
add | -d desc | mandatory description of PBI or category being added |
add | -i icon | mandatory URL to 64x64 .png icon of PBI or category being added |
add | -k keywords | comma delimited list (with no spaces) of search keywords |
add | -l license | type of license (e.g. BSD, GPL, Commercial) |
add or rem | -n name | mandatory name of category or PBI being added to or removed from the target metafile |
add | -t type | type of application (e.g. Graphical, Text, Service) |
add | -u URL | website of application being added |
add | -r | include if application needs to be installed as the superuser |
7.2.18 pbi_patch(1)
The pbi_patch command is used to update an installed PBI to a different version using a small diff Push Button Patch *.pbp file. This allows the user to perform an incremental upgrade of an installed PBI. The available options are summarized in Table 7.2o.
Table 7.2o: pbi_patch Options
Switch | Description |
-e | extract only, do not install; will extract the archive to ~/<pbidirname> unless -o is used |
-g | extract image data from header; commonly used for GUI installations |
-i | display information about this PBI file |
-o outdir | specify the directory to use when only extracting the PBI with -e |
--checkscript | display any custom scripts used in the installation/removal of this PBI file; recommended if the PBI file is suspect in any way |
--no-checksig | skip the openssl signature verification of the PBI data |
--no-hash | disable using the shared hash directory which uses hard links to share files between applications |
7.2.19 pbi_update(1)
The pbi_update command is used to display information about which PBIs have available updates and to perform the updates. Table 7.2p summarizes the available options.
Table 7.2p: pbi_update Options
Switch | Description |
-c | check only the specified PBI for available updates |
--check-all | run a full check of all installed PBIs and display list of available updates |
-disable-auto | disable auto-updating of the target PBI |
--enable-auto | enable auto-updating of the target PBI |
--update-all | update all installed PBIs to the latest versions |
7.2.20 pbi_update_hashdir(1)
The pbi_update_hashdir command is used by the pbid daemon to merge the contents of a PBI into the hash directory.
7.2.21 pbid(8)
The pbid command runs a small daemon which performs maintenance of installed PBIs, merges files into the shared hashdir, fetches the repository INDEX and meta files, and makes the adding and removing of PBIs much faster. It will automatically be started from the/usr/local/etc/rc.d/pbid startup script if pbid_enable="YES" is in the /etc/rc.conf file.
This utility supports the option summarized in table 7.2q:
Table 7.2q: pbid Options
Switch | Description |
-v | enable verbose output when the daemon starts |
--refresh | schedule a refresh of index and meta files |
This command logs its output to /var/log/pbid.log. Check this log for errors should you experience any problems with PBI maintenance.
7.3 Update Manager
Update Manager provides a graphical interface that is used for updating the version of PC-BSD® and for applying security updates. It is also used to update installed PBIs, installed system components, and Warden® meta-packages. The 9.x series of PC-BSD® uses the GENERIC FreeBSD kernel in order to facilitate upgrading the operating system itself.
This section describes how to use the Update Manager GUI to update PBIs or Warden® meta-packages and to apply system updates. Upgrading PC-BSD® demonstrates how to start an operating system upgrade from the GUI.
Advanced users can use the following command line utilities to achieve the same results:
pbi_update: used to update installed PBIs
pc-metapkgmanager: used to update installed system components
pc-updatemanager: used to update the operating system
An icon located in the system tray lets you determine at a glance if any of your installed PBIs are out-of-date or if a system update is available. This icon has several possible states:
your system is up-to-date.
the system is currently checking for updates and patches; this happens automatically whenever you boot your system.
your operating system is out-of-date and system update(s) or patch(es) are available.
newer versions of installed PBI(s) are available; click this icon to open AppCafe® so that you can update the PBI(s).
the system was unable to check for updates, meaning you should check your Internet connection.
the system is currently updating. You should see this icon once you click the “Install selected updates” button.
the system needs to restart in order for the newly installed update to take effect. You will not be able to use Update Manager again until the system is rebooted.
By default, updates are checked every 24 hours or whenever you boot the system. You can check for updates at any time by selecting “Check for updates”.
If you right-click the icon, you will see the menu shown in Figure 7.3a. If updates are available for installed PBIs, AppCafe® will also open to the “Installed” tab so that you can view the new versions which are available.
Figure 7.3a: Right-click Menu for Update Manager
Selecting “Start the Update Manager” from the right-click menu will open Update Manager so that you can review the available system update(s).
Figure 7.3b shows a screenshot of Update Manager:
Figure 7.3b: Update Manager
If any updates are available, they will be listed; if your system is fully up-to-date, there will not be any entries.
If you hover over a listed update, a pop-up menu will provide some details about the update.
To install an update, check the update(s) that you wish to install and click the “Install selected updates” button. You can watch the progress of the update, as seen in Figure 7.3c.
If the update requires a reboot, you will be notified to do so after the update has been installed. If a reboot is needed, clicking the “OK” button at the informational message will not automatically reboot the system, meaning you can continue to use your computer for other tasks while the system is being updated. Finish whatever you are doing and reboot the computer at a time that is convenient for you.
Figure 7.3c: Installing a System Update
7.4 Meta Package Manager
pc-metapkgmanager is the back-end command line utility used by the PC-BSD® installer, System Manager, Update Manager, and Warden® to manage meta-packages. Meta-packages are like system components and include supported and unsupported desktops, development utilities, hardware drivers, and miscellaneous applications such as MythTV or XBMC.
Beginning with version 9.1, PC-BSD® uses metapkgsets to determine which system components are available and which applications are installed with each system component. Currently, two metapkgsets are available: pcbsd which defines the available desktop components, and warden which defines the components available when creating a jail with Warden® or installing a PC-BSD® server. You can view the contents of these metapkgsets on trac.
The pc-metapkgmanager command can be used at the command line to install or delete meta-packages, update to the latest package set, or to change the default metapkgset. If you type the command without any options, it will display its usage:
pc-metapkgmanager
usage: pc-metapkgmanager [options]
Options:
add pkg1,pkg2 <loc> -- Add the specified list of meta-packages
<loc> should be a FTP / HTTP url where pkg_add
can fetch packages, or an absolute path to
location of pkg files on disk.
checkup -- Check for updates to pkgs
del pkg1,pkg2 -- Delete the specified list of meta-packages
list -- List the available meta-packages
status <pkg> -- List the status of the specified meta-packages
update pkg,pkg2 <loc> -- Update system packages. Can use 'all' or <pkg,pkg2>.
<loc> should be a FTP / HTTP url where pkg_add
can fetch packages, or an absolute path to
location of pkg files on disk.
--pkgset <pkgset> -- Change default pkgset we are using
--chroot <dir> -- Operate on the directory specified using chroot
7.4.1 Finding, Installing, and Uninstalling Meta-Packages
To determine which meta-packages are available:
pc-metapkgmanager list |more
Meta Package: Awesome
-------------------------------------
Description: A highly configurable, next generation framework window manager
Icon: /var/db/pc-metapkgmanager/pkgsets/pcbsd/Awesome/pkg-icon.png
Parent: Unsupported-Desktops
Desktop: YES
Required Packages:
awesome-3.4.13
Meta Package: Compiz
-------------------------------------
Description: Compiz - OpenGL compositing manager
Icon: /var/db/pc-metapkgmanager/pkgsets/pcbsd/Compiz/pkg-icon.png
Parent: Misc
Desktop: NO
Required Packages:
compiz-fusion-0.8.4_2
Meta Package: Desktops
-------------------------------------
Description: Supported Desktop Environments for your PC-BSD system.
Icon: /var/db/pc-metapkgmanager/pkgsets/pcbsd/Desktops/pkg-icon.png
Desktop: NO
Category Entry
Meta Package: Development
-------------------------------------
Description: Development tools and utilities for your Desktop
Icon: /var/db/pc-metapkgmanager/pkgsets/pcbsd/Development/pkg-icon.png
Desktop: NO
--More--(byte 989)
To view which meta-packages are available in an alternate metapkgset, specify the metapkgset name. For example, to view the available warden meta-packages from your desktop, use this command:
pc-metapkgmanager --pkgset warden list | more
Meta Package: Apache
-------------------------------------
Description: The Apache Web Server
Icon: /var/db/pc-metapkgmanager/pkgsets/warden/Apache/pkg-icon.png
Parent: Web-Servers
Desktop: NO
Required Packages:
apache-2.2.22_6
Meta Package: BigBlueButton
-------------------------------------
Description: BigBlueButton enables universities and colleges to deliver
a high-quality learning experience to remote students.
Icon: /var/db/pc-metapkgmanager/pkgsets/warden/BigBlueButton/pkg-icon.png
Parent: Web-Apps
Desktop: NO
Required Packages:
mysql-server-5.5.27
bigbluebutton-0.71_3
Meta Package: Database-Servers
-------------------------------------
Description: Database Server Software
Icon: /var/db/pc-metapkgmanager/pkgsets/warden/Database-Servers/pkg-icon.png
Desktop: NO
Category Entry
Meta Package: Development
-------------------------------------
Description: Development tools and utilities
Icon: /var/db/pc-metapkgmanager/pkgsets/warden/Development/pkg-icon.png
--More--(byte 989)
To permanently change the default metapkgset between pcbsd and warden, modify the PCBSD_METAPKGSET variable in /usr/local/etc/pcbsd.conf.
To determine if a meta-package is installed, specify its “Meta Package” name as shown in the output of the pc-metapkgmanager list command. For example, to see if the Awesome desktop is installed:
pc-metapkgmanager status Awesome
The meta-pkg Awesome is not installed
To install the meta-package, use the add option and specify the meta-package name. Only the superuser can install meta-packages. If you do not specify the URL, the default mirror will be used. If you receive an error when downloading the package, you can change the default mirror in Control Panel ➜ System Manager ➜ Mirrors.
The following example installs the Awesome meta-package. pc-metapkgmanager will provide messages regarding the status of the installation:
pc-metapkgmanager add Awesome
Pending Meta-Package changes: 1
Package source: NET
Preparing to add: Awesome...
Checking for updates to old packages...
Installing Meta-Package: Awesome
Getting package list...
Pending package changes: 6
Downloading package: awesome-3.4.13
//usr/local/tmp/awesome-3.4.13.txz 100% of 704 kB 637 kBps
Downloading package: libev-4.11,1
//usr/local/tmp/libev-4.11,1.txz 100% of 117 kB 361 kBps
Downloading package: libxdg-basedir-1.1.1
//usr/local/tmp/libxdg-basedir-1.1.1.txz 100% of 11 kB 130 kBps
Downloading package: xcb-util-image-0.3.8
//usr/local/tmp/xcb-util-image-0.3.8.txz 100% of 18 kB 141 kBps
Downloading package: xcb-util-keysyms-0.3.8
//usr/local/tmp/xcb-util-keysyms-0.3.8.txz 100% of 8040 B 72 kBps
Downloading package: xcb-util-wm-0.3.8
//usr/local/tmp/xcb-util-wm-0.3.8.txz 100% of 35 kB 148 kBps
Installing package: awesome-3.4.13
Skipping installed package: libev-4.11,1
Skipping installed package: libxdg-basedir-1.1.1
Skipping installed package: xcb-util-image-0.3.8
Skipping installed package: xcb-util-keysyms-0.3.8
Skipping installed package: xcb-util-wm-0.3.8
The meta-pkg Awesome is installed
Finished Meta-Package: Awesome
Meta-Package changes finished!
To delete an installed meta-package, specify its name. Only the superuser can uninstall meta-packages. As seen in the following example, pc-metapkgmanager automatically determines which dependent packages are still needed by other applications and which can be safely removed.
pc-metapkgmanager del Awesome
Pending Meta-Package changes: 1
Removing Meta-Package: Awesome
Getting package list...
Pending package changes: 66
Removing: awesome-3.4.13
Skipping Meta-Required: giflib-4.2.0_2
Removing: libev-4.11,1
Removing: libxdg-basedir-1.1.1
Removing: xcb-util-image-0.3.8
Removing: xcb-util-keysyms-0.3.8
Removing: xcb-util-wm-0.3.8
Skipping Required: bitstream-vera-1.10_5
Skipping Required: cairo-1.10.2_4,2
<snip output of other required packages>
The meta-pkg Awesome is not installed
Meta-Package changes finished!
pc-metapkgmanager can also be used to determine if any meta-packages are out of date and to update meta-packages. To determine if any meta-packages have newer versions:
pc-metapkgmanager checkup
All packages are up to date!
In this example, all meta-packages are at their latest versions. If any were out of date, you would instead receive the message “The following package updates are available:” followed by the names of the out-of-date meta-packages.
To update a meta-package, use the pc-metapkgmanager update command followed by the name of the specific meta-package or the word all to update all out-of-date meta-packages.
pc-metapkgmanager records any error messages to /tmp/.pc-metamanager.log. This log file automatically rotates whenever it reaches 5MB in size.
7.5 Create Your Own PBI Repository
By default, AppCafe® displays the PBIs which are available from the official PC-BSD® repository. It also supports custom repositories, allowing organizations to create PBIs for their own applications and to make them available to their users within AppCafe®.
In order to create a custom repository, you need to:
create the OpenSSL signing key which will be used to sign custom PBIs
generate a repository file and populate it with custom PBIs
generate the meta-data for the PBIs which are available within the repository
This section describes these steps in more detail.
7.5.1 Generate the Signing Key
Running a repository requires that all the PBIs in the custom repository be digitally signed for security and identification purposes. In order to sign the PBIs, generate an OpenSSL key pair using the following commands:
openssl genra -out privkey.pem 4096
Generating RSA private key, 4096 bit long modulus
..................++
.............................................................................++
e is 65537 (0x10001)
openssl rsa -in privkey.pem -pubout > pub.key
writing RSA key
These commands will create the files privkey.pem and pub.key. The privkey.pem file will be used to digitally sign your created PBI files and the pub.key file will be included with the repository configuration (.rpo) file.
7.5.2 Create the Repository
In order to create the repository you will need a FTP, HTTP, or HTTPS server to host your repository’s meta-data files and to store the repository's PBIs. The server can be a public URL on the Internet or a private LAN server, as long as it is accessible to your target audience.
Once you have the URL to the server, create the repository's .rpo file using the pbi_makerepo command. Replace the values in the following example with your own description, path to your generated pub.key file, the URL to the location where the PBIs will be hosted, the URL to the location to contain the repository's meta-data files, and the directory to place the created .rpo file.
pbi_makerepo --desc “My Example Repository” --key pub.key --mirror “ftp://ftp.example.org/pbi-files” --url “http://www.example.org/pbi-meta” /root
This command will generate the pbi-repo.rpo file in the specified directory on the server. This file is needed for clients to register with and begin using the new repository. Instruct your clients to download this file to their PC-BSD® desktop, then to configure their system to use the repository using this command as the superuser:
pbi_addrepo pbi-repo.rpo
Once the repository is registered on the clients system, their pbi daemon will automatically keep track of downloading and updating both meta-files and PBIs from the URLs you specified in the repository configuration file.
7.5.3 Generate the Repository's Meta-Data
On the server, you can now create the meta-data and PBI files so that clients have something to download. The meta-data file is used to give the client information about the PBIs available from the repository, such as categories, application names, and descriptions. When creating categories, you can use the same category names that appear in AppCafe®, or you can create your own categories. Each category and each PBI will need its own icon. These icons need to exist on the server before generating the meta-data file.
When you are ready, create an empty meta-data file in the format pbi-meta-<Major Version Number>. This command should be used for 9.x series PBIs:
touch pbi-meta-9
Then use the pbi_metatool command to add the category for a PBI. The following command adds the “Archivers” category, its description, and the URL pointing to the mandatory 64x64 .png icon file to the specified meta-data file.
pbi_metatool add --cat -n “Archivers” -d “File Archivers and Utilities” -i “http://www.example.org/pbiicons/archivers.png” pbi-meta-9
Next, add the following information about the PBI: the name of the application, the category, the application author, a description of the application, the URL pointing to the mandatory 64x64 .png icon file for the application, a comma delimited list (with no spaces) of search keywords, the type of license, the type of application (“Graphical”, “Text”, or “Service”), the URL to the application's website, and the name of the meta-data file to add the information to.
pbi_metatool add --app -n “cabextract” -c “Archivers” -a “Stuart Caie” -d “Utility for reading and extracting .cab files.” -i “http://www.example.org/pbi-icons/cabextract.png” -k “cab,archive,extract” -l “LGPL” -t “Text” -u “http://www.cabextract.org.uk” pbi-meta-9
Repeat this command for each PBI that will be available in the repository, creating new categories as you need to do so.
When you are finished adding the information for the repository's PBIs, compress the file with bzip2 and upload it to the server. The location in our example would be http://www.example.org/pbi-meta/pbi-meta-9.bz2. Once the file is uploaded, clients can use the pbi_browser command or AppCafe® to browse the repository's PBIs.
You should now create your custom PBIs then upload them to their specified category in the download directory on the server. In our example, the download directory is ftp://ftp.example.org/pbi-files/. Refer to the section on creating PBIs for instructions on creating PBIs using either the EasyPBI graphical utility or the pbi_makeport command line utility.
When creating your PBIs, remember to sign them with the private key. If you are using EasyPBI, specify the location to the privkey.pem file by clicking the “Change File” button shown in Figure 8.1d. If you are using the pbi_makeport command, include --sign privkey.pem in the command.
Lastly, create the pbi-index-9 file and add the names of the uploaded PBIs to the file. Use the pbi_indextool to add each entry, specifying that PBI's filename (will end in .pbi), the download location (in the format category/pbi_name), and the name of the index file.
touch pbi-index-9
pbi_indextool -f cabextract-1.2-amd64.pbi -u “archivers/cabextract-1.2-amd64.pbi” pbi-index-9
When you are finished adding entries to this file, use bzip2 to compress it and upload the pbi-index-9.bz2 to the same location on the server where the pbi-meta-9.bz2 file is stored. Clients can now download and install PBIs from your custom repository, using the pbi_add command or AppCafe®.
7.5.4 Configure the Automatic Build of Updated Ports
Over time, the PBIs in your repository will become out-of-date as the versions of the underlying ports change. You can automate the process of automatically rebuilding the newer version of a PBI, as well as generating the binary diff changes to the PBI (which users use to upgrade their installed version of the PBI), whenever an underlying port changes.
To configure this scenario, ensure that all of your PBI modules exist under the same directory and follow the directory structure of the ports tree. For example, if you have created PBIs for cabextract and firefox, the subdirectory structure for /usr/local/my_pbis/ would be archivers/cabextract/ and www/firefox/.
To start the build process, use the pbi_autobuild command as seen in this example:
pbi_autobuild --keep 2 -c /usr/local/my_pbis -o /usr/local/my_pbis --prune --tmpfs --sign /root/privkey.pem –genpatch
This command keeps the last 2 versions of the PBI, reads the modules located in the subdirectories of /usr/local/my_pbis, places the built PBIs in the /usr/local/my_pbis directory, removes any PBIs which no longer have an associated module, uses tmpfs to optimize build speed, signs the PBIs with the specified key, and generates the .pbp patch files needed by users to upgrade an installed version of the previous PBI. The new PBIs and .pbp files will be placed in the specified outgoing directory. If an earlier version of the PBI exists in that directory, it will be placed into the archived subdirectory.
If the ccache FreeBSD port is installed on the build system and the CCACHE_DIR variable is set, pbi_autobuild will detect and use it which can greatly speed up the process of building the PBIs.
Depending upon the load on the build server and how many PBIs are affected by the build, you may wish to modify some pbi.conf values in particular PBI modules. The variables that can affect a build are:
PBI_BUILDKEY: set to a numerical value to instruct pbi_autobuild to rebuild that particular PBI. This is useful when a port has failed to build or you wish to rebuild a PBI with new compile options even though the upstream target port has not changed.
PBI_AB_PRIORITY: when automatically building a large number of PBIs, the build process occurs alphabetically. By setting an incremental integer value, it is possible to artificially force the building of PBIs in the specified order of importance.
PBI_AB_NOTMPFS: typically, using the --tmpfs flag greatly speeds up the build process by extracting a port's files into memory, and compiling directly into RAM. However some ports, such as OpenOffice, require more memory than is available, causing the build to fail. By setting this variable to YES in that PBI's pbi.conf, it is possible to flag that port as needing to build in the traditional manner from disk.
PBI_MAKEOPTS: if you use ccache, you may occasionally run into a port that will not compile properly with CCACHE enabled. For that PBI, edit this variable to include NO_CCACHE=yes which will disable CCACHE for that specific port build.
8 Control Panel
Beginning with version 9.0, PC-BSD® provides a Control Panel which contains tools for managing your system. The Control Panel is available from any desktop, meaning it is available regardless of which desktop you log into.
NOTE: if an unsupported desktop does not contain an icon or menu item for Control Panel, simply type pc-controlpanel from a shell prompt to launch the Control Panel.
A screenshot of Control Panel can be seen in Figure 8.a.
If you know what you would like to configure but not which control panel icon to use, use the search bar in the upper right corner.
If an icon includes a yellow exclamation mark, you will need the superuser password in order to access that configuration utility.
NOTE: your user account must be a member of the wheel group in order to use the superuser password. If your account is not a member of this group, you will not see the configuration utilities that require superuser access in the Control Panel. By default, the first user account that you create is made a member of the wheel group. You can log in as that user and use User Manager to add other accounts to this group.
Figure 8.a: PC-BSD® Control Panel
Control Panel includes a desktop selector menu which allows you to load the configuration utilities from KDE3 and 4, GNOME2, XFCE3 and 4, and LXDE. Figure 8.b shows the desktop selector menu. In this example, the user is currently logged into the LXDE desktop but they have chosen to view the GNOME utilities. You can tell that this is the case as the icon is the GNOME foot and the menu indicates that LXDE is “(current)”.
NOTE: if you select another desktop or “All”, you will see which additional utilities are available. However, if that desktop is not currently installed, no additional icons will be added to Control Panel. You can install additional desktops using System Manager.
Figure 8.b: Desktop Selector Menu
This section demonstrates how to use the following utilities which are found in the Control Panel of a PC-BSD® system, regardless of the desktop that is installed:
Software and updates
System management
Hardware
Networking
Tools
8.1 EasyPBI
EasyPBI is a graphical application that makes it easy to build a PBI module from a FreeBSD port. Beginning with PC-BSD® 9.1, EasyPBI ships with PC-BSD® and can be found in the Control Panel.
This section demonstrates how to use this utility to convert an existing FreeBSD port into a PC-BSD® PBI. You may wish to skim the section on how to Create PBIs first, as well as refer to that Guide should you have trouble creating a PBI or wish to create a more complex PBI.
To start EasyPBI, double-click its icon in Control Panel or type EasyPBI from within an X terminal as your regular user account.
If the ports collection is not installed, you will receive the message shown in Figure 8.1a the first time you start EasyPBI.
Figure 8.1a: Ports Must be Installed to Use EasyPBI
If multiple users will be using the EasyPBI utility, go to Control Panel ➜ System Manager ➜ Tasks and click the “Fetch Ports Tree” button. Alternately, use the following command as the superuser: portsnap fetch extract. Either of these methods will install the ports collection into /usr/ports.
If you are the only user who will be using the EasyPBI utility, click OK to launch the main EasyPBI screen, shown in Figure 8.1b. Click File ➜ Get Ports which will download the ports collection to the EasyPBI subdirectory located in your home directory.
Figure 8.1b: EasyPBI Graphical Interface
If the ports collection was already installed or was installed using System Manager or portsnap, the message in the bottom area of the screen will instead indicate “To get started, please push the “New Module”” button.
8.1.1 Creating a PBI Module
Before building a PBI, refer to the PBI Requests forum to determine which PBIs have been requested by users. You should also check that a module does not already exist for the PBI in the PBI Modules section of trac. Existing modules are listed alphabetically, according to their category in the ports collection.
To create a new module, click the “New Module” button and use the browser to select the desired port from the FreeBSD ports tree. Once a port is selected, EasyPBI will attempt to automatically supply the port information for the PBI and display the results in the GUI. In the example shown in Figure 8.1c, the net/trickle port has been selected and the fields have been auto-filled in.
Figure 8.1c: Review the New Module
You should review these fields for accuracy. If you click “Get Port Info” FreshPorts.org will open in the default web browser so that you can view additional information about the port.
A generic icon will be supplied for the module; you can change the default icon by clicking the “Choose Icon” button. When using a custom icon, use a 64x64 .png file with a transparent background.
Check the “Create Desktop/Menu Entries” if you wish the program's icon to be available on the desktop and in the desktop's application menu.
Once the port information is complete, click the “Create Module” button and EasyPBI will produce the PBI module. The module will be named after the port and will be stored in a subdirectory of the EasyPBI/Modules directory in your home directory. In this example, the module is located in EasyPBI/Modules/trickle.
8.1.2 Build the Module
Creating the module itself is very quick and takes less than a minute. However, you still need to build and test the module to make sure that the application works as expected. Depending upon the complexity of the application, you may have to edit the initial module then rebuild and retest it until you are satisfied with the PBI for the application.
Once the module is created, you are ready to build a PBI from the module. Click on the “Build PBI” tab and click the “Select Module” button to browse to the module you created. Figure 8.1d shows this tab with our example PBI selected.
Figure 8.1d: The Build PBI Tab
The top half of this screen contains modifiable settings which are used when building PBIs:
Save Settings as Defaults: the settings in this section revert back to the default settings when you exit EasyPBI. This allows you to override the default settings for a particular build. If you wish your changes to be permanent, click this button.
Output Directory: specifies the directory to store the built module. By default, it is the EasyPBI/PBI subdirectory of the user's home directory. Click the “Change Directory” button to select another location.
Digital Signature File: the PBIs available from the PC-BSD® repositories are digitally signed by the PC-BSD® project's signature file. If you are creating your own repository, click the “Change File” button to select your own digital signature file. Create Your Own PBI Repository provides instructions for creating a signature file.
Use TMPFS: if your build system has a lot of RAM, selecting this option can speed up the build.
Use Package Caching: this setting is recommended as it reuses previously built packages to speed up subsequent builds.
The rest of this screen is used to build the specified module:
Select Module: select the previously created module to build.
Build PBI: starts the build of the PBI module. It will prompt you for the superuser password and requires a working Internet connection in order to build the PBI. This process may take quite a while, depending upon the port selected and the speed of your computer. The build messages will be displayed in the window at the bottom of the tab. EasyPBI will inform you when the PBI build is finished, and whether it was successful or not.
Stop Build: stops the build process. Click the “Build PBI” button to resume the build.
Save Build Log: useful if the build fails. Will prompt you to select the location to store build.log which can be read with any ASCII text editor.
You can produce additional modules from the “Create Module” tab while a PBI build is running.
If the PBI build fails for some reason, you may need to modify the module as described in the next section. Use the build log to determine the error and modify the module as needed. If you are unsure how to fix the module, send the build.log for the failure to the pbi-dev mailing list.
8.1.3 Test and Fine-Tune the Module
Once your build is finished, test the PBI to ensure that it installs and that the application works.
To install the PBI, become the superuser, cd to the “Output Directory”, and use the pbi_add command. Unless you have specified your own digital signature, include the --no-checksig option.
su
Password:
cd ~dru/EasyPBI/PBI
ls
trickle-1.07_2_amd64.pbi trickle-1.07_2_amd64.pbi.sha256
pbi_add --no-checksig trickle-1.07_2_amd64.pbi
Verifying Checksum...OK
Extracting to: /usr/pbi/trickle-amd64
Installed: trickle-1.07_2
If the module installs successfully, perform the following tests:
if you checked the box “Create Desktop/Menu Entries”, verify that a desktop icon was created (from a desktop that supports icons), that an entry was added to that desktop's application menu, and that the application successfully launches from the application menu. If you used a custom icon, verify that the icon was used.
start the application from the command line to determine if there are any error messages at application launch. When starting the application, specify the full path to the application's binary to make sure that you are testing the PBI's binary.
for GUI applications, go through the various menus to see if they produce any errors.
if you encounter any error messages in either starting or using the application, record them. If the fix for resolving the error messages is not clear to you, send the error report the pbi-dev mailing list.
The “Module Editor” tab, seen in Figure 8.1e, can be used to modify the module's settings. Use the “Select Module” button to browse to the location of the module and to ungrey out the settings in this screen.
Several tabs are provided, allowing you to customize the PBI module. It should be noted that most PBI modules do not require you to make any configuration changes in the “Module Editor” tab. This tab allows the creation of more complex PBI modules that require additional FreeBSD ports or scripts which are not provided by the default FreeBSD port.
The rest of this section describes the actions available within each tab. If you modify any settings in the PBI module, rebuild it then test again to see if the changes fixed the PBI.
Figure 8.1e: EasyPBI Module Editor
8.1.3.1 pbi.conf
Typically the “Program Name”, “Program Website”, and “Program Author” are left at their default values. If this information is incorrect, you should email the FreeBSD port maintainer shown in the “Program Author” field so that the information can be corrected in the FreeBSD port.
If you choose to replace the “Program Icon”, use a 64x64 .png file with a transparent background.
If your PBI requires a dependency that is not provided by the FreeBSD port, use the + button next to “Make Port Before” to select the needed port.
If you wish an additional port to be included with your PBI, use the + button next to “Make Port After” to select the desired port.
The “Make Options” field lets you specify a space separated list of options. The available options and their default settings will be listed in the OPTIONS= section of the port's Makefile.
If the resulting PBI needs to be run as the root user, check the “Require Root Permissions” box.
8.1.3.2 Resources
This tab, shown in Figure 8.1f, is used to add additional files to the PBI module.
Figure 8.1f: PBI Module Resource Configuration
An example of an additional file would be an application that requires the user to accept a License. Use the “+Add Resource” button to browse to the location of the LICENSE file.
Another example would be when you wish to use a custom script to start the application rather than starting the application binary directly. A custom script could also be used to verify that the service is enabled or to generate a custom configuration file.
If the application uses custom installer graphics, add them using this screen.
8.1.3.3 Desktop/Menu Entries
This tab, shown in Figure 8.1g, is used to fine-tune the desktop icon and the application menu entry for the application.
Figure 8.1g: Customizing the PBI's Desktop and Menu Entries
If the “Create Desktop/Menu Entries” box was checked when creating the module and EasyPBI detects that the application is graphical, the default entries for the application will be listed. In our PBI example, trickle is a command line application so no entries were created by default. If your application is graphical but EasyPBI did not detect it, you can manually add the desired entries using the “Remove Desktop Entry” and “Remove Menu Entry” buttons.
Under “Executable”, the drop-down menu will display all of the binaries that came with the application. Select the binary that should launch when the user clicks the desktop icon or selects the application from the application menu. Alternately, you can select “Custom Binary” and input the path to the desired executable.
The “Entry Label” field allows you to customize the name that will appear with the icon and application menu entry.
The “Icon” drop-down menu allows you to select the .png file to use for the icon. This file must exist in ~/EasyPBI/Modules/PBI_name/resources in order to appear in the drop-down menu. Use the “Select Module” button to re-select the module if you add the icon after loading the module.
The “Menu Category” drop-down menu is used to select the category the application menu entry will be added to.
To add a desktop entry, select an “Executable”, input an “Entry Label”, and click the “+Add Desktop Entry” button. This will generate the .desktop file to be used by XDG-compliant desktops. The entry will appear under “Current Desktop Entries”.
To add an application menu entry, select an “Executable”, input an “Entry Label”, and click the “+Add Menu Entry” button. The generated .desktop file will appear under “Current Menu Entries”.
8.1.3.4 External-Links
This tab, shown in Figure 8.1h, is used to customize how the specified binary starts.
Figure 8.1h: Configuring Custom Links for the PBI
To customize how a binary starts, highlight it and click the “Action” drop-down menu. The possible actions are:
binary: indicates that this is an executable. EasyPBI will automatically create the necessary wrapper and PATH links for you.
linux: indicates that this is a Linux executable. EasyPBI will automatically create the necessary Linux wrapper and PATH links for you.
keep: instructs the PBI to not overwrite an existing binary when linking a file into the LOCALBASE. By default, LOCALBASE is set to /usr/local.
replace: instructs the PBI to overwrite an existing binary when linking a file into the LOCALBASE.
nocrash: disables the crashhandler GUI from running on this PBI. Note that the glue for the crash handler is not built into the base system yet.
If you select an “Action”, use the up arrow to add it. If you change your mind, click the “Clear Changes” button.
8.1.4 Submit the Module
Once you are satisfied with the PBI, go to the “Module Editor” tab and use the “Select Module” button to select the PBI's module. Then click the “Package Module” button. A pop-up window will indicate that the module has been compressed and that a .tar.gz file has been added to the PBI module directory. The file name for our example PBI is ~dru/EasyPBI/Modules/trickle.tar.gz.
If you send that file to the pbi-dev mailing list, it will be added to the PC-BSD® build servers so that the 32- and 64-bit versions of the PBI can be built. Once the built PBIs are tested, they will be added to AppCafe® so that other PC-BSD® users can benefit from the PBI.
8.2 About
The “About” icon of Control Panel can be used to quickly find information about the PC-BSD® system. To start the application, double-click its icon in Control Panel or type about-gui. An example is seen in Figure 8.2a.
Figure 8.2a: About Information
The displayed information includes the version of PC-BSD®, the hostname of the system, the architecture where i386 equals 32-bit and amd64 equals 64-bit, the name of the kernel (ident), the type of CPU, and the amount of installed memory.
If you click the “Components” button, the X.org version and installed desktop components will be displayed, as seen in the example shown in Figure 8.2b.
Figure 8.2b: Determining the Versions of X and Installed Desktops
8.3 Active Directory & LDAP
Beginning with PC-BSD® 9.1, the Control Panel contains an “Active Directory & LDAP” icon for managing connections to an Active Directory or OpenLDAP domain. If your network contains an Active Directory or OpenLDAP server, use this icon to input the settings needed to connect to your account information stored on the network. At this time, these settings can not be set during installation of PC-BSD® 9.1; this will be added as a feature of version 9.2.
NOTE: this utility is to manage the settings of the client, not the Active Directory or OpenLDAP server itself.
To start the application, double-click its icon in Control Panel or type pc-su pc-adsldap. You will be prompted to input the administrative password. Figure 8.3a shows the configuration utility with the Active Directory tab open.
Figure 8.3a: Initial Active Directory & LDAP Screen
8.3.1 Connecting to Active Directory
If you need to connect to a network running Active Directory, check the box “Enable Active Directory”. This will change the greyed-out status of the rest of the screen, allowing you to configure the following:
Domain Name (DNS/Realm-Name): input the name of the Active Directory domain (e.g. example.com) or child domain (e.g. sales.example.com). This setting is mandatory.
NetBIOS Name: input the hostname of the PC-BSD® system as listed in the About icon.
Workgroup Name: input the name of the Windows workgroup. Unless the administrator has changed it, the default workgroup name is WORKGROUP.
Allow Trusted Domains: only check this box if the network has active domain/forest trusts.
Administrator Name: input the name of the Active Directory Administrator account.
Administrator Password: input and confirm the password for the Active Directory Administrator account.
The values that you input using this GUI are saved to /usr/local/etc/pc-activedirectory.conf.
8.3.2 Connecting to an OpenLDAP Server
Figure 8.3b shows the configuration utility with the LDAP tab open.
Figure 8.3b: Managing LDAP Client Settings
If you need to connect to a network which contains a configured LDAP server, check the box “Enable LDAP”. This will change the greyed-out status of the rest of the screen, allowing you to configure the following:
Hostname: input the hostname or IP address of the OpenLDAP server. This setting is mandatory.
Base DN: input the top level of the LDAP directory tree to be used when searching for resources (e.g. dc=test,dc=org).
Allow Anon Binding: only check this box if the LDAP server allows read and write access without requiring authentication.
Root bind DN: input the name of the administrative account on the LDAP server (e.g. cn=Manager,dc=test,dc=org).
Root bind password: input the password for the Root bind DN.
Password Encryption: select a type supported by the LDAP server, choices are: clear (unencrypted), crypt, md5, nds, racf, ad, or exop.
User Suffix: this setting is optional and is usually a dept. or company name. The input value will be added to the name when a user account is added to the LDAP directory
Group Suffix: this setting is optional and is usually a dept. or company name. The input value will be added to the name when a group is added to the LDAP directory.
Password Suffix: this setting is optional. The input value will be added to the password when a password is added to the LDAP directory.
Machine Suffix: this setting is optional and usually represents a description such as server or accounting. The input value will be added to the name when a system is added to the LDAP directory.
Encryption Mode: choices are Off, SSL, or TLS. The selected type must be supported by the LDAP server.
Self Signed Certificate: used to verify the certificate of the LDAP server if SSL connections are used. Paste the output of the command openssl s_client -connect server:port -showcerts.
Auxiliary Parameters: ldap.conf(5) options, one per line, not covered by other options in this screen.
The values that you input into this tab are saved to /usr/local/etc/pc-ldap.conf.
If you are new to LDAP terminology, you may find it useful to skim through the OpenLDAP Software 2.4 Administrator's Guide.
8.4 Hardware Compatibility
Beginning with version 9.1, the PC-BSD® installer allows you to quickly determine if your system's video card, Ethernet card, wireless device, and sound card are compatible with PC-BSD®.
A “Hardware Compatibility” icon in Control Panel provides a quick overview of the system's detected hardware. To start the application, double-click its icon in Control Panel or type pc-sysinstaller -checkhardware.
In the example shown in Figure 8.4a, this system has a detected NVIDIA video card with a configured resolution of 1600x900, one Ethernet device using the em(4) driver, and one wireless device using the iwn(4) driver. Currently no sound card is detected, meaning that the user should configure and test their sound card using the Sound Configurationicon in Control Panel.
Figure 8.4a: Sample Hardware Compatibility
If the wireless device shows as unsupported, check the Wireless Testing page to help determine if a driver is forthcoming or if the device is well suited to converting a Windows driver into a FreeBSD loadable module.
Hardware that is currently incompatible may show with a green checkbox after a system upgrade or update. This indicates that the update added the driver for the device.
8.5 GDM Configuration
PC-BSD® uses the GNOME Display Manager (GDM) as its graphical login program. This program was chosen for its support of keyboard layouts, localizations, and accessibility.
Beginning with PC-BSD® 9.1, a GDM Configuration utility is available in Control Panel. Figure 8.5a shows the initial screen when you click on this icon in Control Panel or type pc-su pc-gdmconf at the command line. Note that this utility will prompt you for the administrative password.
Figure 8.5a: GDM Configuration Utility
For security reasons, PC-BSD® defaults to a login screen. This means that users are required to input their password before logging into the PC-BSD® system. If you are the only user on the PC-BSD® computer, always use the same window manager, and do not consider it a security risk for the system to automatically boot into that window manager, you can enable auto-login using the “Auto login” tab.
As seen in the example in Figure 8.4a, the “Enable auto login” box is unchecked by default. If you check the box, the “Auto login user” drop-down menu will be activated. Select the user account to automatically login as. You can also set a delay period (in seconds) to give time to cancel the auto-login, for example if you wish to log into a different desktop.
The “Remote login” tab, shown in Figure 8.5b, is used to configure XDMCP, a protocol that comes with Xorg and allows a connection to an X session from a remote system. Uncheck the “Enable XDMCP” box to enable this service and expose the configuration options. By default, XDMCP uses UDP port 177, allows one connection per host, and allows up to 16 simultaneous sessions.
NOTE: use extreme caution when enabling this option as it can make your system available to anyone over the network. If you need someone to access your PC-BSD® system to assist with troubleshooting, consider using Remote Desktop instead, which allows you to send an invitation to connect. Always disable any type of remote login immediately after finishing your troubleshooting session.
Figure 8.5b: Configuring Remote Login
The "Misc" tab, shown in Figure 8.5c, is used to configure whether or not other computers are allowed to connect to your X server, which provides your GUI environment.
Figure 8.5c: Allowing X Connections
For security reasons, no connections are allowed by default. If you check the “Allow incoming TCP X connections”, other computers in your network may have access to your GUI. Use extreme caution when enabling this option as it can make your system available to anyone over the network. If you are enabling this option for troubleshooting purposes, uncheck this box immediately after finishing your troubleshooting session.
8.6 Service Manager
Service Manager, seen in Figure 8.6a, provides a graphical utility for managing PC-BSD® services. Buttons make it easy to start, stop, or restart services and to set the highlighted service to be enabled or disabled whenever the system boots. To access this utility, go to PC-BSD® Control Panel ➜ Service Manager or type pc-su pc-servicemanager. You will be prompted to input the administrative (also known as the “root” or “superuser”) password.
Figure 8.6a: Managing Services Using Service Manager
By default, services will be listed alphabetically. You can reorder the services by clicking on the “Service Name”, “Running”, or “Enabled” header.
Service Manager is a graphical front-end to the rc scripts located in /etc/rc.d. PC-BSD® 9.2 will include an “Info” button where you can get a short description of the highlighted service.
If you do not know what a service does, do not change its settings in Service Manager. If you would like to learn more about a service, try seeing if there is a man page for it. For example, type man apm or man bootparamd. If a man page does not exist, try seeing what man pages are associated with that keyword. For example:
apropos accounting
ac(8) - connect time accounting
acct(2) - enable or disable process accounting
acct(5) - execution accounting file
accton(8) - enable/disable system accounting
ipfw(4) - IP packet filter and traffic accounting
pac(8) - printer/plotter accounting information
pam_lastlog(8) - login accounting PAM module
sa(8) - print system accounting statistics
This section describes the various tasks that can be performed using the graphical System Manager utility. System Manager can be accessed from Control Panel ➜ System Manager or by typing pc-sysmanager.
8.7.1 Generating a Diagnostic Report
System Manager, shown in Figure 8.7a, is launched by clicking Control Panel ➜ System Manager. You will have to input the administrative password to allow the System Manager window to open.
Figure 8.7a: General Tab of System Manager Utility
The “General” tab displays the following system information:
the version of PC-BSD®
the version of the underlying FreeBSD base
the CPU type and speed
the amount of physical memory
The “Generate” button can be used to create a report that includes the following items:
the output of the dmesg command, which shows messages from the kernel
the last few lines of the /var/log/messages log file
the output of the pciconf -lv command, which lists all the devices that were found when the system booted
your X configuration file, which shows your display settings
your /etc/rc.conf file, which shows your startup settings
your /boot/loader.conf file, which shows which drivers are loaded at boot time
the output of the command df -m, which shows your amount of free disk space
a listing from the top command, which shows the currently running processes
When you click the “Generate” button, you will be prompted to input the name and location of the text file that will be created. Since it is a text file, you can view its contents in any text editor. When troubleshooting your system, this file is handy to include in your forum post or mailing list message.
8.7.2 Setting an Update Mirror
The "Mirrors" tab of System Manager, seen in Figure 8.7b, allows you to configure which PC-BSD® mirror is used when installing applications or updates using AppCafe® or Update Manager.
Figure 8.7b: Mirrors Tab of the System Manager Utility
By default, PC-BSD® automatically checks its list of mirrors every day to ensure each mirror is operational. If you keep the default selection of "Use auto-detected mirrors", it will automatically choose the available mirror that is geographically closest to your location and your mirror will automatically change if you are travelling or if your current mirror goes down.
Alternately, you can override the automatic selection by clicking "Select Mirror from list" and choosing a mirror in the drop-down menu. Occasionally, your selected mirror may become busy or unavailable. If you are unable to install a PBI or an update, try selecting another mirror from the drop-down list or change your selection back to "Use auto-detected mirrors".
If your company maintains its own repository of PBIs or updates, you can select the “Specify a custom Mirror” button and input the IP address of the company's server.
8.7.3 Install/Uninstall Desktops and System Components
During the installation of PC-BSD® you had an opportunity to install desktops and system components. Should you wish to review these components, install missing components, or remove installed components, you can do so in the “System Packages” tab of System Manager, shown in Figure 8.7c.
Figure 8.7c: Available Components in System Manager
Check the boxes for the components that you wish to install, uncheck the boxes for the components that you wish to remove, then click the “Apply” button to perform the requested operations.
This page contains a brief description of the available components.
8.7.4 Install FreeBSD Source and Ports
During the installation of PC-BSD® you had an opportunity to install FreeBSD source and ports. If you did not and wish to do so after installation, use the “Tasks” tab of System Manager, shown in Figure 8.7d.
This tab provides a graphical interface for installing system source (using svn) or the ports tree (using portsnap).
If you click the “Fetch System Source” button, a progress screen will indicate that sources are being downloaded to /usr/src/. Once the download is complete, a “Finished!” message will appear and you can click the “Close” button to exit this screen.
If you click the “Fetch Ports Tree” button, a message will indicate that ports are being fetched and will indicate when this is complete by adding a “Finished!” message to the lower left corner of the message. Ports will be installed to /usr/ports/.
Figure 8.7d: Tasks Tab of the System Manager Utility
8.7.5 Set Miscellaneous Options
The “Misc” tab of System Manager is seen in Figure 8.7e.
The “Boot Screen” section of this tab allows you to configure whether or not the PC-BSD® splash image appears during boot and the language of the splash screen. Uncheck this box if you prefer to watch the boot messages instead of the splash image. Localized versions of the PC-BSD® splash screen are installed in the /usr/local/share/pcbsd/splash-screens/ directory. If you click the “Custom” button, you can browse to the location of a customized splash screen.
NOTE: the splash screen must be an indexed-mode 256-color image in the bitmap (.bmp) or ZSoft PCX (.pcx) format. However, this GUI will not accept a bitmap image. Further information can be found at the FreeBSD Bootsplash page.
The “Other Options” section of this tab contains a checkbox to “Force IBUS keyboard input”. Check this box if you wish to to input Chinese, Japanese, Korean or Indic characters using a Latin keyboard.
Figure 8.7e: Misc Tab of the System Manager Utility
8.8 User Manager
The PC-BSD® User Manager utility, seen in Figure 8.8a, allows you to easily add and delete users and groups, as well as change a user's or the administrative password. To access this utility, go to Control Panel ➜ User Manager or type pc-su pc-usermanager. You will need to input the administrative password in order to access this utility.
In this example, the system has 2 user accounts. The dru account has the ability to become the superuser as the “Can administrate system” checkbox is checked.
If you click the “Remove” button for a highlighted user, a pop-up menu will ask if you would like to also delete the user's home directory (along with all of their files). If you click “No”, the user will still be deleted but their home directory will remain. If you have only created one user account, the “Remove” button will be greyed out as you need at least one user to be able to login to the PC-BSD® system.
NOTE: while a removed user will no longer be listed, the user account will not actually be deleted until you click the “Apply” button. A pop-up message will indicate that you have pending changes if you close User Manager without clicking “Apply”. If you change your mind, click “No” and the user account will not be deleted; otherwise, click “Yes” and the user will be deleted and User Manager will close.
The password for any user can be changed by first highlighting the user name then clicking the “Change Password” button. You will not be prompted for the old password in order to reset a user's password; this can be handy if a user has forgotten their password and can no longer log into the PC-BSD® system. If you click the “Change Admin Password” button, you can change the password that is used whenever you are prompted for administrative access.
Figure 8.8a: Viewing User Accounts in User Manager
If you click the “Advanced View” button, this screen will change to show all of the accounts on the system, not just the user accounts that you created. An example is seen in Figure 8.8b.
The accounts that you did not create are known as system accounts and are needed by the operating system or installed applications. You should not delete any accounts that you did not create yourself as doing so may cause a previously working application to stop working. Advanced View provides additional information associated with each account, such as the user ID number, full name (description), home directory, default shell, and primary group. System accounts usually have a shell of nologin for security reasons, meaning that an attacker can not try to login to the system using that account name.
Figure 8.8c shows the add user account creation screen that opens when you click the “Add” button.
NOTE: if you click the “Add” button while in Simple View, you will only be prompted to enter the username, full name, and password.
Figure 8.8b: Viewing All Accounts and Their Details
Figure 8.8c: Creating a New User Account
This screen is used to input the following information when adding a new user or system account:
Username: the name the user will use when they log in to the system; it is case sensitive and can not contain any spaces. If you are creating a system account needed by an application, use the name provided by the application's installation instructions. If the name that you choose already exists as an account, it will be highlighted in red and the utility will prompt you to use another name.
Full Name: this field provides a description of the account and can contain spaces. If it is a user account, use the person's first and last name. If it is a system account, input a description to remind you which application uses the account.
Home Directory: you can leave this field empty for a user account as the system will automatically create a home directory under /home/username. However, if you are creating a system account it is important to override this default by typing in /var/empty or /nonexistent unless the application's installation instructions specify that the account needs a specific home directory.
Shell: this drop-down menu contains the shells that are available to users when they are at a command prompt. You can either keep the default or select a shell which the user prefers.
Primary Group: if you leave the default button of “New Group” selected, a group will be created with the same name as the user. This is usually what you want unless you are creating a system account and the installation instructions specify a different group name. Note that the drop-down menu for specifying a group name will only show existing groups, but you can quickly create a group using the “Groups” tab.
Password: the password is case-sensitive and needs to be confirmed.
Once you have made your selections, press the “Ok” button to create the account.
If you click the “Groups” tab, you can view all of the groups on the system, as seen in Figure 8.8d.
Figure 8.8d: Managing Groups Using User Manager
This screen has 3 columns:
Groups: shows all of the groups on the system.
Available: shows all of the system and user accounts on the system in alphabetical order.
Members: indicates if the highlighted group contains any user accounts.
To add an account to a group, highlight the group name in the first column. Then, highlight the account name in the “Available” column. Click the right arrow and the selected account will appear in the “Members” column. You should only add user accounts to groups that you create yourself or when an application's installation instructions indicate that an account needs to be added to a group.
If you click the “Add” button, a pop-up menu will prompt you for the name of the new group. Once you press “OK”, the group will be added to the “Groups” column.
If you click the “Remove” button, the highlighted group will automatically be deleted after you press the “Apply” button, so be sure to do this with care. Again, do not remove any groups that you did not create yourself or applications that used to work may stop working.
8.9 Bluetooth Manager
PC-BSD® 9.1 introduces a Bluetooth Manager which can be used to configure Bluetooth device pairing (authentication) and provides a graphical front-end to support FreeBSD's hcsecd(8) daemon which controls the link keys and PIN codes which are used by Bluetooth pairing. FreeBSD supports all Bluetooth USB dongle devices that conform with Bluetooth specification v1.1. More information about FreeBSD's implementation can be found in the Bluetooth section of FreeBSD Handbook.
To launch Bluetooth Manager, either click its icon in Control Panel or type pc-su pc-bluetoothmanager. You will be prompted for the administrative password. If you plug in in a Bluetooth USB dongle device and click on the “New Devices” tab, it should be displayed as seen in the example in Figure 8.9a. If the device is not found, a message in the lower half of the screen will prompt you to put the device in discovery mode and then to rescan by clicking the “Scan” button.
Figure 8.9a: New Device Detected in Bluetooth Manager
If the device, such as a cell phone, requires a PIN key in order to access a service, use the “Saved Devices” tab to view and configure pairing. In the example shown in Figure 8.9b, the first three entries (Default, Dummy, and Dummy) are three FreeBSD sample entries and the fourth entry is for the inserted device. The sample entries are included as they provide examples of valid link keys and PIN codes. You can remove any entry by highlighting it and clicking the “Remove Device” button.
To modify an existing configuration, highlight the device and click the “Configure” button. In the screen shown in Figure .8.9c, input the PIN code required by the provider. The system will automatically generate the link key for you.
Figure 8.9b: Configure Bluetooth Pairing
Figure 8.9c: Input the PIN Code
If you wish to add the Bluetooth Manager to the system tray, type pc-su pc-bluetoothtray and input the administrative password. The Bluetooth tray icon will only automatically appear in the system tray if the USB dongle is plugged in when you log into the system.
Since the developers do not have access to every possible Bluetooth device, it is possible that your device will not be recognized. If this is the case, please take the time to send the details about the device to the testing mailing list so that the developers can work with you to fix the issue.
8.10 Mount Tray
The Mount Tray application is used to facilitate the mounting and unmounting of filesystems and USB storage devices. It is included in the system tray, meaning that in can be used within any window manager that provides a system tray. If you remove the icon from the system tray, you can re-add it using Control Panel ➜ Mount Tray or by typing pc-mounttray &.
8.10.1 Mounting USB Drives
To access the contents of a USB drive, insert the USB drive and click the “Mount Tray” icon in the system tray. You will see a screen similar to Figure 8.10a.
Figure 8.10a: Mount Tray After a USB Device Inserted
NOTE: if an entry for the USB device does not show in “Mount Tray”, click “Rescan Devices” and it should appear.
In this example, a USB thumb drive was inserted and detected while logged into the KDE desktop. Click the “Mount” button next to the “USB DISK” entry to mount that device. As the device mounts, the “Mount” button will change to an "Eject" button and the contents of the drive will be displayed in the default file manager for the desktop. A list of available file managers can be found here.
In this example, the dolphin file manager will open as it is the default KDE file manager. If the desktop does not provide a default file manager, “Mount Tray” will provide an “open with” dialogue so that you can select the utility to use to browse the contents of the USB device.
When you are finished using the device, click the “Eject” button to unmount the device. A pop-up message will indicate that the device has been unmounted and that it is now safe to remove the device. If
NOTE: do not physically remove the device without unmounting it first.
8.10.2 Accessing Data on Non-PCBSD Partitions
“Mount Tray” also detects any non-PC-BSD® partitions of internal drives. Table 1.4a lists which filesystems are supported by “Mount Tray”.
In the example shown in Figure 8.10a, this system is dual booting with Windows 7 on a Lenovo laptop. Windows 7 is using three partitions: one for the system drive, one for Lenovo recovery, and one containing the operating system. The Windows operating system drive has been mounted, meaning that its files can be viewed and modified while logged into PC-BSD®.
8.11 Sound Configuration
Beginning with PC-BSD® 9.1, a “Sound Configuration” icon is available which automatically determines which audio devices are available and provides a button to play a test sound. To access this utility, use Control Panel ➜ Sound Configuration or type pc-soundconfig.
An example of the “Sound Configuration” screen is shown in Figure 8.11a.
Figure 8.11a: Sound Configuration Utility
To determine which audio devices are available, click the drop-down menu. In the example shown in Figure 8.11b, this system has four available sound devices with the FreeBSD device names pcm0 to pcm3. The default device is the Conexant CX20590 on pcm2.
Figure 8.11b: Selecting the Audio Device
To change the default audio device, select the desired device from the drop-down menu and test that it works by clicking the “Test sound” button. To make the change permanent, click the “Apply” button.
If you connect a USB headset, PC-BSD® will detect the new device and will automatically change the audio device to the USB input. At this time, if you insert a headset into an audio jack, the system will not detect the new input so you will have to manually change the default device using “Sound Configuration”.
8.11.1 Troubleshooting Sound
If you are unable to get sound working using the sound configuration utility, you can try using mixer from the command line. As your regular user, type mixer to see your current settings:
mixer
Mixer vol is currently set to 0:0
Mixer pcm is currently set to 100:100
Mixer mic is currently set to 50:50
Mixer mix is currently set to 60:60
Mixer rec is currently set to 75:75
Mixer igain is currently set to 100:100
Mixer ogain is currently set to 100:100
If any of these settings are set to 0, set them to a higher value, by specifying the name of the mixer setting and a percentage value up to 100:
mixer vol 100
Setting the mixer vol from 0:0 to 100:100.
If you only get one or two mixer settings instead of the example output shown above, you need to change the default mixer channel. As the superuser, try this command:
sysctl -w hw.snd.default_unit=1
To see if that changed to the correct channel, type mixer again. If you still only have one or two mixer settings, try setting the sysctl value to 2, and if necessary, to 3.
Once you have all of the mixer settings and none are set to 0, your sound should work. If it still doesn't, these resources may help you to pinpoint the problem:
If you still have problems with sound, see the section on Finding Help to determine which help resources are available. When reporting your problem, include your version of PC-BSD® and the name of your sound card.
8.12 Display
Display wizard can be used to configure your video driver and display settings.
NOTE: if you have a newer NVIDIA card, double-check that the NVIDIA driver is installed in Control Panel ➜ System Manager ➜ System Packages ➜ Hardware-Drivers and install it if it is not already installed. NVIDIA drivers for older cards on 32-bit systems are automatically installed with PC-BSD®.
To access the display wizard, go to Control Panel ➜ Display or reboot the system and select “6 Run the Display Wizard” from the boot menu.
If you start the display wizard from Control Panel, you will receive the message shown in Figure 8.12a:
Figure 8.12a: Save Your Work Before Changing Display Settings
If you are not ready to reboot the system, press “No” and restart the Display wizard when you are ready. Once you select “Yes”, you will be prompted for the superuser password. The system will then reboot into the display wizard, shown in Figure 8.12b.
Figure 8.12b: Display Settings Wizard
This screen can be used to select the desired screen resolution, color depth, and video driver. If you select the “vesa” driver, it will always work but will provide sub-optimal performance. Click on the drop-down menu to select the driver that most closely matches your video card name.
You can also use the drop-down menus to change the screen resolution and color depth values. If the value you desire is not listed, it may be that the selected driver does not support that resolution or depth.
Advanced users can select their monitor's horizontal sync and vertical refresh rate in the “Advanced” tab, seen in Figure 8.12c.
Use caution and refer to your monitor's documentation if you make any changes here. If you are not sure what you are doing, leave the default values as-is.
If your computer is connected to two monitors, check the box “Enable Dual-Head support”.
When you are finished, click the “Apply” button for your settings to be tested. If anything goes wrong during testing, you should be taken back to the “Display Settings” screen so that you can try another setting. Once you are satisfied with the settings, click “Yes” when prompted to accept them.
Figure 8.12c: Advanced Tab of Display Settings
8.12.1 Desktop Effects, Compiz, and Compositing
To prevent problems with video cards that do not support them, desktop effects (used by KDE) and compiz or compositing (used by other window managers) are disabled by default. You can change this default if your video card supports desktop effects.
To enable desktop effects while logged into KDE, click Control Panel ➜ System Settings ➜ Desktop Effects to access the configuration screen shown in Figure 8.12d.
Check the box “Enable desktop effects at startup”. You can use the “All Effects” tab to get more information about each possible effect and to enable the effects that interest you.
If XFCE is installed, you can enable compositing from any logged in desktop. Go to Control Panel ➜ Window Manager Tweaks ➜ Compositor. If Window Manager Tweaks does not appear in the Control Panel menu, use the desktop selector drop-down menu to select "All" or "XFCE".
In the screen shown in Figure 8.12e, check the "Enable display compositing" box to enable the compositing options.
Figure 8.12d: Enabling Desktop Effects in KDE
Figure 8.12e: Enabling Compositing in XFCE
If you do not use KDE or XFCE, install Compiz instead using Control Panel ➜ System Manager ➜ System Packages ➜ Misc ➜ Compiz. Once installed, you can configure Compiz by clicking System ➜ Preferences ➜ CompizConfig Settings Manager while logged into GNOME or by typing ccsm from any desktop. This will open the screen shown in Figure 8.12f:
Figure 8.12f: Configuring Compiz
8.12.2 Troubleshooting
Until TTM is ported to PC-BSD®, ATI/Radeon video cards will not be fully supported. If the screen goes blank or otherwise does not work when you select the HD version of the driver, selecting the non-HD version should allow you to use the card. Radeon HD5xxx and higher GPUs have no support for acceleration, 2D or 3D. At this time, these video cards can only use the Vesa driver.
If you are having problems with your display settings and would like to manually edit /etc/X11/xorg.conf or run Xorg --config, first tell the PC-BSD® system to not automatically start X. You can temporarily stop your current X session and prevent additional sessions from starting by typing this command as the superuser:
/usr/local/etc/rc.d/gdm stop
This will drop you down to a console where you can try the instructions in the FreeBSD Handbook to manually configure and test Xorg. Once you have a configuration that works for you, save it to /etc/X11/xorg.conf, and restart gdm to test the configuration:
/usr/local/etc/rc.d/gdm start
If your graphics white-out after a suspend or resume, try running this command as the superuser:
sysctl hw.acpi.reset_video=1
If that fixes the problem, carefully add this line to /etc/sysctl.conf:
hw.acpi.reset_video=1
If the monitor goes blank and does not come back, try running this command as your regular user account:
xset -dpms
If that fixes the problem, add that line to the .xprofile file in your home directory.
8.13 Printing
Like many open source operating systems, PC-BSD® uses the Common Unix Printing System (CUPS) to manage printing. Control Panel provides a graphical front-end for adding and managing printers.
While the graphical utility is easy to use, it may or may not automatically detect your printer depending upon how well your printer is supported by an open source print driver. This section will walk you through a sample configuration for a HP PhotoSmart 3210 printer. Your printer may “just work”, allowing you to breeze through the configuration screens. If your printer configuration does not work, read this section more closely for hints on how to locate the correct driver for your printer.
8.13.1 Researching your Printer
Before configuring your printer, it is worth the time to see if a print driver exists for your particular model, and if so, which driver is recommended. If you are planning to purchase a printer, this is definitely good information to know beforehand. You can look up the vendor and model of the printer in the Open Printing Database which will indicate if the model is supported and if there are any known caveats with the print driver.
Figure 8.13a shows a search for our example printer. While the particular model is 3210, the closest driver is in the 3200 series.
Figure 8.13a: Using Open Printing Database to Locate a Driver
Once the model is selected, click on the “Show this printer” button to see the results, as demonstrated in Figure 8.13b.
For this model, the HPLIP driver is recommended and the printer is compatible to the HP DeskJet 990C. In PC-BSD®, the HPLIP driver is available as an optional system component. You can see if the driver is installed, and install it if it is not, using Control Panel ➜ System Manager ➜ System Packages ➜ Hardware-Drivers as seen in Figure 8.13c.
Figure 8.13b: Driver Recommendation from Open Printing Database
Figure 8.13c: Installing the HPLIP Driver
8.13.2 Adding a Printer
Once you know that your printer is supported, make sure that the printer is plugged into your computer or, if the printer is a network printer, that both your computer and the printer are connected to the network. Then, go to Control Panel ➜ Printing or type pc-su system-config-printer. Input the administrative password to see a window similar to Figure 8.13d:
Figure 8.13d: Printer Configuration Utility
To add a new printer, click New ➜ Printer. The printing utility will pause for a few seconds as as the wizard searches to see if any printers are connected to your computer or network. When it is finished, you should see a screen similar to Figure 8.13e.
Figure 8.13e: Select a Print Device
In this example, the wizard has found this printer and highlighted the entry for HP Photosmart 3200 (MY65BB21VW045K). The wizard should find any supported printer that is attached to the computer or network and list it as the highlighted entry in the “Devices” frame. If it does not automatically find your printer, read the section on Manually Adding a Driver.
If it finds your printer, simply click “Forward” to advance to the screen shown in Figure 8.13f.
Since the configuration wizard found the printer in the previous screen, the “Describe Printer” screen automatically fills out the printer model series, a description, and the hostname of your computer, if the printer is locally attached, or the hostname of the network printer. If you wish, you can change the printer's name or description. Once you click the “Apply” button, the wizard will ask if you would like to print a test page. Ensure the printer has paper and click Yes to print the test page. If you can not print a successful test page, see the Printer Troubleshooting section.
Once the printer is created, a screen will open where you can set the properties of the printer. Our sample printer's properties screen is shown in Figure 8.13g.
Figure 8.13f: Describe Printer Screen
Figure 8.13g: Viewing the Settings of the Newly Created Printer
You may wish to take a few minutes to review the settings in “Policies”, “Access Control”, “Printer Options”, and “Job Options” tabs as these allow you to configure options such as print banners, permissions, the default paper size, and double-sided printing. The available settings will vary, depending upon the capabilities of the print driver.
8.13.3 Manually Adding a Driver
If the print configuration wizard does not automatically list your printer, double-check that it is supported as described in the Researching your Printer section and that HPLIP is installed if it is a HP printer. Also check that the printer is plugged in and powered on.
You can also try to manually add your printer. In the “Select Device” screen (Figure 8.13e) you will need to highlight and configure the type of connection to the printer:
USB: this entry will only appear if a printer is plugged into a USB port and the number of entries will vary depending upon the number of USB ports on the system. If there are multiple USB entries, highlight the one that represents the USB port your printer is plugged into.
Other: this option allows you to manually type in the URI to the printer. A list of possible URIs is available on the cups site.
AppSocket/HP JetDirect: select this option if you are connecting to an HP network printer. You will need to input the IP address of the printer in the “Host” field. Only change the port number if the printer is using a port other than the default of 9100.
IPP: select this option if you are connecting to a printer cabled to another computer (typically running a Microsoft operating system) that is sharing the printer using IPP. You will need to input the IP address of the printer in the “Host” field and the name of the print queue. You can then click the “Verify” button to ensure that you can connect to the print queue.
LPD/LPR: select this option if you are connecting to a printer which is cabled to a Unix computer that is using LPD to share the printer. You will need to select the hostname and queue name from the drop-down menus.
After making your selection and clicking “Forward”, you will see the screen in Figure 8.13h.
Figure 8.13h: Manually Selecting a Driver
This screen provides three options for installing the driver. When selecting the driver, look for the one that was recommended by the Open Printing Database for your model.
Select printer from database: if you highlight the manufacturer name and click “Forward”, you will see a list of drivers to choose from. In the example shown in Figure 8.13i, the user has selected HP as the manufacturer. If you see the recommended driver, highlight it and click “Forward” to continue with the printer configuration. If you do not see the recommended driver, click the “Back” button and try option 2 or 3.
Provide PPD file: a PostScript Printer Description (PPD) is a driver created by the manufacturer that ends in a .ppd extension. Sometimes the file will end with a .ppd.gz extension, indicating that it has been compressed with gzip. If the driver you are looking for was not in the database, see if there is a PPD file on the driver CD that came with the printer or available for download from the manufacturer's website. If so, you can browse to the location of that file using the screen shown in Figure 8.13j, then click Forward to continue with the printer configuration.
Search for a printer driver to download: if you know the name of the driver that you are looking for, try typing its name or number into the “Search” box. If found, it will display in the “Printer” model drop-down menu.
Figure 8.13i: Selecting a Driver from the Database
Figure 8.13j: Selecting a PPD
8.13.4 Printer Troubleshooting
If you have followed the instructions in Adding a Printer but are unable to successfully print, you may find your answer here. Here are some solutions to common printing problems:
A test page prints but it is all garbled: this typically means that you are using the wrong driver. If your specific model was not listed, click the “Change” button in the “Driver Details” section of the “Settings” tab of the printer and try choosing another driver model that is close to your model number. If trial and error does not fix the problem, see if there are any suggestions for your model in the Open Printing database. A web search for the word freebsd followed by the printer model name may also help you to find the correct driver to use.
Nothing happens when you try to print: in this case, type tail -f /var/log/cups/error_log in a console and then print a test page. The error messages should appear in the console. If the solution is not obvious from the error messages, try a web search for the error message. If you are still stuck, post the error, the model of your printer, and your version of PC-BSD® to either the Hardware Support forum or the Support Mailing List.
8.14 Scanner
Beginning with PC-BSD® 9.1, Control Panel provides an icon for accessing XSane, a graphical utility for managing scanners.
To use your scanner, make sure the device is plugged into the PC-BSD® system and click the Scanner icon in Control Panel or type xsane from the command line. A pop-up message will indicate that XSane is detecting devices and will prompt you to accept the XSane license if a device is detected. If a device is not detected, search for your device at the list of supported scanners.
NOTE: if the scanner is part of an HP All-in-One device, make sure that HPLIP is first installed in Control Panel ➜ System Manager ➜ System Packages ➜ Hardware-Drivers.
Figure 8.14a shows the XSane interface running on a PC-BSD® system attached to an HP OfficeJet.
The XSane Documentation contains details on how to perform common tasks such as saving an image to a file, photocopying an image, and creating a fax. It also describes all of the icons in the interface and how to use them.
By default, XSane uses the default browser when you click F1 to access its built-in documentation. How to configure the default browser varies by window manager so you may need to do an Internet search if you need to set that configuration setting and can not find it.
Figure 8.14a: XSane Interface
8.15 Network Configuration
During installation, PC-BSD® configures your Ethernet interfaces to use DHCP and provides a post-install configuration screen to configure your wireless connection. In most cases, this means that your connected interfaces should “just work” whenever you use your PC-BSD® system.
For desktops that provide a system tray, a wireless configuration icon will appear if PC-BSD® detects a supported wireless card. If you hover over the wireless icon, shown in Figure 8.15a, it will indicate if the interface is associated and provide information regarding the IP address, IPv6 address, SSID, connection strength, connection speed, MAC address, and type of wireless device.
Figure 8.15a: Wireless Information in System Tray
If you right-click the wireless icon, you will see a list of detected wireless networks. Simply click the name of a network to associate with it. The right-click menu also provides options to configure the wireless device, start the Network Manager, restart the network (useful if you need to renew your DHCP address), and to close the Network Monitor so that the icon no longer shows in the system tray. If you have multiple wireless devices, each will have its own icon in the system tray. If you do not use one of the devices, click “Close the Network Monitor” to remove it from the tray.
To view or manually configure all of your network interfaces click Control Panel ➜ Network Configuration or type pc-su pc-netmanager. If a new device has been inserted (e.g. a USB wireless interface), a pop-up message will open when you start Network Configuration, indicate the name of the new device, and ask if you would like to enable it. Click “Yes” and the new device will be displayed with the list of network interfaces that PC-BSD® recognizes. In the example seen in Figure 8.15b, the system has one Realtek Ethernet interface that uses the em driver and a wireless interface that uses the wlan driver.
Figure 8.15b: Network Configuration Utility
The rest of this section describes each tab of the Network Configuration utility and demonstrate how to view and configure the network settings for both Ethernet and wireless devices. It will then present some common troubleshooting scenarios, known issues, and suggestions for when a device does not have a built-in driver.
8.15.1 Devices: Ethernet Adapters
If you highlight an Ethernet interface in the “Devices” tab and either click the “Configure” button or double-click the interface name, you will see the screen shown in Figure 8.15c.
Figure 8.15c: Network Settings for an Ethernet Interface
There are two ways to configure an Ethernet interface:
Use DHCP: this method assumes that your Internet provider or network assigns your addressing information automatically using the DHCP protocol. Most networks are already setup to do this. This method is recommended as it should “just work”.
Manually type in the IP addressing information: this method requires you to understand the basics of TCP/IP addressing or to know which IP address you should be using on your network. If you do not know which IP address or subnet mask to use, you will have to ask your Internet provider or network administrator.
By default, PC-BSD® will attempt to obtain an address from a DHCP server. If you wish to manually type in your IP address, check the box “Assign static IP address”. Type in the IP address, using the right arrow key or the mouse to move between octets. Then, double-check that the subnet mask (Netmask) is the correct value and change it if it is not.
If the Ethernet network uses 802.1x authentication, check the box “Enable WPA authentication” which will enable the “Configure WPA” button. Click this button to select the network and to input the authentication values required by the network.
By default, the “Disable this network device” box is unchecked. If you check this checkbox, PC-BSD® will immediately stop the interface from using the network. The interface will remain inactive until this checkbox is unchecked.
The “Advanced” tab, seen in Figure 8.15d, allows advanced users to change their MAC address and to use DHCP to automatically obtain an IPv6 address. Both boxes should remain checked unless you are an advanced user who has a reason to change the default MAC or IPv6 address and you understand how to input an appropriate replacement address.
Figure 8.15d: Advanced Tab of an Ethernet Interface's Network Settings
The “Info” tab, seen in Figure 8.15e, will display the current network address settings and some traffic statistics.
Figure 8.15e: Info Tab of an Ethernet Interface's Network Settings
If you make any changes within any of the tabs, click the “Apply” button to activate them. Click the “OK” button when you are finished to go back to the main Network Configuration window.
You can repeat this procedure for each network interface that you wish to view or configure.
8.15.2 Devices: Wireless Adapters
If your wireless interface does not automatically associate with a wireless network, you probably need to configure a wireless profile that contains the security settings required by the wireless network. Double-click the wireless icon in the system tray or highlight the wireless interface displayed in the “Devices” tab of Network Configuration and click the “Configure” button. Figure 8.15f demonstrates that this system's wireless interface is currently not associated with any wireless networks as none are listed in the “Configured Network Profiles” section.
To associate with a wireless network, click the “Scan” button to receive the list of possible wireless networks to connect to. Highlight the network you wish to associate with and click the “Add Selected” button. If the network requires authentication, a pop-up window will prompt you for the authentication details. Input the values required by the network then click the “Close” button. PC-BSD® will add an entry for the network in the “Configured Network Profiles” section.
If the network is hidden, click the “Add Hidden” button, input the name of the network in the pop-up window, and click “OK”.
If you add multiple networks, use the arrow keys to place them in the desired connection order. PC-BSD® will try to connect to the first profile in the list and will move down the list in order if it is unable to connect. When finished, click the “Apply” button. A pop-up message will indicate that PC-BSD® is restarting the network. If all went well, there should be an IP address and status of “associated” when you hover over the wireless icon in the system tray. If this is not the case, double-check for typos in your configuration values and read the section on Troubleshooting Network Settings.
Figure 8.15f: Wireless Configuration Window of Network Configuration Utility
PC-BSD® supports the types of authentication shown in Figure 8.15g. You can access this screen (and change your authentication settings) by highlighting an entry in the “Configured Network Profiles” section and clicking the “Edit” button.
Figure 8.15g: Configuring Wireless Authentication Settings
This screen allows you to configure the following types of wireless security:
Disabled: if the network is open, no additional configuration is required.
WEP: this type of network can be configured to use either a hex or a plaintext key. If you click WEP then the “Configure” button, you will see the screen shown in Figure 8.15h. Type the key into both network key boxes. If the key is complex, check the “Show Key” box to make sure that the passwords are correct and that they match. Uncheck this box when you are finished to replace the characters in the key with the * symbol. A wireless access point that uses WEP can store up to 4 keys; the number in the key index indicates which key you wish to use.
WPA Personal: this type of network uses a plaintext key. If you click WPA Personal then the “Configure” button, you will see the screen shown in Figure 8.15i. Type in the key twice to verify it. If the key is complex, you can check the “Show Key” box to make sure the passwords match.
WPA Enterprise: if you click WPA Enterprise then the “Configure” button, you will see the screen shown in Figure 8.15j. Select the authentication method (EAP-TLS, EAP-TTLS, or EAP-PEAP), input the EAP identity, browse for the CA certificate, client certificate and private key file, and input and verify the password.
NOTE: if you are unsure which type of encryption is being used, ask the person who setup the wireless router. They should also be able to give you the value of any of the settings seen in these configuration screens.
Figure 8.15h: WEP Security Settings
Figure 8.15i: WPA Personal Security Settings
Figure 8.15j: WPA Enterprise Security Settings
If you wish to disable this wireless interface, check the box “Disable this wireless device”. This setting can be desirable if you want to temporarily prevent the wireless interface from connecting to untrusted wireless networks.
The “Advanced” tab, seen in Figure 8.15k, allows you to configure the following:
a custom MAC address. This setting is for advanced users and requires the “Use hardware default MAC address” box to be unchecked.
how the interface receives its IP address information. If the network contains a DHCP server, check the box “Obtain IP automatically (DHCP)”. Otherwise, input the IP address and subnet mask to use on the network.
the country code. This setting is not required if you are in North America. For other countries, check the “Set Country Code” box and select your country from the drop-down menu.
Figure 8.15k: Advanced Tab of a Wireless Interface
The “Info” tab, seen in Figure 8.15l, shows the current network status and statistics for the wireless interface.
Figure 8.15l: Info Tab of a Wireless Interface
8.15.3 Network Configuration (Advanced)
The “Network Configuration (Advanced)” tab of the Network Configuration utility is seen in Figure 8.15m. The displayed information is for the currently highlighted interface. If you wish to edit these settings, make sure that the interface that you wish to configure is highlighted in the “Devices” tab.
Figure 8.15m: Network Configuration (Advanced) tab of the Network Configuration Utility
If the interface receives its IP address information from a DHCP server, this screen allows you to view the received DNS information. If you wish to override the default DNS settings or set them manually, check the “Enable Custom DNS” box. You can then set the following:
DNS 1: the IP address of the primary DNS server. If you do not know which IP address to use, click the “Public servers” button to select a public DNS server.
DNS 2: the IP address of the secondary DNS server.
Search Domain: the name of the domain served by the DNS server.
If you wish to change or set the default gateway, check the “Enable Custom Gateway” box and input the IP address of the default gateway.
The following settings can be modified in the IPv6 section:
Enable IPv6 support: if this box is checked, the specified interface can participate in IPv6 networks.
IPv6 gateway: the IPv6 address of the default gateway used on the IPv6 network.
IPv6 DNS 1: the IPv6 address of the primary DNS server used on the IPv6 network. If you do not know which IP address to use, click the “Public servers” button to select a public DNS server.
IPv6 DNS 2: the IPv6 address of the secondary DNS server used on the IPv6 network.
The “Misc” section allows you to configure these options:
System Hostname: the name of your computer. It must be unique on your network.
Enable wireless/wired failover via lagg0 interface: the lagg interface allows you to seamlessly switch between using an Ethernet interface and a wireless interface. If you want this functionality, check this box.
NOTE: some users experience problems using lagg. If you have problems connecting to a network using an interface that previously worked, uncheck this box and remove any references to “lagg” in your /etc/rc.conf file.
If you make any changes within this window, click the “Save” button to apply them.
8.15.4 Proxy Settings
The “Proxy” tab, shown in Figure 8.15n, is used when your network requires you to go through a proxy server in order to access the Internet.
Figure 8.15n: Proxy Settings Configuration
Check the “Proxy Configuration” check box to activate the settings. The follow settings can be configured in this screen:
Server Address: enter the IP address or hostname of the proxy server.
Port Number: enter the port number used to connect to the proxy server.
Proxy Type: choices are “Basic” (sends the username and password unencrypted to the server) and “Digest” (never transfers the actual password across the network, but instead uses it to encrypt a value sent from the server). Do not select “Digest” unless you know that the proxy server supports it.
Specify a Username/Password: check this box and input the username and password if they are required to connect to the proxy server.
Proxy settings are saved to the /etc/profile and /etc/csh.cshrc files so that they are available to the PC-BSD® utilities as well as any application that uses fetch.
Applications that did not come with the operating system, such as web browsers, may require you to configure proxy support using that application's configuration utility.
8.15.5 Troubleshooting Network Settings
While Ethernet networking usually “just works” on a PC-BSD® system, users sometimes encounter problems, especially when connecting to wireless networks. Sometimes the problem is due to a configuration error; sometimes a driver is buggy or is not yet available. This section is meant to help you pinpoint the problem so that you can either fix it yourself or give the developers the information they need to fix or create the driver.
8.15.5.1 Useful Files and Commands
When troubleshooting your network configuration, use the following files and commands:
/etc/rc.conf
This file is read when the system boots up. In order for the system to configure an interface at boot time, an entry must exist for it in this file. Entries are automatically created for you during installation for each interface that is active. An entry will be added (if it does not exist) or modified (if it already exists) when you configure an interface using the Network Configuration utility.
Here is an example of the rc.conf entries for an ethernet driver (em0) and a wireless driver (run0):
ifconfig_em0="DHCP"
wlans_run0="wlan0"
ifconfig_wlan0="WPA SYNCDHCP"
When reading through your own file, look for lines that begin with ifconfig. For a wireless interface, also look for lines containing wlans.
NOTE: unlike Linux interface driver names, FreeBSD/PC-BSD® interface driver names indicate the type of chipset. Each driver name has an associated man page where you can learn which devices use that chipset and if there are any configuration options or limitations for the driver. When reading the man page, do not include the interface number. In the above example, you could read man em and man run.
/etc/wpa_supplicant.conf
This file is used by wireless interfaces and contains the information needed to connect to a WPA network. If this file does not already exist, it is created for you when you enter the “Configuration” screen of a wireless interface.
ifconfig
This command shows the current state of your interfaces. When reading through its output, check that your interface is listed, has a status of “active”, and has an IP address. Here is a sample ifconfig output showing the entries for the re0 Ethernet interface and the run0 wireless interface:
re0: flags=8843<UP,BROADCAST,RUNNING,SIMPLEX,MULTICAST> metric 0 mtu 1500
options=389b<RXCSUM,TXCSUM,VLAN_MTU,VLAN_HWTAGGING,VLAN_HWCSUM,WOL_UCAST,WOL_MCAST,WOL_MAGIC>
ether 60:eb:69:0b:dd:4d
inet 192.168.1.3 netmask 0xffffff00 broadcast 192.168.1.255
media: Ethernet autoselect (100baseTX <full-duplex>)
status: active
run0: flags=8843<UP,BROADCAST,RUNNING,SIMPLEX,MULTICAST> metric 0 mtu 2290
ether 00:25:9c:9f:a2:30
media: IEEE 802.11 Wireless Ethernet autoselect mode 11g
status: associated
wlan0: flags=8843<UP,BROADCAST,RUNNING,SIMPLEX,MULTICAST> metric 0 mtu 1500
ether 00:25:9c:9f:a2:30
media: IEEE 802.11 Wireless Ethernet autoselect (autoselect)
status: no carrier
ssid "" channel 10 (2457 MHz 11g)
country US authmode WPA1+WPA2/802.11i privacy ON deftxkey UNDEF
txpower 0 bmiss 7 scanvalid 60 protmode CTS wme roaming MANUAL
bintval 0
In this example, the ethernet interface (re0) is active and has an IP address. However, the wireless interface (run0, which is associated with wlan0) has a status of “no carrier” and does not have an IP address. In other words, it has not yet successfully connected to the wireless network.
dmesg
This command lists the hardware that was probed during boot time and will indicate if the associated driver was loaded. If you wish to search the output of this command for specific information, pipe it to grep as seen in the following examples:
dmesg | grep Ethernet
re0: <RealTek 8168/8111 B/C/CP/D/DP/E PCIe Gigabit Ethernet> port 0xc000-0xc0ff mem 0xd0204000-0xd0204fff,0xd0200000-0xd0203fff irq 17 at device 0.0 on pci8
re0: Ethernet address: 60:eb:69:0b:dd:4d
dmesg |grep re0
re0: <RealTek 8168/8111 B/C/CP/D/DP/E PCIe Gigabit Ethernet> port 0xc000-0xc0ff mem 0xd0204000-0xd0204fff,0xd0200000-0xd0203fff irq 17 at device 0.0 on pci8
re0: Using 1 MSI messages
re0: Chip rev. 0x28000000
re0: MAC rev. 0x00000000
miibus0: <MII bus> on re0
re0: Ethernet address: 60:eb:69:0b:dd:4d
re0: [FILTER]
re0: link state changed to DOWN
re0: link state changed to UP
dmesg | grep run0
run0: <1.0> on usbus3
run0: MAC/BBP RT3070 (rev 0x0201), RF RT2020 (MIMO 1T1R), address 00:25:9c:9f:a2:30
run0: firmware RT2870 loaded
pciconf
If your interface does not show up in ifconfig or dmesg, it is possible that a driver for this card is not provided with the operating system. If the interface is built into the motherboard of the computer, you can use the pciconf command to find out the type of card.
pciconf -lv | grep Ethernet
device = 'Gigabit Ethernet NIC(NDIS 6.0) (RTL8168/8111/8111c)'
pciconf -lv | grep wireless
device = 'Realtek RTL8191SE wireless LAN 802.11N PCI-E NIC (RTL8191SE?)'
In this example, there is a built-in Ethernet device that uses a driver that supports the RTL8168/8111/8111c chipsets. As we saw earlier, that driver is re0. The built-in wireless device was also found but the ? indicates that a driver for the RTL8191SE chipset was not found. A web search for “FreeBSD RTL8191SE” will give an indication of whether a driver exists (perhaps in a version of FreeBSD that has not been released yet) or if a driver is being developed. You can also use a web search to locate a Windows driver and try using the ndisgen command, as described on this testing page, to convert it to a FreeBSD driver.
The FreeBSD Handbook chapter on Wireless Networking provides a good overview of how wireless works and offers some troubleshooting suggestions.
8.15.6 If a Driver Does Not Exist
If a FreeBSD driver does not exist for your wireless card, you may be able to convert a Windows driver to a FreeBSD kernel module using the instructions on the Wireless Testing page. If your chipset is not listed in Table 1 of that page, please add an entry indicating whether or not you were able to successfully convert and use the driver for your architecture.
If you are still unable to get your network interface to work, see the section on Finding Help. When describing your problem, include the following information:
the version and architecture of PC-BSD® you are using (e.g. PC-BSD® 9.1, 64-bit)
the name of the chipset used by the interface
the applicable entries in /etc/rc.conf
if you include the /etc/wpa_supplicant.conf for your wireless adapter, sanitize the psk value so you do not tell the world what the password is on your wireless network (e.g. replace the actual password with ***** or something similar)
8.15.7 Known Issues
The bge(4) Ethernet driver has a known issue where the interface is seen but does not respond to networking requests. Carefully adding this line to /boot/loader.conf and rebooting should solve this issue.
hw.pci.enable_msi="0"
PC-BSD® uses the PF firewall to protect your system. By default, the firewall is configured to let your system make Internet connections, use the ping utility, and to communicate with other Windows and Unix-like systems using SMB and NFS.
Advanced users who are already familiar with pf will find the default rulebase in /etc/pf.conf. Users who are not familiar with directly editing this file can instead use the Firewall Manager GUI utility to view and modify the existing firewall rules.
NOTE: typically it is not necessary to change the firewall rules. You should not remove any existing rules unless you fully understand what the rule does. Similarly, you should only add rules if you understand the security implications of doing so, especially if the rule allows connections to your computer.
To access the Firewall Manager, go to Control Panel ➜ Firewall Manager or type pc-su pc-pfmanager. You will be prompted to input the administrative password. Figure 8.16a shows the initial screen when you launch this utility:
Figure 8.16a: Firewall Manager Utility
The “General Settings” tab of this utility allows you to:
determine whether or not the firewall starts when the system boots; unless you have a reason to do so and understand the security implications, this box should be so that your system is protected by the firewall
start, stop, or restart the firewall: if you add, delete, or modify a firewall rule, restart the firewall for your changes to take effect
restore default configuration: this button allows you to return to the original, working configuration should you not like the changes you make to your firewall rules
To view or modify the firewall rules, click on the “Exceptions” tab, seen in Figure 8.16b.
In this example, the user has clicked on the “Add entry” button to add a new firewall rule. The following information is needed when creating a rule:
Service or Port: you can either select the name of the service you wish to allow or block from the drop-down menu or type in the number of the port used by the service. Which you choose does not matter as the firewall will match the name and number for you and display both after you save the rule.
Policy: you need to choose whether to allow or block this service/port.
Direction: use the drop-down menu to determine whether the policy applies to incoming or outgoing connections. The direction is from the perspective of your computer. Do you want others to connect to your service (incoming) or do you want to connect to the service running on another system (outgoing).
Protocol: use the drop-down menu to select whether the service uses the TCP or UDP protocol.
Interface: use the drop-down menu to select the interface that will make or receive the connection.
Once you have made your selections, press “Ok” to save the new rule.
Figure 8.16b: Adding a New Firewall Rule
NOTE: the new rule will not be used by the firewall until the firewall is restarted by clicking the “Restart” button in the “General” tab.
Test that your new rule(s) work as expected. For example, if you create a rule to allow an SSH connection, try connecting to your PC-BSD® system using SSH to verify that the firewall is now allowing the connection.
8.17 Adobe Flash Player Preferences
This utility allows for changes to various configuration settings related to Adobe Flash. Many of the same configurations can be done via right-click within an active flash object in a web browser.
To access the utility shown in Figure 8.17a, use Control Panel ➜ Adobe Flash Player preferences or type flash-player-properties.
Figure 8.17a: Flash Player Configuration Utility
The options available in each tab and when to use them are described at the Adobe website:
Storage: describes private browsing support and the privacy issues associated with local storage of flash information.
Camera and Mic: controls how websites can use your computer’s camera and microphone.
Playback: describes how to configure peer-assisted networking to improve bandwidth.
Advanced: controls how Flash Player handles browsing data, updates, trusted locations, and protected content.
8.18 Life Preserver
The built-in Life Preserver utility allows you to automate backups of of /usr/home/ which contains the home directory for each user account created on the PC-BSD® system Backups are stored on a remote system; for the purposes of this section, we will refer to the remote system as a backup server. Life Preserver uses SSH and rsync, meaning that the backup server must have SSH and rsync installed. If the backup server is another PC-BSD® system, these are already installed and configured for you. If the remote system is running another operating system, you will have to ensure that SSH and rsync are installed and that SSH is listening for connections. Regardless of the operating system on the backup server, you will need to open TCP ports 22 and 873 using the firewall software installed on the backup server.
NOTE: you can also use FreeNAS®, an open source NAS solution based on FreeBSD, as the backup server. Instructions for configuring FreeNAS® to accept Life Preserver backups can be found in the September 2011 issue of BSD Magazine.
Life Preserver is not the only way to make a backup. For example, you may find it easier to drag and drop the files/directories that you wish to backup to an external device, such as a USB drive, using one of the file manager utilities listed File Managers. You can also find a few PBIs of backup utilities using AppCafe®. The advantage of Life Preserver is that it allows you to easily schedule backups of your home directory to a backup server.
8.18.1 Creating a Backup Schedule
A shortcut to the Life Preserver utility, seen in Figure 8.18a, can be found in the system tray. This icon is animated and will indicate when a backup is taking place.
Figure 8.18a: Life Preserver Icon in System Tray
If you right-click the icon, the menu provides options to minimize (if the Life Preserver window is open), to perform a restore (if a backup exists), to start Life Preserver whenever the current user logs in, or to quit (remove the icon from the tray).
To start the backup wizard shown in Figure 8.18b, double-click the icon, or click Control Panel ➜ Life Preserver, or type life-preserver at the command line.
Once you click the “Get Started” button, the “Add New Life Preserver” wizard will launch, allowing you to configure a backup. Click “Next” to see the screen in Figure 8.18c.
Figure 8.18b: Life Preserver Welcome Screen
Figure 8.18c: Remote Device Configuration Screen
You will need to input the following information:
Host Name: of the remote system that will store your backup. If the backup server is on your local network, the host name must be in your hosts file or in the database of the local DNS server. You may find it easier to instead input the IP address of the backup server as this will eliminate any host name resolution problems.
User Name: this user must have permission to log in to the system that will hold the backup. If the account does not already exist, you should create it first on the backup server.
SSH Port: port 22, the default port used by SSH is selected for you. You only need to change this if the remote system is using a non-standard port to listen for SSH connections. In that case, use the up/down arrows or type in the port number.
NOTE: if there is a firewall protecting the remote system, make sure that it allows connections to the specified port number from the IP address of the system that you wish to backup. If the backup server is running PC-BSD®, you can use Firewall Manager to add an entry for SSH.
Once you click the “Next” button, you can decide whether or not to schedule regular backups, as seen in Figure 8.18d.
Figure 8.18d: Selection Screen to Automate Backups and Determine Their Frequency
By default, automatic backups are disabled, meaning you will have to manually start a backup when you wish to do so. If you decide to automate backups, you can choose to backup daily or weekly. After making your selection, click “Next” and you will see the informational message in Figure 8.18e:
Figure 8.18e: Life Preserver is Now Ready to Test the Connection to the SSH Server
Click the “Finish” button and a terminal will open where you can enter the password for the user account you specified, as seen in the example in Figure 8.18f.
Figure 8.18f: Logging into the SSH Server
If this is the first time using SSH to connect to this host, you will have to type yes to accept the RSA key fingerprint before being prompted to type in the password. If the connection is successful, the terminal will close and your new preserver will be listed in the main panel, shown in Figure 8.18g:
Figure 8.18g: Life Preserver Shows a New Preserver
The entry contains the following information:
Backup Server: will indicate the user account and IP address of the backup server.
Last Backup: will indicate whether or not there is a last backup and if there is a successful backup, the time and date of that backup. If you chose to automate backups, the first backup will happen immediately. Otherwise, a backup will not occur until you press the “Start” button. How long the first backup takes depends upon the size of your home directory and the speed of your network. If the backup is unsuccessful, logs can be found in /usr/local/share/lifePreserver/preservers/ <preserver_name>/logs/. This post explains the meaning of the various characters found in the logs.
Frequency: will indicate “disabled”, “daily”, or “weekly”.
Status: Running… indicates that the backup is occurring now, otherwise it will show as Not running.
The backup will be stored on the remote system in the home directory of the user that was used by Life Preserver to login. The contents of the backup will be found in the life-preserver/<backup>/ subdirectory where <backup> is named according to the date and time stamp of the backup. The contents of the directory will mirror the directory structure of your home directory, making it very easy to find and restore individual files or directories from the backup server to your PC-BSD® system.
8.18.2 Configuration Options
If you right-click a preserver and select “Edit”, you will see the configuration screen shown in Figure 8.18h.
Figure 8.18h: Life Preserver Configuration Options
This screen allows you to configure the following:
Number of backups to keep: make sure that there is enough disk space on the backup server to store this amount of backups. If you do daily backups, a setting of 7 will keep a week's worth. If you do weekly backups, a setting of 4 or 5 will keep about a month's worth.
Remove incomplete or failed backups: by default, Life Preserver attempts to conserve disk space on the backup server by removing any failed backups. Uncheck this box if you are troubleshooting Life Preserver.
Disable automatic backups: if this is selected, a backup will only occur when you manually press the “Start” button.
Backup daily: if this is selected, a backup will occur once per day.
Backup weekly: if this is selected, a backup will occur once per week.
Remote directory: a subdirectory with the name you specify will be created in the home directory of the user that logs in to the SSH server. This is the location where backups will be stored. The default subdirectory name is life-preserver.
Modify include list: provides a graphical List Editor, seen in Figure 8.18i, for adding files/directories to include in the backup.
Modify exclude list: opens the List Editor in order to add the files/directories to exclude from backups.
Figure 8.18i: Using List Editor to Modify the Include List
When using List Editor, it will indicate whether or not you are editing the include or the exclude list. Use the browse button to select the files or directories that you wish to include or exclude. Alternately, you can type in a wildcard. For example, to select all files ending in the .txt extension, input *.txt.
8.18.3 Restoring a Backup
To restore files from a backup, right-click the preserver entry and select “Restore From”. Life Preserver will query the backup server and show a list of available backups as seen in the example in Figure 8.18j:
Figure 8.18j: Selecting a Backup from the List of Available Backups
When reading the backup name, the number before the “T” is the date in YYYY-MM-DD format and the number after the T is the date stamp in HH_MM_SS format. Highlight the backup you wish to restore and click the “Select Backup” button to open the window seen in Figure 8.18k:
Figure 8.18k: Selecting the Files to Restore
If you wish to restore an individual file or directory, input its full path. In the example shown in Figure 8.17k, the user is restoring the directory /usr/home/dru/Documents--in other words, the Documents subfolder backed up from the home directory of the user named dru.
If you just input the name of the file or directory and click the “Restore” button, it will be restored to its original location and replace any files with the same name at that location.
If you instead check the “Restore Relative to specified directory” box, the selected file/directory will be restored to the location you specify.
8.19 Warden®
Warden® is an easy to use, graphical jail management program. Using Warden®, it is possible to create multiple, isolated virtual instances of FreeBSD which can be used to run services such as Apache, PHP, or MySQL in a secure manner. Each jail is considered to be a unique FreeBSD operating system and whatever happens in that jail will not affect your operating system or other jails running on the PC-BSD® system.
Warden® has been redesigned for PC-BSD® 9.1, and is now part of Control Panel. A command line version is also available for those who prefer to work from the command line or script their jail management.
Some of the new features in Warden® include the ability to:
create three types of jails: a traditional FreeBSD jail for running network services, a (less secure) ports jail for safely installing and running FreeBSD ports/packages from your PC-BSD® system, and a Linux jail for installing Linux
set multiple IPv4 and IPv6 addresses per jail
quickly install meta-packages of common network server applications on a per-jail basis
use Update Manager for installed meta-packages on a per-jail basis
use User Manager to manage user accounts on a per-jail basis
manage ZFS snapshots on a per-jail basis if the PC-BSD® system is formatted with the ZFS filesystem
export a jail which can be then be imported into the same or a different jail
8.19.1 Creating a Jail using Warden®
Warden® can be started by clicking on its icon in Control Panel or by typing pc-su warden gui from the command line. You will be prompted for the adminstrative password as only the superuser can create and manage jails.
The first time you start Warden®, you will be prompted to set the network interface as your jails will not work if the wrong interface is configured. . Click Yes to set the interface using the screen shown in Figure 8.19a. You can access this screen at a later time from Jails ➜ Configuration.
Figure 8.19a: Warden® Configuration
This screen allows you to configure the following:
Jail Network Interface: all jails created within Warden® share the same physical interface. Use the drop-down menu to select the network interface to be used by the jails.
Jail Directory: contains all of the created jails where each jail has its own sub-directory named after its IP address. By default, it is /usr/jails. If you change this directory, make sure the location has sufficient space to hold the jails.
Temp Directory: used when exporting and importing jails. Make sure that the directory has sufficient space to create a tar file of the jail and its contents.
Once you click the “Save” button to save your interface configuration, you will be presented with the main Warden® configuration screen, shown in Figure 8.19b.
To create your first jail, click the + button or go to File ➜ New Jail. A jail creation wizard, seen in Figure 8.19c, will launch.
Figure 8.19b: Initial Warden® Screen
Figure 8.19c: Creating the New Jail
The first screen in the jail creation wizard will prompt you for the following information:
IP Address: input the IPv4 or IPv6 address to be used by the jail and access its contents. Choose an address on your network that is not already in use by another computer or jail and which will not conflict with the address range assigned by a DHCP server.
Hostname: you can change the default of “Jailbird” to another value. The hostname must be unique on your network. Use a hostname that reminds you of the type of jail and your reason for creating it.
When finished, click “Next” to select the type of jail, as shown in Figure 8.19d:
Figure 8.19d: Select the Type of Jail
There are three types of jails supported by Warden®:
Traditional Jail: select this type if you are creating the jail in order to install and run network services. For example, this type of jail is appropriate if you wish to run a web server or a database which is accessible to other systems on a network or over the Internet. This is the most secure type of jail as it is separate from the PC-BSD® host and any other jails that you create using Warden®.
Ports Jail: select this type of jail if your intention is to install software using FreeBSD packages and ports and you wish to have access to that software from your PC-BSD® system. This type of jail is less secure then a traditional jail as applications are shared between the jail and the PC-BSD® system. This means that you should not use this type of jail to install services that will be available to other machines over a network.
Linux Jail: select this type of jail if you would like to install a Linux operating system within a jail.
The remaining screens will differ depending upon the type of jail that you select.
8.19.1.1 Traditional or Ports Jail
If you select “Traditional Jail”, you will be prompted to set the root password as seen in Figure 8.19e.
Input and confirm the password then press “Next” to see the screen shown in Figure 8.19f. If you instead select to create a “Ports Jail”, you will go directly to Figure 8.19f.
Figure 8.19e: Setting the Traditional Jail's Root Password
Figure 8.19f: Select the Jail Options
This screen allows you to install the following options:
Include system source: if you check this box, make sure that /usr/src/ exists on the PC-BSD system as the source is copied to the jail from this location. If it is not installed, use Control Panel ➜ System Manager ➜ Tasks ➜ Fetch System Source to install it.
Include ports tree: if you check this box, the latest version of the ports tree will be downloaded into /usr/ports/ of the jail. This will allow you to compile FreeBSD ports within this jail.
Start jail at system bootup: if this box is checked, the jail will be started (become available) whenever you boot your main system. If the box is not checked, you can manually start the jail whenever you wish to access it using Warden®.
Once you have made your selections, click the “Finish” button to create the jail. Warden® will display a pop-up window containing status messages as it downloads the files it needs and creates and configures the new jail.
Once Warden® is finished creating the jail, a message should appear at the bottom of the pop-up window indicating that the jail has been successfully created. Click the “Close” button to return to the main screen.
8.19.1.2 Linux Jail
If you select the “Linux Jail” and click “Next”, you will be prompted to set the root password as seen in Figure 8.19e. After inputting the password, the wizard will prompt you to select a Linux install script, as seen in Figure 8.19g.
Figure 8.19g: Select the Linux Distribution to Install
The installation script is used to install the specified Linux distribution. At this time, installation scripts for Debian Squeeze and for Gentoo are provided. Scripts for other distros will be added over time.
NOTE: a Linux installation script is simply a shell script which invokes a Linux network installation. In the case of Debian Squeeze, it invokes the debootstrap command.
Once you select the install script, the wizard will ask if you would like to start the jail at boot time as seen in Figure 8.19h.
Figure 8.19h: Linux Jail Options
Click the “Finish” button to begin the Linux installation.
8.19.2 Managing Jails
Once a jail is created, an entry for the jail will be added to the “Installed Jails” box and the tabs within Warden® will become available. Each entry indicates the jail's IP address, hostname, whether or not it is currently running, and whether or not any updates are available for the meta-packages installed within the jail. The buttons beneath the “Installed Jails” box can be used to start or stop the highlighted jail, add a new jail, or delete the highlighted jail.
This section provides an overview of how to manage jails using the tabs within the Warden® interface.
8.19.2.1 Info Tab
The “Info” tab, as seen in the example in Figure 8.19i, provides an overview of a jail's configuration. If you have created multiple jails, the “Info” tab displays the configuration of the currently highlighted jail.
In the example shown in Figure 8.18i, three jails have been created. The first jail is a traditional jail, the second is a ports jail, and Debian Squeeze has been installed into the third jail.
Figure 8.19i: Info Tab of Warden®
The “Info” tab contains the following information:
Jail Type: will indicate if the jail is a Traditional, Ports, or Linux jail.
Size on Disk: indicates the amount of space being used by the jail. The jail itself takes up about 300MB of space, source is about 300MB, and ports are about 850MB.
Start at boot: a status of “Enabled” indicates that the jail will automatically start when the system reboots. “Disabled” means that you will manually start the jail as needed.
Active Connections: will list the number of active connections to the jail (e.g. through ssh or one of the running services).
Additional IPs: click the “edit” link if you would like to bind additional IP addresses to the jail.
Listening on Ports: indicates which ports are currently listening for connections.
You can sort the jail listing by clicking on the “Jail”, “Hostname”, “Status”, or “Updates” header name. The “Updates” column will indicate if a software or system update is available for a jail.
8.19.2.2 Tools Tab
The “Tools” tab, shown in Figure 8.19j, allows you to manage common configuration tasks within a jail.
NOTE: make sure that the desired jail is highlighted when using the “Tools” tab.
Figure 8.19j: Tools Tab for the Highlighted Jail
This tab provides the following buttons:
User Administrator: opens User Manager so that you can manage the highlighted jail's user accounts and groups. The title bar will indicate that you are “Editing Users for Jail: IP_of_Jail”. Note that any users and groups that you have created on your PC-BSD® system will not be added to a traditional jail as each traditional jail has its own users and groups. However, a ports jail has access to the users and groups that exist on the PC-BSD® system, yet the users you create on a ports jail will only be available within the ports jail. This button is not available if a Linux jail is highlighted.
Service Manager: opens Service Manager so that you can view which services are running in the jail and configure which services should start when the jail is started. Note that this button is not available if a Linux jail is highlighted.
Launch Terminal: opens a terminal with the root user logged into the jail. This allows you to administer the jail from the command line. This button will be greyed out if the highlighted jail is not running. You can start a jail by right-clicking its entry and selecting “Start Jail” from the menu or by clicking the start jail icon (a blue arrow icon below the list of jails).
Check for Updates: launches Update Manager to determine if any of the jail's meta-packages have newer versions available. Update Manager will also indicate if system updates are available to be installed into the jail. Note that this button is not available if a Linux jail is highlighted. By default, Update Manager automatically checks for updates every 12 hours to see if there are any system updates or if any of the applications installed using the “Packages” tab within a ports or traditional jail have newer versions. If an update is found, the text “Updates available!” will appear in the “Updates” column for that jail.
Export Jail: launches a pop-up window prompting you to choose the directory in which to save a backup of the jail (and all of its software, configuration, and files) as a .wdn file. Creating the .wdn file may take some time, especially if you have installed src, ports, or software.
8.19.2.3 Snapshots Tab
If you chose to use the ZFS filesystem when you installed PC-BSD®, you can use its snapshot feature to make point in time filesystem backups of jails. A snapshot is essentially a picture of what the filesystem looked like at that point in time. Snapshots are space efficient in that they take up zero space when created and the snapshot only grows in size as files contained within the snapshot are modified after the snapshot was taken. In other words, ZFS manages the changes between snapshots, providing a way to return to what a file looked like at the time a snapshot was taken.
Since jails share the filesystem used by PC-BSD®, any type of jail, including a Linux jail, can take advantage of this ZFS feature if the ZFS filesystem was selected during the installation of PC-BSD®.
The “Snapshots” tab, shown in Figure 8.19k, is used to create and manage snapshots within the currently highlighted jail.
NOTE: this tab will be greyed out if you are not using the ZFS filesystem.
To create a snapshot of the jail, click the “+Add” button. A snapshot indicating the date and time will be added to the slider bar. If you create multiple snapshots at different times, use the slider bar to select a snapshot.
Once you have created a snapshot, the following actions can be used to manage the snapshot. Make sure that the desired snapshot is highlighted in the slider bar before clicking these buttons:
Restore: returns the system to what it looked like at the time the snapshot was taken. Think about what you wish to accomplish before using this option as any changes to files that occurred after the snapshot was taken will be lost. Unless you really want to go back to this point in time, this is probably not what you want to do.
Mount: if you wish to retrieve some files or directories from a snapshot, use this button. Once mounted, a message will indicate where on the PC-BSD® system the jail's contents have been mounted.
Unmount: when you are finished accessing the contents of the mounted snapshot, click this button to unmount the snapshot.
Add: use this button to create additional snapshots.
Remove: use this button to remove the highlighted snapshot.
Figure 8.19k: Snapshots Tab for the Highlighted Jail
This screen also allows you to schedule automatic snapshots. To enable this feature, check the box “Scheduled Snapshots”. Use the drop-down menu to set the frequency to daily or hourly. You can also type in or use the arrows to configure the number of days to keep each snapshot.
8.19.2.4 Packages Tab
The “Packages” tab, shown in Figure 8.19l, allows you to install meta-packages within the specified traditional or ports jail. Software installed using this method will be tracked by Update Manager, meaning that Warden® will be notified when updates are available for the installed software.
Figure 8.19l: Packages Tab for the Highlighted Jail
NOTE: by default, jails use the warden metapkgset which provides packages suited to a server, command line installation. At this time, meta-packages are not available for Linux jails meaning that this tab will be greyed out if a Linux jail is highlighted.
The following meta-packages are available:
Database-Servers: MySQL and PostgreSQL
File-Servers: Samba
Languages: PHP
Virtualization: VirtualBox
Hover over a package to receive a short description. If you right-click a package, it will indicate which packages and versions will be installed.
8.19.2.5 Right-Click Menu
A jail's right-click menu contains the following options:
Start or Stop this Jail: allows you to start a jail (if it is currently not running) or to stop a jail (if it is currently running). You will not be able to access a jail that has not been started. The icon next to the jail will change to indicate the current status: a red X for a stopped jail and a blue arrow for a started jail.
Toggle Autostart: toggles a jail's Autostart between “Disabled” (does not automatically start when the PC-BSD® system is booted) and “Enabled” (will start the jail when the PC-BSD® system is booted). The “Info” tab will be updated to indicate the new “Start at boot” status. Note that toggling autostart will not affect the current running status of the jail (i.e. it does not start or stop the jail right now) as autostart is only used when the system boots.
Export jail to .wdn file: allows you to save the jail (and all of its software, configuration, and files) as a .wdn file. This allows you to quickly clone a pre-configured jail to a new jail on either the same or another PC-BSD® system. The exported jail will end with a .wdn extension and the filename will be the IP address of the jail. When exporting a jail, a pop-up window will prompt you to choose the directory in which to store the backup. A progress bar will indicate that the export is in progress. Creating the .wdn file may take some time, especially if you have installed src, ports, or software.
NOTE: you should close all network connections to the jail before exporting it as Warden® will need to stop the jail in order to back it up. If your jail is running services (e.g. a webserver), export the jail at a time that will least impact network connections to the jail.
Delete Jail: removes the jail and all of its contents from the PC-BSD® system. You will be prompted to confirm this action.
8.19.2.6 Importing a Jail
The “File” menu can be used to create a new jail, import a jail, or exit Warden®.
If you click File ➜ Import Jail you will be prompted to browse to the location of a previously created .wdn file. Once selected, you will be prompted whether or not to use the same IP address for the new jail. If you are creating a new jail on the same system that still has the original jail installed, select “No” and input the IP address for the new jail. However, if you have deleted the original jail or need to restore that same jail on another computer (for example, there was a hardware failure on the system containing the original jail), you can choose to use the same IP address. You will then be prompted whether or not to use the same hostname. Only select “Yes” if that hostname is no longer in use; otherwise, select “No” and input a unique hostname for the jail. Warden® will then recreate the jail with all of the original settings. Whether or not those settings include the original IP address and hostname depends upon your selections.
8.19.3 Using the Command Line Version of Warden®
The Warden® GUI is based on a Bourne shell script. This script can be manually run from the command line on a PC-BSD® server or by users who prefer using the command line. Advanced users can also refer to the command line version in their own scripts.
If you type warden at the command line, you will receive a summary of its usage:
warden
Warden version 1.2
---------------------------------
Available commands
Type in help <command> for information and usage about that command
help - This help file
gui - Launch the GUI menu
auto - Toggles the autostart flag for a jail
checkup - Check for updates to a jail
chroot - Launches chroot into a jail
create - Creates a new jail
details - Display usage details about a jail
delete - Deletes a jail
export - Exports a jail to a .wdn file
get - Gets options list for a jail
import - Imports a jail from a .wdn file
list - Lists the installed jails
pkgs - Lists the installed packages in a jail
set - Sets options for a jail
start - Start a jail
stop - Stops a jail
type - Set the jail type (portjail/normal)
zfsmksnap - Create a ZFS snapshot of a jail
zfslistclone - List clones of jail snapshots
zfslistsnap - List snapshots of a jail
zfsclonesnap - Clone a jail snapshot
zfscronsnap - Schedule snapshot creation via cron
zfsrevertsnap - Revert jail to a snapshot
zfsrmclone - Remove a clone directory
zfsrmsnap - Remove snapshot of a jail
Each command has its own help text that describes its parameters and provides a usage example. For example, to receive help on how to use the warden create command, type:
warden help create
Warden version 1.2
---------------------------------
Help create
Creates a new jail, with options for system source, ports and autostarting.
Available Flags:
-32 (Create 32bit jail on 64bit system)
--src (Includes /usr/src system source)
--ports (Includes the ports tree)
--startauto (Start this jail at system boot)
--portjail (Make this a portjail)
--linuxjail <script> (Make this a linux jail and use supplied script for installation)
--archive <tar> (Use specified tar file for BSD jail creation)
--linuxarchive <tar> (Use specified tar file for Linux jail creation)
Usage:
warden create <IP> <HOSTNAME> <flags>
Example:
warden create 192.168.0.5 jailbird --src --ports --startauto
You do not need superuser access to use the view commands but will for any commands that create or manage a jail. The warden command will display an error message if a command requires superuser access and you currently are not the superuser. On PC-BSD®, you can put pc-su at the beginning of the warden command to be prompted for the administrative password. On a FreeBSD server, you can type su to become superuser, then repeat the warden command.
The warden set command can be used to set additional flags to pass to the jail at jail startup time and the warden get command can be used to determine if any flags have been set. For example, this command will enable raw sockets (which allows ping) and chflags on the specified jail. Note that the flags are separated by a comma with no space. Available flags are listed in the "allow.*" section of jail(8).
warden set flags 192.168.1.1 allow.raw_sockets=true,allow.chflags=true
warden get flags 192.168.1.1
allow.raw_sockets=true,allow.chflags=true
If you have an existing FreeBSD or Linux jail that you would like to import or if you want to create a new jail with a specific world environment, create a tar archive of that jail or environment. Then, when using the warden create command, include the --archive name_of_tarball.tgz option or the --linuxarchive name_of_tarball.tgz option if it is a Linux jail.
The Warden® configuration file is located in /usr/local/etc/warden.conf. It can be manually edited to change the default interface, the directory used for compressing/decompressing files, and the location of the created jails.
more /usr/local/etc/warden.conf
#!/bin/sh
# Configuration options for the Warden
######################################################################
# Network Interface for the jails to use
NIC: em0
# Directory to use for compressing / decompressing files
WTMP: /usr/jails
# Location of the jails
JDIR: /usr/jails
8.19.4 Managing Software Not Available in Packages Tab
The rest of this section demonstrates how to install and upgrade software that is not available in a jail's “Packages” tab.
Note that the software you install into a traditional jail will not be available to your PC-BSD® system. In other words, software installed into a traditional jail is meant to be used within the jail, or, in the case of network applications such as a web server, to be configured to be available over the network.
The commands demonstrated in this section can also be used to install software inside a ports jail. The software you install into a ports jail will be available to your PC-BSD® system. If you are interested in installing software on your PC-BSD® system that is not available as a PBI or you wish to learn how to use FreeBSD packages and ports without affecting the software that came with your PC-BSD® system, install the software within a ports jail.
NOTE: to manage software in a Linux jail, use the package management system provided by that Linux distro. For example, in Debian Squeeze, use aptitude.
All of the commands in this section assume that you have highlighted the jail that you wish to install software into and clicked Tools ➜ Launch Terminal.
8.19.4.1 Installing FreeBSD Packages Within a Traditional or Ports Jail
The quickest and easiest way to install software inside the jail is to install a FreeBSD package. A FreeBSD package is pre-compiled, meaning that it contains all the binaries and dependencies required for the software to run on a FreeBSD system.
When dealing with FreeBSD packages, the following command line utilities are used:
pkg_add: used to install packages. If you have never used this command before, take the time to read man pkg_add to get an overview of how this command works.
pkg_delete: used to uninstall packages. If you have never used this command before, take the time to read man pkg_delete to get an overview of how this command works.
pkg_info: used to get more information about the packages that have been installed. This command provides many useful switches so it is well worth your time to read through man pkg_info and to experiment with various switches.
A lot of software has been ported to FreeBSD (currently nearly 24,000 applications) and most of that software is available as a package. The best way to find FreeBSD software is to use FreshPorts.org. If you are using the firefox PBI, it provides a FreshPorts search plugin for quickly finding software.
Figure 8.19m shows the search results for electric; the search was performed using the firefox plugin.
Figure 8.19m: FreshPorts Search Result
Each listing in the search results includes the name of the software, the version, a description, the category (e.g. security), the email address of the port's maintainer, a CVSWeb link containing the details of the port, and a link to the software's main website. Each entry includes the command used to compile the port (as described in the next section) and the pkg_add -r command used to install the package.
To install a package, use the pkg_add command using the remote (-r) switch to install the specified package from the FreeBSD packages repository. For example, this command will install the electric package:
pkg_add -r electric
Fetching ftp://ftp.freebsd.org/pub/FreeBSD/ports/amd64/packages-9-stable/Latest/electric.tbz... Done.
You should receive a message indicating that the package was successfully fetched, then your prompt back. Depending upon what is already installed within the jail, your messages may indicate that dependent packages were also fetched. Some packages include post-installation instructions that will be displayed in the message. Occasionally you will see a warning about a version mismatch; you can ignore these as they do not affect the installation of the package. Unless the message includes an error indicating that the system was unable to fetch or install the package, the installation was successful.
You can confirm that the installation was successful by querying the package database:
pkg_info -ox electric
Information for electric-7.0.0_4:
Origin:
cad/electric
Most packages install their binary (executable) in /usr/local/bin and configuration files in /usr/local/etc/. You can find out exactly what was installed using the -L (list) switch. If you include -x, you will not have to type in the entire name and version of the package as pkg_info will match any installed packages containing your query string.
pkg_info -Lx electric | more
Information for electric-7.0.0_4:
Files:
/usr/local/bin/electric
/usr/local/share/electric/lib/.cadrc
/usr/local/share/electric/lib/ALS.help
/usr/local/share/electric/lib/AllDialogs.c
<snip rest of output>
The pkg_delete command can be used to uninstall either a package or a port. If you include the -x switch, you do not have to give the full name and version of the software. Be sure to give enough of a name so that you do not inadvertently uninstall other software matching the name:
pkg_delete -x electric
If you just get the command prompt back, the delete was successful. You can verify this by checking that the package no longer exists in the package database:
pkg_info | grep electric
You will just get your prompt back if no installed software matches that name.
If the software has other applications that depend upon it, pkg_delete will refuse to uninstall it. If you wish to override this setting, you can use the -xf switch to force the delete. However, use the force switch with caution as forcibly removing software can adversely affect the applications that required it as a dependency.
8.19.4.2 Compiling FreeBSD Ports Within a Traditional or Ports Jail
Typically, software is installed using the pkg_add command. Occasionally you may prefer to compile the port yourself. Compiling the port offers the following advantages:
not every port has an available package. This is usually due to licensing restrictions or known, unaddressed security vulnerabilities.
sometimes the package is out-of-date and you need a feature that became available in the newer version.
some ports provide compile options that are not available in the pre-compiled package. These options are used to add additional features or to strip out the features you do not need.
Compiling the port yourself has the following dis-advantages:
it takes time. Depending upon the size of the application, the amount of dependencies, the amount of CPU and RAM on the system, and the current load on the PC-BSD® system, the amount of time can range from a few minutes to a few hours or even to a few days.
NOTE: if the port does not provide any compile options, save your time and the PC-BSD® system's resources by using the pkg_add command instead.
FreshPorts will indicate if a port has any configurable compile options. To continue the example shown in Figure 8.18m, Figure 8.19n shows the configurable options for electric.
Figure 8.19n Viewing a Port's Information at FreshPorts
Before you can compile a port, you must first install the ports collection into the jail. If you did not choose to do so when the jail was created, you can install the ports collection using the following command. You will know that you have the ports collection when /usr/ports/ is populated with many subdirectories, each representing a category of software.
portsnap fetch extract
If you compile additional software at a later date, you should make sure that the ports collection is up-to-date using this command:
portsnap update
Ports tree is already up to date.
Once you have the ports collection installed into your ports jail, change to the subdirectory of the application you wish to install, for instance /usr/ports/cad/electric, and issue the command to make and install the application. FreshPorts provides the location to cd into and the make command to run.
cd /usr/ports/cad/electric
make install clean
If the port's Makefile includes OPTIONS, a configure screen will be displayed. The example in Figure 8.19o shows the options for the openvpn port.
Figure 8.19o: Configuration Options from a Port's Makefile
To change an option's setting, use the arrow keys to highlight the option, then press the spacebar to toggle the selection. Once you are finished, press enter. The port will begin to compile and install.
NOTE: if you change your mind, the configuration screen will not be displayed again should you stop and restart the build. Type make config && make install clean if you need to change your selected options.
If the port has any dependencies with options, their configuration screens will be displayed and the compile will pause until it receives your input. It is a good idea to keep an eye on the compile until it finishes and you are returned to the command prompt.
How long the compile will take can range from a few minutes to many hours, depending upon the size of the application and the speed of your system. The make command will spit out many messages, most of which you can ignore as they are simply an indication of which source is currently being compiled. Occasionally, make will encounter an error and will stop with an error message. If the solution for the error is not obvious to you, try a web search for the keywords in the error message.
NOTE: sometimes due to licensing reasons a port will require that a file be downloaded manually and placed into the /usr/ports/distfiles/ directory. After downloading and copying this file to that directory, repeat the make command to finish the compile.
Once the port is installed, it is registered in the same package database that manages packages. This means that you can use the pkg_info command to determine what was installed, as described in the previous section.
8.19.4.3 Keeping Software Up-to-Date
Any software that you install using the “Packages” tab within Warden® can be kept up-to-date using Update Manager. Simply highlight the jail and go to Tools ➜ Check for Updates. Update Manager will also indicate when security patches and newer versions of the operating system are available and should be used to keep the jail's operating system patched and up-to-date.
However, you will need to manually upgrade any software that you installed using pkg_add or any ports that you compiled yourself within a traditional or ports jail. In order to do this, you will need to:
Update the ports collection so that it is in sync with the latest version.
Install the portmaster utility which is used to upgrade FreeBSD packages and ports.
Read /usr/ports/UPDATING so that you are aware of any gotchas before you attempt to upgrade the software.
Perform the upgrade.
These steps are demonstrated in more detail in this section.
1. Update the Ports Collection
If you used pkg_add to install the software, you may not have the ports collection installed within the jail. This is the case if /usr/ports does not exist or is empty. To install the latest version of the ports collection, use this command:
portsnap fetch extract
If the ports collection is already installed, use this command to make sure that it is up-to-date:
portsnap update
2. Install an Upgrading Utility
At this time, the portmaster command is the recommended utility for upgrading software installed using packages or ports. To install this program within the jail, use this command:
pkg_add -r portmaster
rehash
3. Read /usr/ports/UPDATING
Before upgrading installed software, always read through /usr/ports/UPDATING first. This file contains any gotchas or special instructions that are needed to upgrade certain ports. Ports maintainers add to this file as new gotchas are discovered. However, you will want to start reading the file at the entry that is closest to the date that your version of PC-BSD® was released (if you have not upgraded anything yet) or the date you last upgraded, and read your way up to the top of the file. For example, this entry indicates that FreeBSD 9.0 was released on January 12:
20120112:
AFFECTS: Nobody
AUTHOR: wxs@FreeBSD.org
FreeBSD 9.0 released.
As you read through the entries from that date up to the last entry at the beginning of the file, make note of any entries that match the software that you have installed. If you are unsure of what software is installed, this command will tell you:
pkg_info | more
Occasionally, a software upgrade (e.g. perl) may affect many applications. If you come across such entries that affect your installed software, be sure to follow the instructions carefully.
If your software is up-to-date and you prefer to be notified as new entries are added to /usr/ports/UPDATING, consider subscribing to its RSS feed.
4. Perform the Upgrade
After using the portsnap command to update your ports collection and reading /usr/ports/UPDATING, you are ready to upgrade your installed software using the portmaster command.
The following command will look for out-dated ports and offer to upgrade them for you. If any of the software has configuration options, you will be presented with their configuration menus to make your selections.
portmaster -a
===>>> Gathering distinfo list for installed ports
===>>> Starting check of installed ports for available updates
<snip some output>
===>>> The following actions will be taken if you choose to proceed:
Upgrade mpg123-1.12.3 to mpg123-1.12.5
Upgrade p5-Object-InsideOut-3.69 to p5-Object-InsideOut-3.72
Upgrade linkchecker-5.3 to linkchecker-5.4
Upgrade tomcat-6.0.29 to tomcat-6.0.29_1
===>>> Proceed? y/n [y]
If you press enter to accept the default of yes, the upgrade will begin. As each upgrade completes, you will be asked if you want to delete the source for the old version of the software (which can save disk space). If you do not want to be prompted, include -D or -d with the portmaster command. There are many switches available for portmaster so it is a good idea to man portmaster to see which ones interest you.
9 Using PC-BSD®
This section discusses how to perform common tasks that were not discussed in the Control Panel section. This section contains the following categories:
9.1 Java, Flash, and Fonts
This section demonstrates how to install and configure Java, Flash, and fonts to improve your desktop experience.
9.1.1 Java
The OpenJDK PBI provides an open source implementation of the Java Platform. It includes the IcedTea Java browser plugin which automatically works with the FireFox, Chrome, and Opera web browsers without any additional configuration. To install this PBI, search for “jdk” within AppCafe®.
9.1.2 Adobe Flash
PC-BSD® installs and configures the Adobe Flash player (version 10) plugin for you. This means that flash should “just work” when browsing the web. You will find several web browsers in the Web Browsers category of AppCafe®, including Firefox, Opera, and Chromium.
If Adobe Flash does not seem to be working, running the following command as your regular user account should fix the problem:
flashpluginctl on
The Adobe Flash Player preferences icon in Control Panel can be used to modify how websites interact with your browser using Adobe Flash.
9.1.3 Installing Custom Fonts
IPC-BSD® installs Microsoft TrueType fonts for you which includes the Times New Roman, Courier New, Georgia, Trebuchet MS, Comic Sans MS Arial, Arial Black, Verdana, Andale Mono, and Impact fonts.
If you have a collection of fonts that you have downloaded or purchased, you can configure your PC-BSD® system to also use these fonts. Which utility you use depends upon which window manager you have logged into.
NOTE: many fonts are available from FreshPorts. To find a font, search for “font”. If you find a font you like, FreshPorts will indicate the pkg_add command that is used to add that font to your system. Any font installed using pkg_add should not require any additional configuration to “just work”. The rest of this section demonstrates how to install fonts that you have downloaded manually or purchased from the Internet.
9.1.3.1 Using KDE
To install custom fonts within KDE, go to System Settings ➜ Font Management. In Figure 9.1a, “All Fonts” is currently selected under the “Group” column, showing all of the fonts installed on this system.
To install your fonts, highlight “Personal Fonts” under the “Group” column, then click the “+Add” button. This will allow you to browse to the font you wish to add. You can add multiple fonts in the same directory by holding down the Ctrl key while making your selection. Click the “Open” button, which will install the font for you. When it is finished, a pop-up message will indicate that you will need to restart any open applications for the font change to take affect. Your newly installed font(s) should now show up in the “Personal Fonts” section in the “Group” column and be available to the applications you use.
Figure 9.1a: Using KDE's Font Installer to Install Custom Fonts
9.1.3.2 Using GNOME
To install custom fonts within GNOME, go to Applications ➜ Utilities ➜ File Manager. Navigate to the location of the font that you would like to install and either double-click the font name or select “Font Viewer” from the icon's right-click menu. This will open the font in Font Viewer, allowing you to view it. If you like the font, click the “Install Font” button to make it available to your applications. In the example shown in Figure 9.1b, the user is installing the BlackFlag font.
Figure 9.1b: Using GNOME's Nautilus to Install a Custom Font
9.1.3.3 Using XFCE
To install custom fonts within XFCE, use Applications ➜ System ➜ Thunar File Manager. Once you browse to the location of the font and double- or right-click it, you will see the same Font Viewer used by GNOME.
9.1.3.4 Using Other Desktops
For any desktop, you can use XFCE's thunar to install fonts. Depending upon which desktop(s) you have installed, this utility may or may not already be installed. If nothing happens when you type thunar, install it using AppCafe®.
9.1.3.5 From the Command Line
If you prefer to install fonts from the command line, become the superuser and copy the downloaded font to the /usr/local/share/fonts/ directory. Then, refresh the fonts cache with the fc-cache -f -v /usr/local/share/fonts/name_of_font command.
9.2 Multimedia
PC-BSD® has been pre-configured to support most multimedia formats and makes it easy to install most open source media applications using AppCafe®. In addition, the following Control Panel icons are available, regardless of the desktop:
Sound Configuration: this utility displays the recognized audio devices and allows you to select and test which device to use by default.
Mount Tray: this application automatically detects the insertion and removal of media in USB devices. This means that any desktop should notify you if media is inserted into a USB CD/DVD device.
If you insert a CD/DVD media into an internal CD/DVD device and your desktop does not notify you, you can still mount the media manually as the superuser. This command will mount a CD inserted into the first internal CD device:
mount -t cd9660 /dev/cd0 /media
If you install your web browser using AppCafe®, you should be able to play most media formats, including Youtube videos, Internet radio, and many trailer and movie sites.
NOTE: if you happen to come across a file that you can not play in a web browser or media player, it is probably because it is in a proprietary format that requires a licensing fee or restricts distribution of the codec that is required to play that media format.
The “Multimedia” category of AppCafe® contains several dozen applications for playing and editing multimedia. It includes these popular applications (click the links to view screenshots):
Ardour: digital audio workstation that provides non-destructive, non-linear editing with unlimited undo and more than 200 LADSPA & LV2 plugins.
aTunes: full-featured audio player and manager that can play mp3, ogg, wma, wav, flac, mp4 and radio streaming, allowing users to easily edit tags, organize music and rip audio CDs.
Audacity: multilingual audio editor and recorder.
Audacious: audio player with a focus on low resource usage, high audio quality, and support for a wide range of audio formats.
Decibel-audio-player: audio player built around a highly modular structure that lets the user disable completely the features he does not need. Able to play CDs directly.
gtkpod: graphical user interface for the Apple iPod.
Hulu-Desktop: an application for watching Hulu programming without a web browser.
Kaffeine: DVD and CD media player.
Miro: HD video player that can play almost any video file and offers over 6,000 free Internet TV shows and video podcasts.
Rhythmbox: integrated music management application.
Totem: the official movie player of the GNOME desktop environment based on GStreamer. It features a playlist, a full-screen mode, seek and volume controls, as well as keyboard navigation.
UMPlayer: universal media player that can handle any media format and play audio CDs, DVDs, (S)VCDs, TV/radio cards, YouTube™ and SHOUTcast™ streams.
VLC: simple, fast and powerful media player which plays everything: files, discs, webcams, devices and streams.
9.3 Files and File Sharing
This section describes the various file managers that are available for managing the files on your PC-BSD® system. It then shows how you can configure your PC-BSD® system to share files with other systems in your network using Samba.
9.3.1 File Managers and File Structure
Depending upon which window managers you have installed, different graphical file manager utilities may already be installed for you. You do not need to be logged into a specific window manager to use an installed file manager. For example, if KDE is installed, you can run its file manager from any window manager by typing dolphin. KDE, GNOME, LXDE, and XFCE install their own file managers while most of the unsupported desktops assume that you will install your favorite file manager. Table 9.3a summarizes the available file managers and indicates which desktop they are installed with. Some file managers can be installed independent of a desktop using AppCafe® to install the PBI. Once a file manager is installed, type its name if you wish to run it from another desktop.
When working with files on your PC-BSD® system, save your own files to your home directory. Since most of the files outside of your home directory are used by the operating system and applications, you should not delete or modify any files outside of your home directory, unless you know what you are doing.
Table 9.3b summarizes the directory structure found on a PC-BSD® system. man hier explains this directory structure in more detail.
Table 9.3b: PC-BSD® Directory Structure
Directory | Contents |
/ | pronounced as “root” and represents the beginning of the directory structure |
/bin/ | applications (binaries) that were installed with the operating system |
/boot/ | stores the startup code, including kernel modules (such as hardware drivers) |
/compat/linux/ | Linux software compatibility files |
/dev/ | files which are used by the operating system to access devices |
/etc/ | operating system configuration files |
/etc/X11/ | the xorg.conf configuration file |
/etc/rc.d/ | operating system startup scripts |
/home/ | subdirectories for each user account; each user should store their files in their own home directory |
/lib/ | operating system libraries needed for applications |
/libexec/ | operating system libraries and binaries |
/media/ | mount point for storage media such as DVDs and USB drives |
/mnt/ | another mount point |
/proc/ | the proc filesystem required by some Linux applications |
/rescue/ | necessary programs for emergency recovery |
/root/ | administrative account's home directory |
/sbin/ | operating system applications; typically only the superuser can run these applications |
/tmp/ | temporary file storage; files stored here may disappear when the system reboots |
/usr/bin/ | contains most of the command line programs available to users |
/usr/local/ | contains the binaries, libraries, startup scripts, documentation, and configuration files used by applications installed from ports or packages |
/usr/pbi/ | contains the binaries, libraries, startup scripts, documentation, and configuration files used by installed PBIs |
/usr/local/share/fonts/ | system wide fonts for graphical applications |
/usr/local/share/icons/ | system wide icons |
/usr/ports/ | location of system ports tree (if installed) |
/usr/share/ | system documentation and man pages |
/usr/sbin/ | command line programs for the superuser |
/usr/src/ | location of system source code (if installed) |
/var/ | files that change (vary), such as log files and print jobs |
9.3.2 Samba
Samba allows any operating system to share volumes using Microsoft's CIFS protocol. There are two components to Samba:
client libraries: this allows an operating system to access existing CIFS shares. The client is built into the Windows and Mac OS X operating systems and is installed for you during the PC-BSD® installation. Most Linux distros also install the Samba client; if your Linux distro does not, search its software repository.
server: this allows a computer to act like a Windows server in that it can create shares and printers that are available to any CIFS client on the same network.
This section will demonstrate how to access shares using the Samba client as well as how to configure your PC-BSD® system as a Samba server.
9.3.2.1 Using the Samba Client
Since the Samba client libraries are pre-installed for you, you simply have to decide which utility you prefer to access existing Windows shares on your network. If a desktop is installed, you do not have to be logged into that desktop in order to use that utility.
Table 9.3c summarizes the available utilities (type a utility's name to launch it in any desktop), which desktop it installs with and whether or not a separate PBI is available, and a short description of how to access the available shares using that utility.
Table 9.3c: Utilities that Support Windows Shares
Utility | Desktop/PBI | How to Access Existing Shares |
dolphin | KDE | in the left frame, click on Network ➜ Samba Shares, then the Workgroup name; if the network requires a username and password to browse for shares, set this in Control Panel ➜ System Settings ➜ Sharing while in KDE or type systemsettings ➜ Sharing while in another desktop |
konqueror | KDE | in the location bar, type smb:/ |
krusader | PBI | add Local Network to toolbar by going to Settings ➜ Configure Toolbars; once in toolbar click Local Network ➜ Samba Shares |
mucommander | PBI | click on Go ➜ Connect to server ➜ SMB; input the NETBIOS name of server, name of share, name of domain (or workgroup), and the share's username and password |
nautilus | GNOME | click on Go ➜ Network ➜ Windows Network |
smb4k | PBI | click on the “Network Neighborhood” tab |
thunar | XFCE or PBI | in the left frame, click on Network ➜ Windows Network |
9.3.2.2 Configuring the Samba Server
If you would like to share folders or a printer attached to your PC-BSD® system with other users in your network, configure the built-in Samba server.
In order to create shares, Samba's configuration file, smb.conf, needs to be modified. You can either edit this file manually or use a GUI utility such as SWAT. This section will demonstrate both methods.
9.3.2.2.1 Edit smb.conf Manually
To modify the file manually, become the superuser and copy the sample file to the configuration directory:
cp /usr/local/share/examples/samba36/smb.conf.sample /usr/local/etc/smb.conf
Open the copied file in your favorite editor and review the default settings, editing them to match your network. In particular, check these global settings:
workgroup = must match the Windows workgroup or domain name; unless the administrator has changed it, the default workgroup name is WORKGROUP
security = the security modes are described in the Samba HOWTO
hosts allow = you should input the network address to restrict connections to the local network
In the share definitions section, review the [homes] settings. You can also define your own shares. This example will share the Downloads directory of user1 as read-only:
[Downloads]
path = /usr/home/user1/Downloads
public = yes
writable = no
To test your changes, restart the Samba service:
/usr/local/etc/rc.d/samba restart
and try browsing to the share from another system. Note that you may have to first map a drive to the share in order for it to appear in Windows Explorer or within the file manager utility of another PC-BSD® or Linux system.
9.3.2.2.2 Create Shares Using SWAT
SWAT provides a graphical front-end to smb.conf through a web browser.
To enable SWAT, remove the # at the beginning of this line in /etc/inetd.conf:
#swat stream tcp nowait/400 root /usr/local/sbin/swat swat
Add the following line to /etc/rc.conf:
inetd_enable=”YES”
And start inetd:
/etc/rc.d/inetd start
To connect to SWAT, open a web browser and input the IP address of the PC-BSD® computer followed by :901. When prompted, input the username root and the password associated with the superuser account. In the example shown in Figure 9.3a, the user has clicked on the “Globals” button in order to view the global settings.
One of the nice features of SWAT is the built-in help system. If you need more information about an option, simply click its “Help” hyperlink to access that section of the Samba documentation. The “shares” button allows you to quickly create shares and the “view” button allows you to review the current configuration.
Figure 9.3a: SWAT Graphical Menu
9.4 MythTV
MythTV is an open source software digital video recorder (DVR) that is an alternative to Tivo or Windows Media Center. It allows you to pause and rewind live TV shows, skip commercials, schedule TV show recordings, and control a set-top box using an infrared remote or firewire. In order to use MythTV, you will need a video capture card. Hardware requirements are described on the MythTV Wiki.
NOTE: in PC-BSD®, webcamd is used to provide the drivers for video capture cards. This is enabled by default, meaning any devices supported by Video for Linux should “just work”.
During the installation of PC-BSD® the installer provided an option to install MythTV. If you wish to install MythTV afterwards, use Control Panel ➜ System Manager ➜ System Packages ➜ Misc. Once MythTV is installed, an entry should be added to the “Multimedia” section of the application menu of your desktop. You can also run MythTV from the command line by typing /usr/local/share/pcbsd/scripts/mythtv.sh.
9.4.1 Running MythTV for the First Time
The PC-BSD® version of MythTV provides an initialization script to properly setup the database backend used by MythTV. The first time you run MythTV, you will be prompted for the superuser password in order to configure MythTV. After inputting the superuser password, a console will temporarily open indicating that the MySQL service is starting and that the MySQL database is being created. Once that is complete, you will see the configuration GUI shown in Figure 9.4a:
Figure 9.4a: MythTV Configuration GUI
The initial screen will prompt you to select your “Country” and “Language”. Once the desired options are highlighted, click the “Save” button. You should see the MythTV front-end screen shown in Figure 9.4b.
Navigate to the configuration screen you wish to access, then press enter. To leave a screen, press ESC. To exit the front-end completely, press ESC from the main configuration menu.
Figure 9.4b: MythTV Configuration Screen
Chapters 10-12 of the MythTV Howto demonstrate the possible configurations and how to schedule recordings.
Additional Resources
9.5 XBMC
XBMC is a GPL licensed software media player and entertainment hub for digital media. XBMC can play most popular audio and video formats. It can play CDs and DVDs from a disk or image file and even files inside ZIP and RAR archives. It can scan all of your media and automatically create a personalized library with album covers, descriptions, and fan art.
NOTE: before installing XBMC, make sure that your system meets the minimum hardware requirements. The XBMC team recommends using an NVIDIA GeForce 6150 or later.
During the installation of PC-BSD® the installer provided an option to install XBMC. If you wish to install XBMC afterwards, use Control Panel ➜ System Manager ➜ System Packages ➜ Misc. Once XBMC is installed, an entry should be added to the “Multimedia” section of the application menu of your desktop. You can also start XBMC by typing xbmc from a command prompt.
If you have never used XBMC before, take some time to skim through the XBMC Quick Start Guide and the XBMC Online Manual.
9.6 Windows Emulation
Wine is an application that allows you to create a Windows environment for installing Windows software. This can be useful if your favorite Windows game or productivity application has not been ported to Linux or BSD.
Wine is not guaranteed to work with every Windows application. If you are unsure if the application that you require is supported, search for it in the “Browse Apps” section of the Wine Application Database. The Wine Wiki contains many resources to get you started and to refer to if you encounter problems with your Windows application.
9.6.1 Installing and Using Wine
Wine can be installed from AppCafe®. In Figure 9.6a, the user has performed a search to find the Wine PBI. You should install the version that is correct for your architecture (32-bit or 64-bit).
Figure 9.6a: Installing Wine from AppCafe®
Once installed, an icon for Wine Configuration will be added to the Control Panel and, depending upon your desktop, a desktop icon may be created as well. Double-clicking the icon will load the Wine configuration menu shown in Figure 9.6b. You can also start this program by typing winecfg at the command line.
Click the “Add application” button to browse to the application's installer file. By default, the contents of your hard drive will be listed under “drive_c”. If the installer is on a CD/DVD, use the drop-down menu to browse to your home directory ➜ .wine ➜ dosdevices folder. The contents of the CD/DVD should be listed under d:. If they are not, the most likely reason is that your CD/DVD was not automatically mounted by the desktop. To mount the media, type the following as the superuser:
mount -t cd9660 /dev/cd0 /cdrom
You should hear the media spin and be able to select the installer file. Once selected, press “Apply” then “OK” to exit the configuration utility.
Figure 9.6b: Wine Configuration Menu
To install the application, click the Winefile desktop icon or type winefile to see the screen shown in Figure 9.6c.
Click the button representing the drive containing the installer (in this example, D:\) and double click on the installation file (e.g. setup.exe). The installer should launch and you can proceed to install the application as you would on a Windows system.
Figure 9.6c: Installing the Application Using winefile
NOTE: if you had to manually mount the CD/DVD, you will need to unmount it before it will eject. As the superuser, use the command umount /mnt.
Once the installation is complete, browse to C:\ and find the application's location. Figure 9.6d shows an example of running Internet Explorer within winefile.
Figure 9.6d: Running the Installed Application
9.7 Remote Desktop
Occasionally it is useful to allow connections between desktop sessions running on different computers. This can be handy when troubleshooting a problem since both users will be able to see the error on the problematic system and either user can take control of the mouse and keyboard in order to fix the problem. Typically this is a temporary situation as providing access to one's computer allows a remote user the ability to both view and modify its settings.
This section will demonstrate two remote desktop scenarios: how to configure an RDP connection to another computer from PC-BSD® and how to invite another computer to connect to your desktop session.
9.7.1 Connecting to Another Computer With RDP
The remote desktop protocol (RDP) can be used to make a connection to another computer. This section will demonstrate what is needed on the remote computer for an RDP connection, how to connect using KDE's KRDC, and how to connect using VNC.
9.7.1.1 Preparing the Remote System
Depending upon the operating system, you may have to first install or enable RDP software on the remote computer:
not every edition of Windows provides a fully functional version of RDP; for example, it may not be fully supported in a Home Edition of Windows. Even if the full version of RDP is included, remote access may or may not be enabled by default. If you have trouble connecting using RDP, do a web search for “remote desktop” and the name of the version of Windows you are using to find out how to configure its remote desktop settings. If you still can not connect, you will need to download, install and configure VNC server software on the system.
if the other computer you are connecting to is a Mac, Linux, or BSD system, you will have to first install either xrdp or a VNC server on the other system. Depending upon the operating system, either software may or may not already be installed. If it is not, check the software repository for the operating system or use a web search to find out how to install and configure one of these applications on that operating system. If you are connecting to another PC-BSD® system, the krfb VNC server is automatically installed with KDE and additional VNC server software is available in AppCafe®.
If the remote system is protected by a firewall, you will need to check that it allows connections to the TCP port required by the type of connection that you will be using:
RDP: uses port 3389
VNC: uses port 5900 (for the first connection, 5901 for the second connection, etc.)
If you need to manually add a firewall rule, it is best to only allow the IP address of the computer that will be connecting. You should immediately remove or disable this firewall rule after the connection is finished so that other computers do not try to connect to the computer. Since your PC-BSD® system is considered to be the client and will be initiating the connection, you do not have to modify the firewall on the PC-BSD® system.
9.7.1.2 Connecting with KDE's KRDC
If your PC-BSD® system has the KDE desktop installed, you can initiate a connection request using KRDC. To launch this application, go to Applications ➜ Internet ➜ Remote Desktop Client within KDE or type krdc at the command line within any desktop. If you click F1 while in KRDC you can access the Remote Connection Desktop Handbook to learn more about how to use this application.
Figure 9.7a shows the initial KRDC screen which allows you to specify which system you wish to connect to.
Use the drop-down menu to indicate whether the remote system is using RDP or VNC for the connection. Then type in the IP address of the system you wish to connect to. If you are connecting to a VNC system, the IP address needs to be followed by a colon and a number indicating the number of the session. Typically, the number will be 1 unless the VNC server is hosting multiple simultaneous connections. Once you press enter, the connection will be initiated and, if it is an RDP connection, you will see the screen shown in Figure 9.7b.
Figure 9.7a: Creating a Connection Using KRDC
Figure 9.7b: Settings for the RDP Connection
Here is a quick overview of the settings:
Desktop resolution: since the contents of the screen are sent over the network, select the lowest resolution that still allows you to see what is happening on the other system. If you have a very fast network connection, you can choose a higher resolution; if you find that the other system is very slow to refresh its screen, try choosing a lower resolution.
Color depth: choose the lowest color depth that allows you to see the other system; you can choose a higher color depth if the network connection is fast.
Keyboard layout: this drop-down menu allows you to select the desired keyboard layout.
Sound: this drop-down menu allows you to choose whether any sounds heard during the connection are produced on this system, the remote system, or to disable sound during the connection.
Console login: if you are connecting to a Unix-like system, you can check this box if you wish to have access to the other system's command line console.
Extra options: allows you to specify rdesktop switches that are not covered by the other options in this screen.
Show this dialog again for this host: if you plan on using the same settings every time you connect to this computer, you can uncheck this box. If you need to change the settings at a later time, you can right-click the connection (which will appear in a list as a past connection) and choose Settings from the right-click menu.
Remember password: KWallet is KDE's password storage system. If this box stays checked, you will only need to input the password the first time you make this connection as it will be saved for you. If this is the first time you have stored a password using KWallet, it will prompt you for some information to set up your wallet.
If it is a VNC connection, you will be able to choose your connection type (speed), screen resolution, and have the option to remember the password.
Once you press OK, the connection should be initiated and you will receive pop-up messages asking for a username then a password; the details you provide must match a user account on the system you are connecting to. Once your authentication details are confirmed, you should see the desktop of the other system. If you move your mouse, it will move on the other desktop as well. Click the “View Only” button in the top toolbar whenever you wish to disable this mouse behaviour. When you are finished your session, you can click the “Disconnect” button in the top toolbar.
NOTE: if the connection fails, check on the remote computer that either the RDP software is enabled or that the VNC server is listening for connections. Also double-check that a firewall is not preventing the connection.
9.7.1.3 Connecting with VNC
If you prefer to install VNC software instead of using KDE's KRDC, use AppCafe® to install TightVNC. If you use VNC, the VNC server must be installed on the remote desktop.
Once TightVNC is installed, type vncviewer to start the VNC client. A small window will appear, allowing you to type in the IP address of the remote system in the format IP_ADDRESS:5801. Change the 5801 if the VNC server is listening on a different port.
9.7.2 Allowing Another Computer to Connect Using Desktop Sharing
If you wish another user to connect to your computer and have the KDE desktop installed, you can use the KDE Desktop Sharing application to generate a connection invitation. To launch this application within KDE, go to Applications ➜ Internet ➜ Desktop Sharing or type krfb from the command prompt of any desktop. If you press F1 while in this application, it will open the Desktop Sharing Handbook where you can learn more about using this utility. Figure 9.7c shows the initial screen for this application.
Figure 9.7c: Initiating a Connection Request Using krfb
There are two types of invitations that you can create:
Personal Invitation: if you click this button it will display the hostname that the other person will use to connect, a temporary password to use for the connection, and a connection request expiration time of one hour. It will include a warning reminding you to only give this information to the person you wish to connect as anyone can connect using that information. The connection itself can be made from any VNC client. If the person is using PC-BSD®, they can use kdrc or vncviewer as described above. On other operating systems, they will need to check if VNC is installed and download a VNC client if it is not. Once you press the “Close” button, the invitation expiry date will be listed in the main screen.
Email Invitation: if you click this button it will display a warning that anyone who reads the email containing the invitation can connect. Once you click the “Continue” button, the default email program will open the invitation so that you can input the email address of the recipient and send the email.
It should be noted that the most secure way to convey the invitation information is through an alternate communications channel such as a phone call. Ideally, you are speaking to the other person as they connect so that you can walk them through the problem you are experiencing and they can let you know what they are doing to your system as you watch them do it.
Figure 9.7d shows an example of a personal invitation.
Once the other person has the invitation, they should input the information in the invitation into their VNC client in order to start the connection. You will know when they try to connect as a pop-up message will appear on your screen similar to Figure 9.7e.
Figure 9.7d: Connection Invitation Created Using krfb
Figure 9.7e: The Other User is Trying to Connect Using the Invitation
In this example, a computer with an IP address of 192.168.1.111 is trying to connect. Buttons are provided to either accept or refuse the connection. You can also check or uncheck the box to “allow remote user to control keyboard and mouse”. If you accept the connection, the other user will be prompted to input the invitation password. Once the password is accepted, they will see your desktop.
9.8 Thin Client
The pc-thinclient script has been improved for PC-BSD® 9.1 by adding the following features:
the ability to create an installation server. Now when you first initialize the pc-thinclient script, you will be asked if you want to setup a PXE Boot Desktop Server or a PXE Boot Install Server.
when configuring a PXE Boot Install Server, all the necessary bits for PXE booting are taken care of, allowing you to prepare for PXE installs within minutes.
the ability to create unattended installation scripts for the PXE Boot Install Server.
This section demonstrates how to configure and use both the PXE Boot Desktop Server and the PXE Boot Install Server.
9.8.1 Creating a PXE Boot Desktop Server
A PC-BSD® PXE Boot Desktop Server allows you to automatically configure a network of diskless computers where each computer has a network interface card capable of PXE booting. When a client boots from their network interface instead of their hard disk, they automatically connect to the PXE Boot Desktop Server and receive a login window. Once authenticated, they can use PC-BSD®, even if PC-BSD® is not installed on their own computer and even if their computer does not have a hard drive.
To prepare your PC-BSD® system for a PXE Boot Desktop Server configuration, perform these tasks first:
If the diskless clients will require Internet access, install two network cards where one NIC is connected to the Internet and the other is connected to a private LAN from which the thin clients can PXE boot from.
The PC-BSD® system should have lots of RAM installed, especially if multiple clients will be connecting. It is recommended that you use a 64-bit system with as much RAM installed as possible.
If the /usr/ports/ directory is empty or does not exist, install the ports collection using the “Fetch Ports Tree” button in the Tasks tab of System Manager or by typing portsnap fetch extract.
Set aside a few hours as the system will need to rebuild its world and the applications it needs in order to support the PXE environment. The script will automatically build a 32-bit environment (even on a 64-bit system) as most PXE boot clients are 32-bit.
To configure the PC-BSD® system as a PXE Boot Desktop Server, run the following script as the superuser:
pc-thinclient
/usr/local/bin/pc-thinclient will install the components to convert this system into a thin-client server.
Continue? (Y/N) y
Do you wish to make this a remote X desktop server or install server?
(r/i) r
If your intent is to install a PXE Boot Desktop Server, input r and press enter. If the DHCP server is not already installed, you will receive a configuration menu for compiling the DHCP port. You can press enter to accept the defaults. Once the DHCP server is installed, the tools needed in the PXE environment will be installed:
Fetching FreeBSD environment... This may take a while...
Extracting PC-BSD® environment... This may take a while...
Copying /usr/ports -> /usr/home/thinclient/usr/ports
<snip very long output>
Setting up system for PXE booting...
What NIC do you wish DHCPD to listen on? (I.E. re0)
nic) em0
Input the FreeBSD device name of the interface that is attached to the local network containing the diskless workstations. This interface will run the DHCP server and should not be connected to a network with another DHCP server running. In the example shown here, the user has input the em0 interface. If you are unsure of the device name, type ifconfig from another terminal.
The script will now configure the specified interface and start the required services:
Starting /etc/rc.d/nfsd...OK
Starting /etc/rc.d/inetd...OK
Starting /usr/local/etc/rc.d/isc-dhcpd...OK
You will now need to enable remote desktop.
This can be done via the PC-BSD® Control Panel -> GDM Configuration
or by manually editing /usr/local/etc/gdm/custom.conf
Your system is now setup to do PXE booting!
Go to Control Panel ➜ GDM Configuration and check the box “Enable XDMCP”. If you forget this step, clients will not be able to receive an X session when they connect.
The installation creates a chroot directory that contains a small PXE image that is used by clients to launch Xorg and connect to the PXE Boot Desktop Server. You can access this chroot by typing this command as the superuser:
chroot /usr/home/thinclient
Running pkg_info within the chroot will show which X components and drivers are available. Should you need to install additional video drivers, use pkg_add within the chroot. When you are finished using the chroot, type exit to leave it.
The thin client script installs and configures the following services:
NFS: the Network File System is a protocol for sharing files on a network. It has been configured to allow clients on the network attached to the interface that you specified to connect to the thin client server. Its configuration file is located in /etc/exports.
TFTP: the Trivial File Transfer Protocol is a light-weight version of FTP used to transfer configuration or boot files between machines. The PXE network cards on the diskless computers will use TFTP to receive their configuration information. This service was enabled in /etc/inetd.conf with a home directory of /home/thinclient.
DHCP: the Dynamic Host Configuration Protocol is used to configure IP addressing info on the diskless workstations. It has been configured to assign addresses for the network attached to the interface that you specified. Its configuration file is located in /usr/local/etc/dhcpd.conf.
The thin client script also creates the pxeboot user with the default password thinclient. This username and password is used to save the working Xorg configuration files for each of the diskless computers. It is highly recommended that you change this password right away by running this command as the superuser:
passwd pxeboot
You will also need to create the users that will connect to the system. You can do so using User Manager or by typing adduser at the command line and following the prompts.
9.8.1.1 Connecting to the PXE Boot Desktop Server
After a successful installation and reboot of the PXE Boot Desktop Server, the DHCP service will be running on the NIC you specified. Make sure that this NIC and a PXE capable client are connected to the same hub or switch. When you boot up the client, PXE should automatically obtain an IP address and begin to load PC-BSD®. If it does not, review the boot order settings in the BIOS on the client to make sure that PXE is listed first.
After the boot process has finished, the client will be brought to this prompt:
No saved xorg-config for this MAC: <MAC_Address>
Do you wish to setup a custom xorg.conf for this system? (Y/N)
If you wait 10 seconds, this message will timeout, and the client will bring up X in 1024x768 mode. If this is not the resolution that you wish to use, type “Y” at the prompt and hit enter to bring up the Xorg Configuration screen. In this menu, you will be able to setup your own custom xorg.conf file, auto-detect settings, and test the new configuration. When finished, choose “Save working config” to send this configuration to the PXE Boot Desktop Server. This will prompt for the password of the pxeboot user. Once authenticated, the file will be saved by the client's MAC address in /home/pxeboot/mnt/xorg-config/<mac>.conf. The next time you boot the client, it will automatically use the saved xorg.conf file and bring the system to the PC-BSD® login screen.
NOTE: in order for the login to succeed, the user account must already exist on the PXE Boot Desktop Server.
The client's boot environment is located in /home/pxeboot. This is mounted read-only during the PXE boot process to allow the client to bootup and create an XDCMP connection to the server.
Once logged in to the PXE Boot Desktop Server, using PC-BSD® will be the same as if you had installed PC-BSD® on the client system. You will be able to use AppCafe® to install software and to save and use the files in your home directory.
9.8.1.2 Uninstalling the PXE Boot Desktop Server
Use the -remove option if you wish to uninstall the PXE Boot Desktop Server:
pc-thinclient -remove
Removing /usr/home/thinclient
This will remove the PXE environment from the system. If you are finished using the PXE boot services, you can stop them using these commands:
service nfsd stop
service inetd stop
service isc-dhcpd stop
and prevent them from restarting by removing these lines from /etc/rc.conf:
# pc-thinclient configuration
dhcpd_enable="YES"
dhcpd_ifaces="em0"
portmap_enable="YES"
nfs_server_enable="YES"
inetd_enable="YES"
ifconfig_em0="192.168.2.2"
Your interface name and IP address may differ from those in the example.
9.8.2 Creating a PXE Boot Install Server
A PC-BSD® PXE Boot Desktop Server can be used to install PC-BSD®, FreeBSD, or TrueOS™ onto computers who connect to the server using PXE. The installations can be interactive or fully automated. The PXE Boot Desktop Server supports multiple, concurrent installations with the only limiting factor being the server's disk I/O and the network's bandwidth.
The installation of the PXE Boot Install Server starts the same way, except this time you select i when prompted:
pc-thinclient
/usr/local/bin/pc-thinclient will install the components to convert this system into a thin-client server.
Continue? (Y/N) y
Do you wish to make this a remote X desktop server or install server?
(r/i) i
Fetching FreeBSD environment... This may take a while...
Extracting PC-BSD environment... This may take a while...
Setting up system for PXE booting...
What NIC do you wish DHCPD to listen on? (I.E. re0)
nic) em0
Starting /etc/rc.d/nfsd...OK
Starting /etc/rc.d/inetd...OK
Starting /usr/local/etc/rc.d/isc-dhcpd...OK
To perform system installations, place your custom pc-sysinstall scripts in:
/usr/home/thinclient/installscripts
An example script is provided in the above directory
For unattended installations, save your pc-sysinstall script as:
/usr/home/thinclient/installscripts/unattended.cfg
Your system is now setup to do PXE booting!
9.8.2.1 Connecting to and Customizing the PXE Boot Install Server
Once the PXE Boot Install Server is installed, try to PXE boot a client which is connected to the same network. If the client boots successfully, you will see the installation screen shown in Figure 9.8a.
Figure 9.8a: PXE Boot Installation Menu
By default, selecting “install” from the boot menu will use the /usr/home/thinclient/installscripts/pc-sysinstall.example script which installs a basic FreeBSD system. In addition to starting an installation, this menu provides an emergency shell prompt. This can be useful if you have a system which can no longer boot and you wish to either access the disk's contents or attempt to repair the installation.
Any scripts that you create and place in the /usr/home/thinclient/installscripts/ directory will be selectable as an installation option within the PXE client boot menu. Tables 5.5a and 5.5b in Creating an Automated Installation with pc-sysinstall summarize the available configuration options when creating an installation script. Alternately, every time you install PC-BSD, the installation script is automatically saved to /root/pc-sysinstall.cfg. This means that if you wish to repeat an installation, you simply need to copy that file to the /usr/home/thinclient/installscripts/ directory on the PXE Boot Install Server.
The PXE Boot Install Server also supports completely unattended installations. To perform fully-automated installations over the PXE interface, create a configuration script named /usr/home/thinclient/installscripts/unattended.cfg. When a PXE client first boots, it checks for the existence of the unattended.cfg file, and if found, it will automatically use it for installation. Some caution should be taken when using this method since simply plugging a PXE boot client into the wrong LAN cable could cause it to be re-installed.
9.9 ownCloud
ownCloud is open source software that allows you to create your own cloud storage. This allows you to share data, contacts, and calendars with other devices and users.
In PC-BSD®, you can create your own private cloud service by installing ownCloud either into a traditional jail that you created using Warden® or into a TrueOS® installation. For security reasons, installing ownCloud directly onto a desktop installation is not recommended as the web and database services it requires may expose the desktop to security vulnerabilities. If you are installing ownCloud on a PC-BSD® system, create a traditional jail as it isolates the software installed into the jail from your desktop operating system.
9.9.1 Install and Start the Required Services
If you are installing ownCloud into a traditional jail, make sure that the jail has been started, then go to the “Packages” tab of the jail as seen in the example in Figure 9.9a.
Figure 9.9a: Install the Required Packages
Check the boxes for Database-Servers ➜ MySQL, Languages ➜ PHP, and Web-Servers ➜ Apache, then click the “Apply” button to install these packages.
Once installed, go to Tools ➜ Service Manager which will open the screen shown in Figure 9.9b. Highlight the apache22 service and click the “Enable Service” button and then the “Start” button. Repeat for the mysql service.
Figure 9.9b: Start the Required Services
Verify that you can reach the web server by typing the IP address of the jail into a web browser. You should receive an “It works!” message. You will need to first allow incoming TCP port 80 on the jail interface using Firewall Manager if you use a web browser on a different computer.
If you are installing ownCloud onto a TrueOS™ system, you will need to create the jail and install the dependencies from the command line. When creating the jail, specify the jail IP address and hostname as seen in this example:
warden create 10.0.0.1 owncloudjail --startauto
pc-metapkgmanager --pkgset warden --chroot /usr/jails/10.0.0.1 add MySQL,Apache,PHP
Once the software is installed, access the jail by its IP address in order to edit the /etc/rc.conf file within the jail so that the required services start when the jail is available:
warden chroot 10.0.0.1
vi /etc/rc.conf
Add these two lines to that file:
apache22_enable=”YES”
mysql_enable=”YES”
Save your edits then start the services:
usr/local/etc/rc.d/apache22 start
/usr/local/etc/rc.d/mysql-server start
Verify that you can reach the web server by typing the IP address of the jail into a web browser. You should receive a “It works!” message. You will need to first edit /etc/pf.conf in order to allow incoming TCP port 80 using if you use a web browser on a different computer. An example would be to add a line to the “Nic specific rules” section:
pass in quick on re0 proto tcp from any to (re0) port 80 keep state
You may wish to replace any with just the IP addresses of the systems on your network. re0 should be replaced with the interface used by the jail.
9.9.2 Configuring ownCloud
You are now ready to download and configure ownCloud. If you are using a traditional jail on your desktop, go to Tools ➜ Launch Terminal to access the jail's command line. If you are using TrueOS™, use the warden chroot command to access the command line of the jail.
Once at the command line of the jail, download ownCloud into the Apache data directory:
cd /usr/local/www/apache22/data
fetch http://download.owncloud.org/releases/owncloud-4.0.7.tar.bz2
tar xzvf owncloud-4.0.7.tar.bz2
chown -R www:www owncloud
Next, configure the MySQL database, substituting ocuser and mypass with the username and password that you wish to use:
mysql -u root
mysql> create database owncloud;
mysql> grant all on owncloud.* to ocuser@localhost identified by "mypass";
mysql> quit
Next, add the required PHP options to Apache. Open /usr/local/etc/apache22/httpd.conf in an editor and look for this line:
#AddType application/x-gzip .tgz
Add the following lines directly below that line:
AddType application/x-httpd-php .php
AddType application/x-httpd-php-source .phps
Next, look for the following section:
<IfModule dir_module>
DirectoryIndex index.html
</IfModule>
and change it to:
<IfModule dir_module>
DirectoryIndex index.html index.php
</IfModule>
Save your changes and restart the Apache and MySQL services:
/usr/local/etc/rc.d/apache22 restart
/usr/local/etc/rc.d/mysql-server restart
Test your changes from a web browser by adding “owncloud” to the end of the IP address of the jail. For example, type http://10.0.0.1/owncloud/. You should see the setup screen shown in Figure 9.9c.
Figure 9.9c: ownCloud Initial Setup Screen
Input the name of the user and password that will be used to administer ownCloud, then click the “Advanced” button. In the advanced settings, click the “MySQL” tab and input the MySQL username, password, and database name that you configured previously. Click the “Finish setup” button to save your changes and enter your new cloud interface, shown in Figure 9.9d.
Click the left panel of the interface to access a type of media. For example, if you click “Files” and then the “New” button, you can upload a file, folder, or from a URL. If you click “Contacts”, you can add a contact or import/export the address book.
Click the “Settings” icon at the bottom of the left panel to add users, configure applications, change the administrative configuration, and to access “Help”.
Instructions for synchronizing the calendar and address book, integrating with a file manager, and integrating with a media player can be found in the documentation section of the ownCloud website. Synchronization clients are available from here.
Figure 9.9d: ownCloud Interface
9.10 Security
Your PC-BSD® system is secure by default. This section provides an overview of the built-in security features and additional resources should you like to learn more about increasing the security of your system beyond its current level.
The security features built into PC-BSD® include:
Naturally immune to viruses and other malware: most viruses are written to exploit Windows systems and do not understand the binaries or paths found on a PC-BSD® system. Antivirus software is still available in the Security section of AppCafe® as this can be useful if you send or forward email attachments to users running other operating systems.
Potential for serious damage is limited: file and directory ownership and permissions along with separate user and group functions mean that as an ordinary user any program executed will only be granted the abilities and access of that user. A user that is not a member of the wheel group can not switch to administrative access and can not enter or list the contents of a directory that has not been set for universal access.
Built-in firewall: the default firewall ruleset allows you to access the Internet and the shares available on your network. If there are no shared resources on your network, you can use Firewall Manager to further tighten the default ruleset. In addition, Fail2ban is installed. This service can be configured to identify possible break-in attempts and to respond with an action such as creating a firewall rule to ban the intruder. Instructions for configuring fail2ban can be found here.
Built-in Host-based Intrusion Detection System: PC-BSD® installs OSSEC which can be configured to perform log analysis, file integrity checking, policy monitoring, rootkit detection, real-time alerting, and active response. If you have never used OSSEC before, take some time to read through its manual to determine which features interest you and how to configure them.
Very few services are enabled by default: you can easily view which services are started at boot time using Service Manager or by reading through /etc/rc.conf. You can also disable the services that you do not use by disabling that service in Service Manager or by commenting out that line with a # in /etc/rc.conf.
SSH is disabled by default: and can only be enabled by the superuser. This setting prevents bots and other users from trying to access your system. If you do need to use SSH, change the “NO” to a “YES” in the line sshd_enable= in the file /etc/rc.conf. You can start the service right away by typing /etc/rc.d/sshd start. You will need to add a firewall rule to allow SSH connections from the systems that require SSH access.
SSH root logins are disabled by default: if you enable SSH, you must login as a regular user and can use su or sudo when you need to perform administrative actions. You should not change this default as this prevents an unwanted user from having complete access to your system.
sudo is installed: and configured to allow users in the wheel group permission to run an administrative command if they know the root password. By default, the first user you create during installation is added to the wheel group. You can use User Manager to add other users to this group. You can change the default sudo configuration using the visudo command as the superuser.
AESNI support is loaded by default for the Intel Core i5/i7 processors that support this encryption set. This support speeds up AES encryption and decryption.
Automatic notification of security advisories: Update Manager will automatically notify you if an update is available as the result of a FreeBSD security advisory that affects PC-BSD®. This allows you to keep your operating system fully patched with just the click of a mouse.
If you would like to learn more about security on FreeBSD/PC-BSD® systems, man security is a good place to start. These resources provide more information about security on FreeBSD-based operating systems:
9.11 Accessibility
The GNOME and KDE desktop environments included with PC-BSD provide accessibility features to assist users with vision and mobility impairments. This section provides an overview of these features and references to additional accessibility information.
NOTE: if you install the GNOME-Accessibility or KDE-Accessibility system components, most of the applications installed with those components can also be started from the command line, regardless of which desktop a user is logged into.
9.11.1 GNOME Accessibility Tools
To install the GNOME accessibility tools, make sure that the “GNOME-Accessibility” box is checked (it is by default) when selecting to install GNOME either during installation or afterwards using System Manager ➜ System Packages ➜ Desktops.
The GNOME-Accessibility component installs the following software:
dasher: supports alternative input devices such as a joystick, touchscreen, trackball, head-mouse, or eyetracker. In GNOME, this utility is located in Applications ➜ Utilities ➜ Dasher. It can also be started from the command line by typing dasher.To change the input device, start dasher and click Edit ➜ Preferences ➜ Control, shown in Figure 9.11a.
Figure 9.11a: Changing the Input Device in Dasher
gok: application which displays virtual keyboards. You can use a mouse or an alternative pointing device to operate the virtual keyboards. It generates dynamic keyboards that contain keys to represent the applications that are running on your desktop or the menus that are contained in an application. In GNOME, this utility is located in System ➜ Preferences ➜ Assistive Technologies, or you can type gok at the command line. Check the box “Enable assistive technologies” and then press the “Close and Log Out” button. Once you log back in, you can start this program by typing gok in a terminal. To start the virtual keyboard, click “Compose” in the main window, shown in Figure 9.11b. You can set your gok preferences by clicking GOK ➜ Preferences.
Figure 9.11b: gok Main Screen
mousetweaks: provides mouse accessibility enhancements while logged into GNOME, such as simulating different mouse clicks without using physical buttons and a delay-click feature which opens a context menu. To configure mousetweaks within GNOME, go to System ➜ Preferences ➜ Mouse ➜ Accessibility. In the screen shown in Figure 9.11c, if you check the box “Trigger secondary click by holding down the primary button”, you can simulate a secondary click on a mouse with one button by keeping the primary mouse button pressed without moving the pointer for the time determined by the delay slider. If you check the box “Initiate click when stopping pointer movement”, you will activate dwell click. This allows you to assign actions to a single primary click, double click, drag click, and secondary click without having to actually click a mouse button.
Figure 9.11c: Configuring mousetweaks
orca: To start orca from within GNOME, click Applications ➜ Utilities ➜ Orca Screen Reader and Magnifier or type orca from the command line. The first time you start orca, you will be prompted to set some preferences and you may be prompted to logout to set those preferences. Once in orca, you can click the “Preferences” button to access a screen of many more preferences, shown in Figure 9.11d. While in orca, you can press F1 or “Help” to access the Orca Users Guide. Orca can also be integrated into several other applications and instructions on how to do so for various applications can be found here.
Figure 9.11d: Orca Preferences
The GNOME-Accessibility component also adds the following options to the login Accessibility screen shown in Figure 4.8b:
Use on-screen keyboard
Use screen reader
Use screen magnifier
More information about GNOME-Accessibility can be found in the GNOME Desktop Accessibility Guide.
9.11.2 KDE Accessibility Tools
To install the KDE accessibility tools, make sure that the “KDE-Accessibility” box is checked (it is by default) when selecting to install KDE either during installation or afterwards using System Manager ➜ System Packages ➜ Desktops.
The KDE-Accessibility component installs the following software:
KMag: a screen magnifier. In KDE, this application is in Applications ➜ Utilities ➜ Screen Magnifier or you can type kmag from the command line. Drag the magnifier window over the text you wish to magnify or click its “Settings” button to view the shortcuts for its various modes. Click F1 while the application is open to access the Kmagnifier Handbook.
KMouseTool: clicks the mouse whenever the mouse cursor pauses briefly. It can also drag the mouse, although this takes a bit more practice. To start this utility in KDE, click Applications ➜ Utilities ➜ Automatic Mouse Click or type kmousetool from the command line. In the screen shown in Figure 9.11e, check the settings you wish to use, click the “Apply” button, then click the “Start” button. If you quit this screen, it will be added to the system tray and will continue to run until you launch its icon and click the “Stop” button. A PDF of the KMouseTool Handbook can be downloaded from here.
Figure 9.11e: Configuring KMouseTool
10 Finding Help
While professional PC-BSD® support is available from iXsystems, most users turn to the Internet for help. We are doing our best to make PC-BSD® as easy as possible for newcomers. Should you need help, there are plenty of ways to get in touch with the PC-BSD® community. This section discusses the following help resources:
10.1 PC-BSD® Forums
The PC-BSD® Forums contain a wealth of information, tips and solutions which you can access from a web browser. There are many active members and you will find that most questions are replied to quickly. If you are having problems with something on your PC-BSD® system, try using the forum's search utility. You will often find that someone else has posted a similar question and that other users have responded with a fix or a how-to.
The Forums have been categorized, allowing users to skim through the categories that interest them while learning some things along the way. You do not have to create a login account in order to search or read through the forums. However, if you wish to ask or answer a question on a forum or subscribe to a forum or a thread (to be automatically notified when a new post is added), you will need to be logged in. To subscribe to a forum, open the page for the forum and select Forum Tools ➜ Subscribe to this Forum. You will be prompted to choose how often to be notified whenever a post is added to the forum. If you wish to subscribe to a specific post, open the post and select Thread Tools ➜ Subscribe to this Thread. You will be notified whenever someone responds to that post.
The current categories and the forum descriptions are described below:
The General category contains the following forums:
Announcements: this is a read only forum containing announcements of new releases and news related to PC-BSD®. Subscribing to this forum is a good way to keep up-to-date with the latest news about PC-BSD®.
General Questions: use this forum if your question does not fit into any of the other forum categories.
The Lounge: this is a general discussion area for PC-BSD® users. Posts in this forum are not of a technical nature. Posts should be of interest to other PC-BSD® users and not contain any mature or slanderous content.
Advocacy: this is a brainstorming area for promoting PC-BSD®.
Guides: this forum contains how-tos and guides for performing specific tasks on PC-BSD®.
Tips and Tricks: this forum contains suggestions for configuring and tweaking your PC-BSD® system.
Books on PC-BSD®: this forum contains errata and discussion for published books about PC-BSD®.
PC-BSD® Server Edition: this forum is for the discussion of the FreeBSD server and TrueOS™ editions of PC-BSD®.
The PC-BSD® Software (PBI files) category allows PBI developers to become aware of any problems with current PBIs and to receive requests for software that should be made into a PBI. If you start a post in any of these forums, subscribe to it so you can be notified of any responses to your post. The forums in this category include:
PBI Discussion: a general discussion area for resolving PBI problem reports. If you have a problem installing or using a PBI, post the details in this forum.
PBI Requests: do you have a favorite application that is not currently available as a PBI? You can request it in this forum. Be sure to read the Readme first post if this is your first PBI request.
Finished PBIs: once a new PBI is created as the result of a PBI request, the original request is moved to this forum.
Port Requests: do you have a favorite application that is not currently available as a FreeBSD port? You can request it here. If someone does make a port, it can also be converted into a PBI as PBIs are based on FreeBSD ports. Again, read the Readme first file if this is your first port request.
The Support category deals with the following types of support questions. PC-BSD® developers are subscribed to this list so they can help determine what is causing the problem, and if a fix is made available, can commit it for the next version of PC-BSD®. If you start a post in any of these forums, subscribe to it so you can be notified of any responses to your post.
General Bug Reports: if you are having a problem on your PC-BSD® system that does not match any of the other forum categories, you can report it here. Read any posts marked as “sticky” (they will always be at the top of the forum) if this is your first bug report.
Installing PC-BSD®: if you are having problems installing PC-BSD®, post the details of your problem to this forum.
Startup Bug Reports: if you have been able to install PC-BSD® but are having problems booting into PC-BSD®, post the details of your problem in this forum.
Usage Bug Reports: if you are having problems performing a task or using the software that was installed with your PC-BSD® system, post the details of your problem to this forum.
FreeBSD Help: if you suspect that your problem is not with PC-BSD® but with the underlying FreeBSD operating system, post the details of your problem in this forum. The Looking for FreeBSD Help? README FIRST! post should be read first.
The Hardware Support category is for reporting hardware-related problems. PC-BSD® developers are subscribed to this list so they can help determine what is causing the problem, and if a fix is made available, can commit it for the next version of PC-BSD®. If you start a post in any of these forums, subscribe to it so you can be notified of any responses to your post. Be sure to read the README first before posting.
General Support: if your hardware problem does not match any of the other forum categories, post the details of your problem in this forum.
Graphics Cards: if you are having problems with your video card settings, post the details of your problem to this forum.
Sound and Multimedia: if you are having problems with sound or in playing multimedia such as CDs or videos, post the details of your problem to this forum.
Networking: if you are having problems using or configuring a network interface, post the details of your problem to this forum.
Laptops: if you are having problems with power management or other laptop-specific issues, post the details of your problem to this forum.
Drives: if you are having problems accessing or formatting CD, DVD, USB or hard drives, post the details of your problem to this forum.
The Development category contains the following forums:
Creating PC-BSD® Packages (.pbi files): this is a discussion area for PBI developers who need help with or have questions about creating a PBI.
Feature Requests: do you have an idea for a feature that you would like to be available in PC-BSD®? This is the forum to request it.
Translations: this is a discussion area for translators who localize PC-BSD® menus or translate PC-BSD® documentation.
Documentation Project: this is a discussion area for those who wish to help with PC-BSD® documentation.
PC-BSD® Installer: this is a discussion area for feature requests and testing of the PC-BSD® installation program.
The Testing category is for PC-BSD® beta testers to report problems found in upcoming versions of PC-BSD®. It contains the following forums:
General Testing: if your problem is not related to one of the following desktop environments, report the problem in this forum. Be sure to read the sticky threads first as they contain useful information about beta testing and any known issues with the testing snapshot.
KDE: if your problem is related to the KDE desktop or KDE applications, report the problem in this forum. Be sure to read README first for instructions before posting.
Gnome: if your problem is related to the GNOME desktop or GNOME applications, report the problem in this forum. Be sure to read README first for instructions before posting.
XFCE: if your problem is related to the XFCE desktop, report the problem in this forum. Be sure to read README first for instructions before posting.
LXDE: if your problem is related to the LXDE desktop, report the problem in this forum. Be sure to read README first for instructions before posting.
Fluxbox: if your problem is related to the Fluxbox desktop, report the problem in this forum. Be sure to read README first for instructions before posting.
Ports Testers: if your problem is related to a FreeBSD package or port, you can report the problem in this forum. Be sure to read README first for instructions before posting.
The International category contains forums for non-English speakers for PC-BSD® related discussions in their native language. Each forum has its own categories for organizing posts. The following forums are available:
While logged into the forums, a link called “UserCP” will appear in the upper left hand corner. This is your control panel and it contains many settings to customize your forums experience. You should review the settings in your Control Panel.
Before asking a question on the forums or starting a new thread, first use the search utility to see if a similar thread already exists. If one does, you can add to the conversation by using the “Reply” button. If you find a thread useful, feel free to click the “Thanks” button to let the original poster know that you benefited from their knowledge.
If a similar thread does not already exist, review the forum categories to determine which one is the best fit for your post. When creating a new thread, use a useful “Title” name to describe your problem or question--remember, other users may be researching a similar issue and you want them to find your thread. Include enough details in your message so that others can quickly understand what you are experiencing--otherwise, they will have to ask you additional questions to understand your problem. Make sure you are subscribed to your thread so that you will receive a notification when someone responds to it.
You can ask a question by clicking on the “New Thread” button in the forum category that most closely matches your question. For example, if you are having problems with your video settings, you should create a new thread in the “Graphics” Card forum. If you do not see a category that matches your question, try the “General Support” category.
In addition to the forums available from the PC-BSD® Forums website, the following forums may assist you in troubleshooting your PC-BSD® system:
FreeBSD Forums: many PC-BSD® problems are related to the underlying FreeBSD operating system. The FreeBSD forums are very active and full of useful information that can apply to your PC-BSD® system.
BSD Nexus: contains categories for each of the BSD operating systems as well as general BSD information.
BSD Foren: these forums are in German and contain many categories for each of the BSD operating systems.
BSD Guru PC-BSD® Forum: this forum is in Polish and is specific to PC-BSD®, forums for the other BSD operating systems are also available at BSD Guru.
10.2 IRC Channel
Like many open source projects, PC-BSD® has an IRC channel to connect supporters and users. To get connected, use the following information in your IRC client:
Server name: irc.freenode.net
Channel name: #pcbsd (note that the # is required)
AppCafe® has an IRC category where you can find PBIs for IRC clients. If you do not wish to install an IRC client, you can instead use the the web interface to #pcbsd.
IRC is a great way to chat with other users and get answers to your questions. A few things to keep in mind if you ask a question on IRC:
Most of the regular users are always logged in, even when they are away from their computer or are busy doing other computing tasks. If you do not get an answer right away, do not get mad, leave the channel and never come back again. Stick around for a while to see if anyone responds.
IRC users represent many different time zones. It is quite possible that it is late at night or very early in the morning for some users when you ask a question.
Do not post error messages in the channel as the IRC software will probably kick you out for flooding and it is considered to be bad etiquette. Instead, use a pasting service such as pastebin and refer to the URL on channel. If you prefer to paste an image of your error, upload it to a temporary screenshot hosting service such as Upload Screenshot and post the URL to your uploaded image.
Be polite and do not demand that others answer your question.
It is considered rude to DM (direct message) someone who does not know you. If no one answers your question, do not start DMing people you do not know.
The first time you join a channel, it is okay to say hi and introduce yourself.
10.3 Mailing Lists
Mailing lists are a handy way to discuss problems, solutions, and requested features as they create a searchable archive of discussions. The PC-BSD® Project offers the following mailing lists to cover a wide variety of discussion topics:
Announce: a read-only, low frequency list used by the PC-BSD® team to make announcements to the community.
Commits: lists SVN commits as PC-BSD® code is added or modified by developers.
Dev: for discussion related to PC-BSD® technical development.
Docs: for communications between those who are involved, or interested in contributing to, the PC-BSD® documentation effort.
Installer: for discussions about the backend to the pc-sysinstall utility.
PBI-bugs: for users to report and discuss bugs found in PBI applications.
PBI-dev: for discussions between PBI developers and users concerning PBI construction and maintenance.
PBIbuild: lists SVN commits as PBIs are added or modified by PBI developers.
PCBSD-Malaysia: general discussion list for Malaysian users in their native language.
PCBSD-warden: the place to discuss Warden®.
Public: general public list for discussion not related to the other mailing lists.
Support: if you have a problem, you should report your issue or error messages on this list.
Testing: for those wishing to participate in PC-BSD® beta testing and feedback.
Trac-bugs: lists notifications about changes to PC-BSD® bug reports in Trac database.
Translations: for those involved in translating for PC-BSD®.
Each mailing list includes a description of topics suitable for discussion on that list and indicates if it is read only or available for user discussion. Anyone can read the archives of a list. If you wish to send an email to a mailing list, you will need to first subscribe to the list. The link for each mailing list provides an interface for subscribing to that list. When you send an email to the list, remember to use the mailing address that you used when you subscribed to the list.
Several of the mailing lists are archived at gmane. Gmane allows you to read the archives in several different formats. It also provides RSS feeds in various formats for keeping up-to-date on new messages and topics.
In addition to the official mailing lists, there are mailing lists set up by PC-BSD® users. Many of these lists are designed for discussion in other languages. A list of alternative PC-BSD® mailing lists can be found at Google Groups.
10.4 FreeBSD Handbook and FAQ
PC-BSD® uses FreeBSD as its underlying operating system, so everything in the FreeBSD Handbook and FreeBSD FAQ applies to PC-BSD® as well. Both documents are very comprehensive and cover nearly every task you can accomplish on a FreeBSD system. They are also an excellent resource for learning how things work under the hood of your PC-BSD® system.
NOTE: some configurations described in the FreeBSD Handbook already “just work” on your PC-BSD® system as they have been pre-configured for you. In these instances, reading that FreeBSD Handbook section can help you to understand how your system is configured and why it works.
10.5 Social Media
The PC-BSD® project maintains several social media sites to help users keep up-to-date with what is happening and to provide venues for developers and users to network with each other. Anyone is welcome to join.
10.6 Search and Portals
Many BSD related search portals exist. If you can not find the answer that you are looking for in the forums or mailing lists, try searching these websites:
FreeBSD Search (includes mailing list archives, man pages, and web pages)
10.7 Other Resources
The following BSD sites and resources may also contain useful information:
BSD Magazine (free, monthly download)
BSD Hacks (book)
The Best of FreeBSD Basics (book)
Definitive Guide to PC-BSD® (book)
11 Supporting PC-BSD®
PC-BSD® is a community project and relies on involvement from its users and supporters. This section lists some ideas for becoming involved. We also have a list of Tasks Looking for People if you are looking for a specific task to assist with.
11.1 Become a Beta Tester
If you like playing around with operating systems and have a bit of spare time, one of the most effective ways you can assist the PC-BSD® community is by reporting problems you encounter while using PC-BSD®.
If you have a spare system or virtual machine, you can also download and try out the latest alpha, beta or release candidate snapshots. These versions are still in testing and have not been officially released yet. Having as many people as possible using PC-BSD® on many different hardware configurations assists the project in finding and fixing bugs. This makes using PC-BSD® better for everyone. Subscribing to the PC-BSD® blog is a good way to keep up-to-date on the availability of testing snapshots and any major bugs that are found within a snapshot.
If becoming a tester interests you, subscribe to the testing mailing list. As new testing versions become available they will be announced on this list. You will also be able to see what problems other testers are finding and can check to see if the problem exists on your hardware as well. You can also subscribe to Gmane's RSS feeds if you want a quick way to keep up with the subjects being discussed on the testing mailing list.
Anyone can become a beta tester. Follow these tips so that you can accurately describe your findings so they can be fixed as soon as possible:
before sending an email, search the testing mailing list to see if anyone else has reported a similar problem.
when reporting a new issue, use a descriptive subject in your email that includes the error and the version of PC-BSD®. Ideally, the subject is short (8 words or less) and contains key words about the error. An example would be “Warden on 9.1-BETA1 fails to export jail”.
ensure that the body of your email includes the PC-BSD® version and architecture (e.g. 9.1-BETA1, 64-bit USB version).
give a short (2-3 sentences) description of how to recreate the error (e.g. when I right click a jail in warden and select Export jail to a .wdn file, it lets me select a file name, but then it freezes). If there is an error message, include its text.
include any other info that may be useful (e.g. this seems to work on my 32 bit system or this used to work on 9.0).
if the problem appears to be hardware related, include a copy of /var/run/dmesg.boot as this file shows the hardware that was probed the last time the PC-BSD® system booted.
11.2 Become a Translator
PC-BSD® uses Pootle for managing localization of the menu screens used by the installer and the PC-BSD® utilities. Pootle makes it possible to find out if your native language has been fully localized for PC-BSD®. Pootle also makes it easy for users to check and submit translated text as it provides a web editor and commenting system. This means that translators can spend their time making and reviewing translations rather than learning how to use a translation tool.
To see the status of a localization, open up the PCBSD Translation System in your browser, as seen in Figure 11.2a:
Figure 11.2a: The PC-BSD® Pootle Translation System
The localizations PC-BSD® users have requested are listed alphabetically on the left. If your language is missing and you would like to help in its translation, send an email to the translations mailing list so it can be added.
The green bar in the “Overall Completion” column indicates the percentage of PC-BSD® menus that have been localized. If a language is not at 100%, it means that the menus that currently are not translated will appear in English instead of in that language.
If you click on a language name then click on the pcbsd hyperlink under the “Name” column, you will see each menu item that is available for translation. The example shown in Figure 11.2b is for the Greek localization.
In this example, the menu for CrashHandler is complete, but the one for LifePreserver is not.
If you click on the “Review” tab, you will see a list of statistics as seen in Figure 11.2c. This page will indicate the results of Pootle's quality checks, helping translators to notice any problematic items. A description of each quality check can be found at sourceforge's translate site.
Figure 11.2b: Viewing a Language's Available Menus
Figure 11.2c: Reviewing a Language's Quality Checks
If you wish to help localize your language, you should first join the translations mailing list and introduce yourself and which language(s) you can assist with. This will allow you to meet other volunteers as well as keep abreast of any notices or updates that may affect the translations. You will also need to create a Pootle login account.
Once you are logged in to Pootle, navigate to the menu item that you wish to translate. Figure 11.2d continues the earlier example by clicking on the link for the Greek version of LifePreserver.po.
In this example, the first string, the phrase “No Previous Backup” has been translated. Each text field (string) in the menu is numbered--click on the hyperlink associated with the number to open that text field in the Pootle editor, or use the “Next” and “Previous” links to navigate between text fields.
For untranslated strings, you can use the “Google translate” button to suggest a translation, then fix as necessary for correctness. If a string fails a quality check, a message will indicate which check failed. For example, if the whitespace or double-spacing check fails, remove the extra space. As you translate or fix a string, click the “Add Comment” link to type in an optional comment then press the “Submit” button to save the translated text.
Figure 11.2d: Using the Pootle Interface to Edit a Translation String
If you need help with a translation or using the Pootle system, you can ask for help on the translations mailing list or in the PC-BSD® Translations Forum.
11.3 Become a Developer
If you like programming, and especially coding on FreeBSD, we would love to see you join the PC-BSD® Team as a PC-BSD® committer. Developers who want to help improve the PC-BSD® codebase are always welcome! If you would like to participate in core development, subscribe to the developers mailing list. Once you have signed up, feel free to browse the active TODO list, or search for bugs that need fixing in the PC-BSD® Trac database. If you see something that you want to work on, or have a proposal for a project you wish to add to PC-BSD®, please let us know via the developers list and we will be happy to help get you started.
Most of the PC-BSD® specific GUI tools are developed in C++ using the QT Libraries, and other non-GUI development is done using standard Bourne shell scripts. There may be cases where other languages or libraries are needed, but those will be evaluated on a case-by-case basis, so feel free to let us know your proposals on the developers mailing list.
Developers will also find the following resources helpful:
11.4 Report Bugs
Have you found a bug in PC-BSD®? If so, please take the time to read through this section to ensure that your bug gets reported to the correct group and is resolved in a timely fashion.
First, determine the type of bug that you are encountering. Is it a bug that is preventing you from properly installing and running PC-BSD® (a system bug), or is it an issue with an installed software package such as FireFox (an application bug)?
An application bug can fall into a few different categories.
11.4.1 Application Packaging Bug
The first is a packaging bug, which is when you can not install the application or it simply crashes on startup. Please report these types of bugs by logging into the Trac Database and clicking “New Ticket”. In the “Type” drop-down menu select “PBI Packaging Bug” and select the operating system version you are using in the “Version” drop-down menu. Use descriptive words in the “Summary”. In the “Description”, provide as much detail as possible about the bug, such as:
the name of the program
the architecture you are using (32-bit or 64-bit)
a detailed description of the bug, including any error messages and which commands or menus you used to generate the error
If you would like to include a screenshot of the error or a log that includes error messages, check the box “I have files to attach to this ticket” to browse to the location of the attachment. Use the “Preview” button to read through your ticket to make sure that the information is clear to the person who will resolve the issue. When finished, click the “Create ticket” button to submit your bug report.
11.4.2 Application Runtime Bug
An application runtime bug occurs when an application installs and is able to start successfully, but during use, it crashes or exhibits some other type of undesired behavior. An example would be OpenOffice failing to import a type of document properly or a chat client unable to keep a connection to a network.
f you installed the application using AppCafe® and you think that the problem is related to how the PBI was packaged, report the bug on the PBI Discussion Forum. If you suspect that the problem is with the underlying FreeBSD port, you can use FreshPorts.org to determine the email address of the port maintainer. If you do email the port maintainer, indicate the name of the port, any error messages that you receive and how to reproduce the bug, and indicate if you are able to assist the maintainer in testing any patches to the port. Once the port is fixed, let the PBI Discussion Forum know so that the PBI can be rebuilt using the fixed port.
11.4.3 System Driver Bugs
A system bug is any bug which prevents the initial installation of PC-BSD® or causes issues with hardware. Some examples would be a non-bootable system, failed installation, missing drivers for your hardware, or a non-functional desktop after installation. To report this type of issue, please follow the instructions below for your type of system bug.
An example of a system driver bug would be a missing network driver, no sound output, or no disk drives detected. Most of these types of issues are directly related to the FreeBSD base upon which PC-BSD® is built, and are best fixed by discussing them with the FreeBSD team directly. Reporting a bug to FreeBSD can be done using the Send PR page. You should also search the FreeBSD mailing lists as other users may have already discovered the bug or have a work-around for your particular hardware. Below are some of the related mailing lists:
ACPI: power management and ACPI development
Emulation: place to discuss Linux, VirtualBox, Wine and Linux Flash plugin support
Multimedia: sound drivers and multimedia applications
USB: USB support and development
Xorg: Xorg and video drivers and development
11.4.4 System Installation Bugs
Any bugs encountered during the installation of PC-BSD® should be reported to the Trac Database, with as much detail as possible, including:
PC-BSD® version and architecture
hardware information, disk and partition sizes, amount of RAM and CPU
description of any defaults that you changed using the installer's “Customize” button
attach a copy of your saved /tmp/pc-sysinstall.log; if you did not save it during the installation, a copy was saved for you to /root/pc-sysinstall.log
11.5 Submit PBI Requests
Is an application that you need not currently available as a PBI? Making a PBI request is an excellent way to let PBI developers know which applications are most useful to PC-BSD® users. Before requesting a PBI, please do the following:
check the module browser area of Trac to see if a PBI module already exists
search FreshPorts to see if there is an existing FreeBSD port; if a port does not exist, you want to generate a port request instead
check to see if a request has already been made in the PBI Requests Forum
To make your request, start a new thread in the PBI Requests Forum. If this is your first forum post, you will need to use the “Register” hyperlink to create a username and password so that you can login to make your request.
NOTE: you do not need to login to read the content in the PC-BSD® forums; you do have to login in order to start a new thread or respond to an existing one.
Once you have submitted your request, click the Thread Tools link ➜ Subscribe to this Thread and select your “Notification Type” so that you can be notified of any responses to your request. If you would like to receive notifications about all of the PBI requests in this forum, click Forum Tools ➜ Subscribe to this Forum while in the forum.
When creating a new forum thread, include the name of the PBI you are requesting in the thread name. That way it is easy for PBI developers and other PC-BSD® users to know which applications have been requested.
People who create PBIs are subscribed to the PBI Requests forum. Usually, someone will respond to a request within a few days either indicating that they are working on creating the PBI or with an explanation if creating a PBI will be problematic. The PBI process is as follows:
A user requests a PBI.
Someone responds to the request and creates a PBI module.
The PBI module is sent to the pbi-dev mailing list so it can be added to the PBI build server.
The PBI module is built on the PBI build server.
Once the PBI is built, PBI testers test for basic functionality such as verifying that the application starts and its menus appear to be present and working.
Once the PBI is tested, the PBI is made available in AppCafe®.
The PBI request is moved from the PBI Requests Forum to the Finished PBIs forum.
Please note that it takes at least 2-7 days for a new PBI to go from step 3 to step 7 as it needs to be fully tested. If there is a delay, that usually means that a problem was found in the PBI and that the testers are trying to resolve the problem.
11.6 Test PBIs
The previous section indicated that new PBI modules are uploaded to the PBI build server so that they can be built and tested. There are two build locations, one for each PC-BSD® architecture:
Figure 11.6a shows a sample from the PC-BSD® 9.x 64-bit location.
There are two ways you can assist in testing PBIs.
First, if you wish to help test a PBI before it has been approved, go to the build location for your version and architecture. Find the name of the PBI you wish to test in the “Module” column and click its hyperlink. You can then download the file with the .pbi extension. Once downloaded, run pbi_add /path/to/pbi to install the PBI. If you find any problems with the PBI, send an email to the PBI-dev mailing list describing how to recreate the problem. Include the text of any error messages you receive.
Second, you can try to resolve PBI modules that have a “Build Status” of “FAILED”. If you click on the name of a failed module, you can download the build.log for that module. This file is in ASCII text so it can be viewed in any text editor.
If the file ends in a .bz2 extension, it has been compressed. To uncompress the file, type bunzip2 build.log.bz2. Or, you can read the compressed file directly using the command bzcat build.log.bz2. This command will scroll down to the end, where the error occurred. Use bzcat build.log.bz2 | more if you prefer to scroll through the file.
Figure 11.6a: Viewing the Status of PBIs on the Build Server
If you think you know the cause of the problem after reading the error messages, you can review the PBI's module by clicking its “svn” hyperlink. If you decide to download a file to edit it, look for the “Plain Text” link in the “Download in other formats” section at the bottom of the page.
If you make an edit to correct the problem, send the modified file (or a diff) to the PBI-dev mailing list so the changes can be uploaded to the build server.
11.7 Create PBIs
PC-BSD® provides a unique file format known as a PBI (push button installer). PBI files end with the .pbi extension and are self-contained installation programs. This means that even novice users can safely install and uninstall PBIs without inadvertently overwriting or deleting files needed by the operating system or other applications.
A PBI file includes all the runtime and library dependencies required by the application. This means that a PBI is a large file, but this does not necessarily mean that the installed PBI will be that large. During installation, the PBI system compares the currently installed libraries and files with the ones contained within the PBI file and only installs the ones that are not already installed on the system. A hash database is used to eliminate dependency problems while allowing the computer to share libraries between different programs.
Once a PBI is created, it can be installed using the graphical AppCafe® utility or from the command line using PBI Manager.
In order to create a PBI, the software must already be ported to FreeBSD. The easiest way to confirm whether or not a FreeBSD port exists is to search for the software at FreshPorts.org. If a port does not exist, you can issue a port request at the PC-BSD® Port Requests forum using these instructions. Alternately, if you have ported software before, the Porters Handbook contains detailed instructions for porting software to FreeBSD.
Creating a PBI from an existing FreeBSD port is a mostly automated process that does not require development skills. Some ports are effortless to convert while more complex ports may require some thought and simple scripting. Two utilities are available for converting a FreeBSD port into a PBI:
EasyPBI: provides a graphical interface and is available in Control Panel. See the EasyPBI section of the Handbook for instructions on how to use this utility.
pbi_makeport: provides a command line utility.
This section explains the components of a PBI module, demonstrates how to use the pbi_makeport utility, and provides some troubleshooting tips.
NOTE: before creating a PBI, check to see if one exists using the instructions in Submit PBI Requests. If you decide that you prefer to request a PBI that you need rather than to create one, that page also contains instructions for submitting a PBI request.
11.7.1 PBI Module Components
This section describes the various components that comprise a PBI module. A PBI module is simply a collection of files which controls the contents of the PBI.
When creating a PBI module, create a directory on your computer to hold the module's components. For example, if you are creating a PBI module for firefox, create the directory as the superuser using this command:
mkdir -p /usr/local/my_pbis/www/firefox
As you create the subdirectories and files needed by the PBI module, save them to that directory. This directory is referred to as %%PBI_APPDIR%%. The rest of this section assumes that you are the superuser.
11.7.1.1 LICENSE File
If the application requires the user to read a license agreement, save that license as a file named LICENSE in your %%PBI_APPDIR%%. This file is optional unless the underlying port is restricted and requires the user to accept a license in order to install and use the software.
11.7.1.2 pbi.conf
The pbi.conf file is mandatory. It is a simple shell script that contains the information needed to build the PBI. Typically this file requires you to modify a few simple variables, such as the name of the program, its location in the ports tree, and the name of its icon. Sometimes you will need to set a few additional variables in order to make sure that required dependencies are included in the PBI. If you get stuck when creating your own pbi.conf, you can view the pbi.conf file for every PBI module in the PC-BSD® trac repository.
Here is an example of the pbi.conf file for firefox. When creating your file, modify the text in red to meet the needs of the PBI.
#!/bin/sh
# PBI Build Configuration
# Place over-rides and settings here
#
# XDG Desktop Menu Spec:
# http://standards.freedesktop.org/menu-spec/menu-spec-1.0.html
##############################################################################
# Program Name
PBI_PROGNAME="Firefox"
# Program Website
PBI_PROGWEB="http://www.mozilla.com"
# Program Author / Vendor
PBI_PROGAUTHOR="The Mozilla Foundation"
# Default Icon (Relative to %%PBI_APPDIR%% or resources/)
PBI_PROGICON="share/pixmaps/FireFox-128.png"
# The target port we are building
PBI_MAKEPORT="www/firefox"
# Additional options for make.conf
PBI_MAKEOPTS="PACKAGE_BUILDING=Y
WITH_CUPS=yes
WITH_GECKO=libxul"
# Ports to build before / after
PBI_MKPORTBEFORE=""
PBI_MKPORTAFTER="audio/esound x11-fonts/dejavu x11-themes/qtcurve-gtk2 devel/gconf2 x11/libXScrnSaver www/gecko-mediaplayer www/firefox-i18n"
# do not include the PBI_BUILDKEY or PBI_AB_PRIORITY options
# as the correct values will be added for you when the PBI is added to the build server
PBI_BUILDKEY="06"
PBI_AB_PRIORITY="50"
export PBI_PROGNAME PBI_PROGWEB PBI_PROGAUTHOR PBI_PROGICON PBI_MAKEPORT PBI_MAKEOPTS PBI_MKPORTBEFORE PBI_MKPORTAFTER PBI_BUILDKEY PBI_AB_PRIORITY
Table 11.7a describes the most commonly used variables. When creating your pbi.conf file, refer to the FreeBSD port's Makefile and pkg-descr to determine which values to use.
Table 11.7a: Commonly Used pbi.conf Variables
Variable | Description |
PBI_PROGNAME= | mandatory; should be the same value as PORTNAME= in the port's Makefile, but capitalized |
PBI_PROGWEB= | mandatory unless does not exist; should be the same value as WWW= in the port's pkg-descr |
PBI_PROGAUTHOR= | mandatory; often found in the port's pkg-descr or at the website for the application |
PBI_PROGICON= | mandatory path, relative to %%PBI_APPDIR%%, to application icon file in .png format |
PBI_PROGREVISION= | bump up a PBI's revision number; useful when rebuilding a port with new PBI specific options |
PBI_MAKEPORT= | mandatory; the path to the port within /usr/ports/ |
PBI_MAKEOPTS= | optional; set this to the options that you want saved to make.conf for the port building process (e.g. WITH_CUPS=YES) |
PBI_MKPORTBEFORE= | optional; port(s) to build before building the PBI |
PBI_MKPORTAFTER= | optional; port(s) to build after building the PBI |
PBI_BUILDKEY= | should not be included; this variable is used on the PBI build server to force the rebuild of a PBI that has failed to build |
PBI_REQUIRESROOT= | set to to YES to require this app to be installed as root; default is NO which allows it to be installed as a regular user |
PBI_EXCLUDELIST= | list of files or directories to exclude from the final archive, such as ./include or ./share |
PBI_AB_PRIORITY= | may be set by build server administrator; a higher number indicates a greater priority and will be built before lower priority PBIs |
PBI_AB_NOTMPFS= | set to YES to disable using tmpfs when doing auto-builds on a server |
PBI_HASH_EXCLUDES= | set to a space delimited list of files to exclude from merging into the shared hash-dir |
export | mandatory; followed by a list of all of the variables that will be included when the PBI is built |
11.7.1.3 external-links
The optional external-links file contains a list of targets to link into the system's LOCALBASE at PBI installation time. This is useful for placing binaries and files in the user's PATH. This file is usually not needed as most binaries and files are auto-detected and automatically placed in the LOCALBASE.
Example 11.7a shows an example usage:
Example 11.7a: Example external-links File
# Files to be Sym-Linked into the default LOCALBASE
# One per-line, relative to %%PBI_APPDIR%% and LOCALBASE
# Defaults to keeping any existing files in LOCALBASE
# TARGET LINK IN LOCALBASE ACTION
#etc/rc.d/servfoo etc/rc.d/servfoo keep
#include/libfoo.h include/libfoo.h replace
#etc/rc.d/servfoo etc/rc.d/servfoo keep
bin/firefox3 bin/firefox3 binary,nocrash
The flags in the “ACTION” column are as follows:
keep: if this file already exists in LOCALBASE, do not overwrite it
replace: replace this file in LOCALBASE if it exists
binary: this file is an executable
nocrash: used for binary files; do not display crash handler if program exits with non-0 status
linux: used for binary files; indicates that this is a Linux application, and needs to be run with Linux compat
11.7.1.4 resources/
The resources/ directory can contain extra files you wish copied into the PBI application directory. This is often the best place for icons and other files not included with a port.
11.7.1.5 scripts/
This directory can contain the following scripts:
post-install.sh: script run immediately after the extraction of PBI contents to disk
post-portmake.sh: script run during building of the PBI file, after the port compile is finished
pre-portmake.sh: script run during building of the PBI file, prior to the port compile
pre-install.sh: script run before installation of the PBI; return non-0 to halt installation
pre-remove.sh: script run before deletion of the PBI file
Table 11.7b summarizes the variables that may be used in these scripts:
Table 11.7b Supported Variables
Variable | Description |
PBI_PROGNAME= | mandatory; should be the same value as PORTNAME= in the port's Makefile, but capitalized |
PBI_PROGDIRNAME= | name of the subdirectory that is created for the PBI in /usr/pbi/ (e.g. “firefox-amd64” for the 64-bit Firefox PBI) |
PBI_PROGDIRPATH= | full path to the PBI install directory (e.g. /usr/pbi/firefox-amd64/ for the 64-bit Firefox PBI) |
PBI_PROGVERSION= | version of the program - should be the same value as the DISTVERSION in the port's Makefile |
PBI_RCDIR= | location of rc.d/ directory used by PBIs, usually /usr/local/etc/rc.d |
SYS_LOCALBASE= | LOCALBASE of the default system, typically /usr/local |
PBI_FAKEBIN_DIR= | the binary wrapper directory, typically /usr/pbi/<pbidir>/.sbin/ |
11.7.1.6 xdg-menu/ and xdg-desktop/
The xdg-menu/ and xdg-desktop/ directories can be used to supply menu and desktop icons, respectively. The file that you place in these directories should be in the format pbiname.desktop. Example 11.7b shows the firefox.desktop files for the firefox PBI:
Example 11.7b: firefox.desktop File
more xdg-menu/firefox.desktop
#!/usr/bin/env xdg-open
[Desktop Entry]
Value=1.0
Type=Application
Name=FireFox
GenericName=FireFox
Exec=%%PBI_EXEDIR%%/firefox %U
Path=%%PBI_APPDIR%%
Icon=%%PBI_APPDIR%%/share/pixmaps/FireFox-128.png
StartupNotify=true
Categories=Network;
more xdg-desktop/firefox.desktop
#!/usr/bin/env xdg-open
[Desktop Entry]
Value=1.0
Type=Application
Name=FireFox
GenericName=FireFox
Exec=%%PBI_EXEDIR%%/firefox %U
Path=%%PBI_APPDIR%%
Icon=%%PBI_APPDIR%%/share/pixmaps/FireFox-128.png
StartupNotify=true
%%PBI_EXEDIR%% should reference the PBI's executable and any required switches.
For more details on the XDG menu specifications, please refer to the freedesktop specifications.
11.7.1.7 xdg-mime/
The xdg-mime/ directory is used to register file associations according to the freedesktop MIME specs. This requires the creation of an XML file. The example shown in Figure 11.7c adds the MIME information for gimp, so that it can be available as an application choice in a web browser:
Example 11.7c: Gimp MIME Info
more xdg-mime/gimp-xdg.xml
<?xml version="1.0"?>
<mime-info xmlns='http://www.freedesktop.org/standards/shared-mime-info'>
<mime-type type="application/x-gimp">
<comment>Gimp File</comment>
<glob weight="100" pattern="*.xcf"/>
<glob weight="100" pattern="*.XCF"/>
</mime-type>
</mime-info>
11.7.2 Creating a New PBI with pbi_makeport
Once you have created the files needed by your PBI module, use the built-in pbi_makeport command to convert the FreeBSD port to a PBI module.
Before attempting to build the PBI, make sure that the FreeBSD ports collection is installed. If /usr/ports/ does not exist or is empty, the ports collection is not installed. To install the ports collection either use Control Panel ➜ System Manager ➜ Tasks ➜ Fetch Ports Tree or type portsnap fetch extract.
To build the PBI, make sure that you are in %%PBI_APPDIR%% then specify where to place the built PBI and the port to build the PBI from, as seen in this example:
pbi_makeport -o /usr/local/my_pbis archivers/cabextract
Fetching FreeBSD chroot environment... This may take a while...
<snip build output>
===> Compressing manual pages for cabextract-1.4
===> Registering installation for cabextract-1.4
===> Cleaning for cabextract-1.4
Checking for Linux libraries to copy...
Creating PBI: cabextract-1.4
Creating Stage Dir: /usr/pbi/cabextract-amd64/.stagedir
Creating external link entries...
Creating xdg scripts...
Creating install script...
Creating deinstall script...
Creating hash list...
Creating compressed archive...
Created PBI: /pbiout/cabextract-1.4-amd64.pbi
Cleaning /usr/pbi/cabextract-amd64
Cleaning /usr/pbi/cabextract-amd64.chroot
The first time you run the pbi_makeport command, a clean chroot environment will automatically download and install. This chroot environment will be used for all PBI builds. If the filesystem is UFS, installing the chroot may take a few minutes. If the filesystem is ZFS and you accepted the default ZFS layout (which includes /usr/pbi/), installing the chroot should happen almost instantaneously.
NOTE: each time you run pbi_makeport, it cleans up its environment, including all of the files that it downloaded and built. Since you may have to rebuild your PBI after testing it, you can save re-downloading and re-building all of these files again by including the --pkgdir <dir> option. You can manually remove that directory when you are finished if you need to save disk space.
FreeBSD ports may contain build dependencies, runtime dependencies, and required libraries. When building a PBI, pbi_makeport automatically compiles all of the required dependencies. When the build is finished, it prunes the build dependencies before packaging the PBI file, leaving only the runtime packages and libraries that are required for the program to work. This means that any files which are included in the PBI are necessary for the program to run, and manually removing them will cause the program to fail.
After the PBI build has finished, two files should be created in the specified directory: the PBI itself and its SHA256 checksum.
ls /usr/local/my_pbis
cabextract-1.4-amd64.pbi cabextract-1.4-amd64.pbi.sha256
Use the pbi_add command to verify the information about the PBI.
pbi_add -i /usr/local/my_pbis/cabextract-1.4-amd64.pbi
PBI Information for: cabextract-1.4-amd64
-----------------------------------------
Name: cabextract
RootInstall: NO
Version: 1.4
Built: 20120829 144309
Prefix: /usr/pbi/cabextract-amd64
Author:
Website:
Arch: amd64
FbsdVer: 9.1-RELEASE
CreatorVer: 1.0
ArchiveCount: 498
ArchiveSum: b75ef8fe699bfed50ad28b058f26af3e685915b5c2330951e2802f891a5b4a85
Signature: Not Signed
AutoUpdate: NO
Once your PBI has built, test the PBI to ensure that it installs and that the application works.
As the superuser, use the pbi_add command with the --no-checksig option:
pbi_add --no-checksig /path_to_pbi
Once installed, start the application from the command line to determine if there are any error messages at application launch. When testing the executable, use the one located in /usr/pbi/(pbi-name)/bin/ so all the linking will be properly set up. Otherwise you can get some interesting errors about missing files.
If the executable does not start the application, the executable may actually be a wrapper script rather than a binary file. If so, check the first line of the script to make sure that it is using the right path for the scripting language. For example, #!/bin/python is an incorrect path which should be changed to #!/usr/pbi/(pbi-name)/bin/python.
The suggested path works because each program is packaged with the proper version of the language it uses and you want to make sure it uses that one. This is usually accomplished by putting a quick sed line in the post-install.sh script to fix the first line as seen in the post install script for frets on fire.
If the application starts and it is a GUI application, go through the various menus to see if they produce any errors.
If you encounter any error messages in either starting or using the application, record them. If the fix for resolving the error messages is not clear to you, send the error report the pbi-dev mailing list.
If your PBI works and you would like to submit its module to be included on the build server, compress it after cding into your module directory (%%PBI_APPDIR%%):
tar tzvf .
This should result in a file named your_pbi_name.tar.gz. Send this file to the pbi-dev mailing list.
11.8 Purchase PC-BSD® Swag
While PC-BSD® is free, some users may wish to purchase media or other items to show their support for the PC-BSD® Project. PC-BSD® items are available from the following websites:
FreeBSD Mall: sells PC-BSD® DVDs and subscriptions, stickers, The Definitive Guide to PC-BSD®, and apparel.
Amazon: sells The Definitive Guide to PC-BSD® (hard copy and Kindle formats) as well as the Kindle versions of the PC-BSD® Handbook. Items are available for purchase in your country may vary.
The PC-BSD® Corporate Storefront: sells high-quality apparel and accessories.
iXsystems: sells professional PC-BSD® support packages.
11.9 Host a Mirror
We are always interested in more download mirrors. If you have a system with a high-speed connection, 350-500GB of space, and the ability to rsync with a host, you can greatly help the PC-BSD® project and PC-BSD® users by becoming a mirror. More mirrors means faster download speeds and more geographic locations for users to download from.
This rsync command will mirror the entire collection of installation files and PBIs:
rsync -vaz --delete isc.pcbsd.org::ftp .
That command should be run as a cron job with a recommended frequency of at least once daily with a preferred interval of every 12 hours.
Once you have begun the rsync process, send an email to kris at pcbsd dot org letting him know the URL of the mirror so that the new mirror can get listed and become available to users.
11.10 Seed a Torrent
PC-BSD® is also distributed as a torrent and you can increase download speeds for other users by seeding, especially during the first two weeks after a new release. If you are new to seeding, read through the GotBSD FAQ first.
The Network-P2P category of AppCafe® provides several torrent utilities including:
11.11 Become an Advocate
So you love PC-BSD®? Why not tell your family, friends, fellow students and colleagues about it? You will not be the only one that likes a virus-free, feature-rich, no-cost operating system. Here are some suggestions to get you started:
Burn a PC-BSD® Live version onto a USB stick to have available for others to try.
Brainstorm and network with other PC-BSD® advocates at the Spread PC-BSD® Wiki.
Burn a couple of DVDs and pass them out. If your school or user group has an upcoming event where you can promote PC-BSD®, you can request additional DVDs from sales@pcbsd.com.
Consider giving a presentation about PC-BSD® at a local community event or conference. Let us know about it and we will help you spread the word.
Write a personal blog detailing your journey from your first PC-BSD® install experience to your most recent accomplishment. The blog could also be used to teach or explain how to perform tasks on PC-BSD®. A regional language blog may help build the community in your area and to find others with similar interests.
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